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PURPOSE

The Against The Clock series has been developed for those involved in the field of
graphic arts.

Welcome to the world of electronic design and prepress. Many of our readers are
already involved in the industry — in advertising and design companies, in
prepress and imaging firms, and in the world of commercial printing and repro-
duction. Others are just now preparing themselves for a career somewhere in the
profession.

This series of courses will provide you with the skills necessary to work in this fast-
paced, exciting, and rapidly expanding business. Many people feel that they can
simply purchase a computer, the appropriate software, a laser printer, and a ream
of paper, and begin designing and producing high-quality printed materials. While
this might suffice for a barbecue announcement or a flyer advertising a local hair
salon, the real world of four-color printing and professional communications
requires a far more serious commitment.

TUE SCRILS

The applications presented in the Against The Clock series stand out as the pro-
grams of choice in professional graphic arts environments.

We’ve used a modular design for the Against The Clock series, allowing you to mix
and match the drawing, imaging, and page layout applications that exactly suit
your specific needs.

Titles available in the Against The Clock series include:

Macintosh: Basic Operations
Windows: Basic Operations
Adobe Illustrator: An Introduction to Digital Illustration
Adobe Illustrator: Advanced Digital Illustration
Freehand: An Introduction to Digital Illustration
Freehand: Advanced Digital Illustration
Adobe PageMaker: An Introduction to Electronic Mechanicals
Adobe PageMaker: Advanced Electronic Mechanicals
QuarkXPress: An Introduction to Electronic Mechanicals
QuarkXPress: Advanced Electronic Mechanicals
Adobe Photoshop: An Introduction to Digital Images
Adobe Photoshop: Advanced Digital Images
File Preparation: The Responsible Electronic Page
Preflight: An Introduction to File Analysis and Repair
TrapWise: Trapping
PressWise: Imposition



How 10 USsE TH1S WORKBOOK

We've designed our courses to be “cross-platform.” While many sites use
Macintosh computers, there is an increasing number of graphic arts service pro-
viders using Intel-based systems running Windows (or Windows NT). The books
in this series are applicable to either of these systems. This course applies only to
the Macintosh. For a similiar course on Windows, see Windows: Basic Operations,
from this same series.

All of the applications that we cover in the Against The Clock series are similar in
operation and appearance whether you're working on a Macintosh or a Windows
system.

|CONS-AND VISUALS

Pencil icon indicates a comment from an experienced operator.
Whenever you see the pencil icon, you'll find corresponding
sidebar text that augments or builds upon the subject being dis-
cussed at the time.

Bomb icon indicates a potential problem or difficulty. For in-
stance, a certain technique might lead to pages that prove diffi-
cult to output. In other cases, there might be something that a
program cannot easily accomplish, so we might present a
workaround.

Pointing Finger indicates a hands-on activity — whether a short
exercise or a complete project. This will be the icon you'll see the
most throughout the course.

Key icon is used to point out that there is a keyboard equivalent
to a menu or dialog-box option. Key commands are often faster
than using the mouse to select a menu option. Experienced op-
erators often mix the use of keyboard equivalents and menu/dia-
log box selections to arrive at their optimum speed.

vii
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SUPPORT MATERIALS

FORTUE STUDENT

On the CD-ROM, you will find a complete set of Against The Clock (ATC) fonts,
as well as a collection of data files used to construct the various exercises.

The ATC fonts are solely for use while you are working with the Against The Clock
materials. These fonts will be used throughout both the exercises and projects and
are provided in both Macintosh and Windows format. For the purposes of this
course, Macintosh: Basic Operations, there are no fonts necessary to complete the
exercises.

FORTUE INTRUCTOR

The Instructor Kit consists of an Instructor’s manual and an Instructor’s CD-
ROM. It includes various testing and presentation materials in addition to the files
that come standard with the student books.

. Overhead Presentation Materials are provided and follow along with the
course. These presentations are prepared using Microsoft PowerPoint and
are provided in both “native” PowerPoint format as well as Acrobat Por-
table Document Format (PDF).

. A Test Bank of Questions is included within the instructor kit. These
questions may be modified, reorganized, and administered throughout the
delivery of the course.

. A Final Review at the end.
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The GASP Report. Gary is the author of Workflow Reengineering, Adobe Press, and
co-author of Creative Techniques: Adobe Illustrator, and Creative Techniques: Adobe
Photoshop, both available from Hayden Books.

xi



GETTING STARTED

1LY (OMMANDS

The Macintosh has a key marked with an Apple and an icon that looks like a clover
leaf. This is called the Command key. Whenever you see this icon, you will need to
hold this key down. The Command key is a modifier key; that is, it doesn’t do
anything by itself, but changes the function of a key pressed while it’s being held
down. A good example is holding Command while pressing the “S” key: this Saves
your work. The same thing applies to the “P” key; hold down Command and press
it to Print your work.

Another special function key on the Macintosh is the Option key. It’s also a modi-
fier key, and you’ll need to hold it down along with whatever other key is required
for a specific function.

TUC -ROM AND INMAL SETUP (ONSIDERATIONS

Before you begin using your Against The Clock course book, you will have to set
up your system so that you have access to the various files and tools you'll need to
complete your lessons.

STUDENT FILES

This course comes complete with a collection of student files. These files are an
integral part of the learning experience, as they’re used throughout the course to
help you work through the various exercises. Having these building blocks avail-
able to you throughout your practice and study sessions will ensure that you will
be able to experience the exercises with a minimum of time spent looking for the
various components required.

Navigate through the CD-ROM to locate the folder called “SF-Basic Mac Opera-
tions” and simply drag the icon onto your hard disk drive.

xii



(HAPTER 1

Whiar 1s s Macinrosu?

-~

: CHAPTERl aiU'ECTI VE:

~ To introduce you to the concept of hardware and software, and to discuss the
* various components that make up your Macintosh; to introduce you to
programs and operating systems. In this first section of the course, you will:

R0 Leqrri about the computer itself and how the CPU controls the
Macintosh system and provides important computing resources.

® Leatn about memory and storage, how they differ, and how they work
together to allow programs to function.

® Learn about storage: internal storage, external storage, and so-called -
removable media.

® Learn about CD-ROMs and how they are used to store data.

o .Understand the difference between applications, the Macintosh operat-
ing system, and data files.

‘¢ Learn about popular graphics applications and what they’re used for.



There are many people for
whom the Macintosh is
their first computer; for
others, they're already
familiar with another
system — perhaps

Windows.

Once upon a time, there
was a major difference
between the Mac and other
systems — especially
relative to how easy it was
to use. Today, most
computers have emulated
the Macintosh user
interface and ease-of-use.
Still, the Mac is many
people’s favorite computer.
In particular, its popularity
in the graphics industry

remains unchallenged.

What is a Macintosh?

So what exactly is a Macintosh computer? In the most fundamental ways, it’s
almost exactly like any other computer in that it boasts several components
that are common to all platforms, or machine types.

Monitor

Scanner

Keyboard

The components are:

The Machine: the actual computer itself, which consists of boards,
chips, memory, circuits, and other electronic components.

Storage: hard drives, diskettes, removable platters, optical disks, and
other places where your data is stored, and where it remains when your
computer is turned off.

Input devices: items used to get information into the computer. These
can include such basic items as the keyboard and mouse, and range all
the way to complicated hardware such as expensive, high-end scanners
and digital cameras.

CHAPTER 1: WHAT 1S A MACINTOSH? PAGE 3



Ore of the biggest reasons
for the Mac’s success is
the fact that it's a “plug-
and-play” machine. If you
want to add a printer, or a
monitor, or a keyboard, or
any device to the system,
you simply match up the
small pictures on the
cables, plug them in, and

away you go.

Output devices: components used to “show you the data.” This can
range from a monitor (capable of displaying the contents of files,
folders, and the desktop environment where you actually work) all the
way to extremely high-resolution devices that can actually print image
plates for high-speed commercial printing,

Communication components: things that allow one computer to talk to
or communicate with another computer. Networks, where people in

workgroups share files, is one example of communications; the World
Wide Web and email are others.

If you're working with this course, it’s very likely that you have at least some of
these components in front of you (or at least accessible). Let’s look at these
components in a little more depth.

The Machine

The first component to consider is the computer itself. There are two types of
basic systems: desktop (also called tower if designed to stand on end) and
laptops, or portable machines. Laptops normally are small enough to fitin a
decent-sized briefcase, and offer a self-contained keyboard, pointing device,
and monitor. A well-configured laptop might even have a CD-ROM drive
(more on those a little later), a floppy disk (ditto), and a modem for communi-
cating with remote computers or networks.

Tue CPU

If you opened up your computer, you would find a great deal of complex
electronics stored inside. Among the many chips and circuit boards you might
see is one large chip — essentially the “brains” of the entire thing, It’s called the
CPU, which is short for Central Processing Unit. This CPU contains the basic
instructions that the system needs to perform tasks like using software tools,
storing data, and communicating with devices like monitors, printers, and
other system components.

Increasingly, manufacturers like Apple Computer are building computers that
have more than one processor. Rather than attempting to build bigger and
bigger devices (to meet increasing demands from more-and-more complicated
programs), they have decided that it’s easier to use multiple processors. That

PAGE 4

CHAPTER 1: WHAT 1S A MACINTOSH?



Rl

Most computers today are
equipped with at least 8
megabytes of RAM, and
often contain much more.
In fact, you can’t buy a new
computer with only &
megabytes of RAM these
days. The general rule of
thumb is to buy as much
memory as you can afford
in your budget. The more
RAM memory your com-
puter has, the better it will

perform.

way, the demands on the CPU can be divided up (by specialized operating
system software) and shared among the processors.

This doesn’t mean that companies like Apple, IBM, Compag, Intel, AMD, and
many others aren’t working to make the basic processors themselves more
powerful — it’s more a strategy that lets users like you select a system that’s just
right for their unique needs. If you work on digital images, for example, which
are very computer-intensive, you might choose to buy a computer with two or
more processors. If you're going to be a copywriter, primarily utilizing word
processing programs (which inherently place less of a demand on the com-
puter), a single-processor system might suffice quite well.

MEMORY

The amount of memory that’s built into a given computer determines two
things:

+  How many things the computer can do at once (how many programs
can be loaded and ready-to-go when you need them), and

+  How fast certain functions execute.

Memory can be thought of as a honeycomb. Each cell on the grid represents
one byte. A byte is enough to store one character.

If you put together about 1,000 of these cells (actually 1024, but let’s not get
too crazy here), it’s called a kilobyte. A million of them is called a megabyte,
and a billion are referred to as a gigabyte.

You may have heard these terms before, especially when looking at promo-
tional material for computers or hard drives. Memory contained in the com-
puter is called RAM, or Random Access Memory.
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Many people remain
confused about the
difference between RAM
and hard disk space. In one
way, they're very similar —
and that's that you should
budget for the biggest hard
drive you can afford. The
price per megabyte is
pretty low these days, and
you can purchase gigabyte
(and greater) drives for a
few hundred dollars. No
matter how much drive
space you have, you'l
always need more. That's
why proper drive organiza-

tion is important.

RAM memory is only active and available when the computer is actually
turned on and operating. Things that were stored only in RAM (which is the
case while you're working on a new document, not yet saved) are lost when the
system is powered down. When you want to store something permanently, you
save the contents of RAM to the system’s hard drive (or some other storage
media). This transfer takes place whenever you issue a save command from
within an application, or software tool. We’ll be working with these concepts in
depth a little later on in the course. Here’s a graphic that shows the difference:

RAM vs. Hard Disks

Random Access Memory — the computer's internal memory
available for files and application programs in current use.
Contents of RAM are volatile and are erased when the power is
turned off, The amount of RAM determines, in part, how fast
and how many applications you can run at the same time. RAM
capacity is rated in megabytes (MB). A megabyte is one million
characters such as letters or numbers.

Most computers include at least one Hard Disk mechanical
storage device. Files are "written” to these devices to store
them for future use. Capacities, also rated in megabytes,
range from 10 to thousands. The larger the capacity, the more
applications and data files can be stored for easy retrieval.
There are many types of drives; some are “fixed” inside the
system, some are connected with cable. Others are in the form
of removable devices: platters, opticals, and even CDs. CDs are
usually created by a special device and can never be changed.

Storage

If you're new to computers, you have probably encountered someone who told
you horror stories about losing your data to a “crash.” This usually happens, it
is said, whenever you're working on the most critical project of your life, it’s
due in the morning, and you have to work all night long. Fret not.

Today’s computers are quite able to keep your important (and not-so-impor-
tant) information safe and secure through all but the most traumatic events.

Computers offer several different types of storage systems where you can save
your information quickly and easily. Later in this chapter we’ll discuss backup

and archiving methods, which ensure that even if you do experience a system

PAGE 6

CHAPTER 1: WHAT 1S A MACINTOSH?



mdn

You probably have several
different types of storage
on your computer. At a
minimum, you have a hard
drive and a floppy disk.
Ferhaps you also have a
CD-ROM built into your
system, and you might even
have other media, like the
popular Zip or Jaz drives
from the lomega Corpora-
tion. These removable disks
are increasingly popular in
the graphic arts industry,
where moving large image
and page layout files is a

common procedure.

failure, you will be able to restore your system to the way it was the last time
you created a backup.

TaE HARD DRIVE

The most fundamental type of storage you’ll encounter as a Macintosh opera-
tor is the internal hard disk. These mechanical devices (pictured below) provide
the basic storage space available to you.

Most computers today are configured with an internal hard disk — built into
the actual system or portable unit. The way they work is quite simple. A read-
write head modifies a magnetic field that’s stored on the surface of the media
itself (sometimes called the platter). The platter is formatted with concentric
rings, called tracks, and pie-like slices called sectors. This segmenting strategy
allows the entire surface of the device to contain unique addresses, which
programs and the Macintosh Operating System (we’ll explain these terms later)
use when they store and retrieve your data, or when they launch (another word
for start up) a program.

Addices

Hard disks do occasionally require maintenance, and have even been known to

fail now and then — even with today’s very secure and stable systems. Another
disk-related problem that you might see happen from time to time is when a
file becomes corrupted, or impossible to read. There are specialized programs
that can be used to fix certain categories of problems. These applications are
called utility programs.

CHAPTER 1: WHAT 1S A MACINTOSH? PaGge 7



These are high-capacity
disks used to copy large
files for transfer to a
service provider for output,
or to archive them for
future reference. The
standard in the industry
has been the series
manufactured by Syquest,
but recently the Zip and
Jaz drives have become
very popular. The basic Zip
holds 100 MB, and the Jaz
holds 1or 2 GB, but there
are continuous improve-
ments and upgrades in

these producte.

External Storage

Certain computers not only have internal hard disks, but are also equipped
with external storage devices. These can take several forms:

Fixep

A fixed external hard drive is one that’s contained in its own case, and usually
has its own power supply. When you're considering the expansion of your
system, you can choose to put another hard drive inside your computer
(internal), or choose to put the device outside your system (external). Depend-
ing on the configuration, some computers either don’t have the space inside
within which to mount an additional drive, or aren’t able to supply sufficient
power to the device.

Sometimes, adding an external fixed drive is just easier to do, since the opera-
tor only needs to plug in the cables, supply power, and run a program that
comes with the external hard drive in order to use it immediately. Installing an
internal hard drive normally requires you to take your computer into a service
center where a trained technician will do the installation without voiding your
warranty or destroying some vital component.

REMOVABLE MEDIA

Removable media is just that: disks and storage systems that can be taken out
of your computer. There are many types of such media, including:

Floppy Disks  Floppies are normally 3.5 inches square, and fit into a slot
either within your computer or in an externally-connected
drive. They only offer about 1.5 megabytes of storage space,
and are often reserved for making copies of small files to
move to another machine, or as a limited backup media.

Removables ~ Removable platters were quite popular for a while as a
manner of both extending the amount of space available to
the user, as well as moving larger graphic files from one
system to another. An example is the designer or advertising
agency who sends their files for output at a service bureau.
While they’re still in use at many sites, larger, faster, and
more reliable methods are beginning to reduce their impor-
tance as removable media.
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Optical Disks ~ Optical disks are larger (usually 5.25 inches) media that are
mounted in a specialized read/write drive mechanism.
Optical disks normally hold between 600 megabytes and 1.2
gigabytes of data— enough for most large projects and very

reliable as a backup media. The disks are relatively expensive
though, and they’re normally used for projects, not daily

Most CD-ROMs are meant backups.

to be “read-only,” which

means that your computer CD-ROMs When most people think of CDs they either think of music
can read data from the CDs or the kind that you get when you purchase new

drive, but cannot put data software or interactive titles. CD-ROM:s can also be written
onto the disk (write). Some to (usually only once, though), and are increasingly being
special CD-ROM drives are used to store important data. They can hold a lot of infor-
also able to write to a blank mation (around 600 megabytes or so) and are very reliable.

CD, though. The thing to
Getting Stuff In

remember about writing to
CDs is that once they're

written to, the information “Input” is one of those computer buzzwords so popular at Star Trek conven-

ie permnent, And they tions, on internet chat lines, and among the “geek elite.” It’s just a term that

hecome nead-only. refers to methods of getting information into your computer.

CD storage is gaining in There are three primary methods of getting data or commands into your
popularity at an amazing computer:

pace, due to their stability,

the low price of a disk * AMouse

(about $10), and the

relatively low cost of a CD- * A Keyboard

Writer device.

»  Scanners
The Mouse

In the old days, before there were mice (the mechanical, computer kind of
mice, not the squeaky, pointy-eared species), using computers was quite a bit
harder. To get the computer to do anything, you had to enter confusing strings
of (otherwise) meaningless code.

The mouse was invented in the late seventies, but didn’t make its public debut

on a computer until Apple put one on an early model called the Lisa. This
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Dor’t run your mouse oh
anything but a mousepad
or a very clean surface.
Even then, they'll occasion-
ally become gunked up and
won’t work properly. This is
because the roller ball and
the tracking mechanism
become clogged with this
really weird, greasy stuff
that is very hard to get off.
You should remove the ball
oh a regular basis, and
clean it really well with
alcohol or soapy water.
Same thing with the small
rollers inside; examine them
and make sure they're
clean. If they have accumu-
lated lint, remove it gently

with a wooden toothpick.

Despite your best. precau-
tions and rodent hygiene,

you can expect to replace
your mouse about once a

year — or less, if you're

really a heavy-handed roller,

computer was never really popular, and it wasn’t until the introduction of the
Macintosh computer that mice began to make their impact on computers
everywhere.

Mouse

The way a mouse works is quite simple. Moving the mouse around on a flat
surface (many people use a special piece of plastic called a mouse pad) controls
an arrow that you can see on the monitor.

On the top of the mouse is a button. By using the mouse to move the arrow
around the screen, and the button to click on the items on the screen, you can
make things happen. This is (trust us) a much easier and more natural way to
get computers to do things for you.

If using the mouse to point at different regions of the screen seems a little
clumsy, just give it time. Before you know it you'll be speeding around like a
regular expert. You'll learn how to adjust mouse operation later in the section
about Control Panels.
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This illustration should help
you see how to clean your
mouse. Before you do,
though, be sure to check
the instructions that came

with your system.

There are kits available
that have special balls that
you put into your mouse,
moisten with fluid, and roll
around for a while. These
devices help keep the rollers

clean.

Here’s how the mouse works:

000 -

There’s a ball inside the mouse. As you move the mouse, the
ball rolle around on the surface of the table or mouse pad.
It also moves three sensors, which control the position of

the arrow pointer.

Tae KEYBOARD

The next way to get things into the computer is through the keyboard. The
keyboard is used for several different types of input:

Typing information directly into various programs. You might find yourself
entering copy into a word processor or into a design. If you do have to enter
lots of copy, then learning how to type is clearly important. Other types of
information you might find yourself inputting into the system are numbers. If
you're working on financial documents a lot, then you will become familiar
with the numeric keypad, which is usually found on the right side of the
keyboard.

Using the keyboard to control programs. Almost all programs offer what are
called keyboard commands or keyboard equivalents. All programs on the
Macintosh offer several ways to accomplish certain tasks. Saving a file, for
example, can be done using the mouse (which you’ll learn later on in the
course), or by pressing a combination of keys from the keyboard.
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When you're first using your
system, it will be all you can
do to move the mouse,
watch the screen, and gasp
in amazement when the
system does something
cool. As time passes, and
you become more comfort-
able with how the system
works, you should make a
concerted effort to begin
using command-key
equivalents, such as
Command-S to Save,
Command-P to Print, or
Command-Q to quit. As
great as the mouse is, it's
not nearly as fast as using
the keyboard when there's a
choice between pressing a
key or two and rolling the
mouse from one side of

your monitor to the other.

Using function keys. Function keys are positioned across the top of the key-
board, and are named F1, F2, and so on, usually through F12. These keys often
consolidate common keyboard combinations into one keystroke.

There are other ways you might find yourself using the keyboard, depending
on the exact nature of the program you’re using at the time. A drawing pro-
gram, for example, might allow you to use the keyboard to “nudge” or move an
object a little bit at a time; a game might let you use the Arrow keys on the
keyboard to maneuver your warrior through the bowels of Hell.

There are also four special keys — called modifier keys — that you will use
almost every time you work on your computer. Here is a list of these special
modifier keys:

The Command Key is the most important special function key on the
Macintosh; in most programs it's used to save, print, and open files.

The Option Key is the second of the special function keys on the Mac.
If you see this symbol anywhere, it means to hold this key down.

If you've ever used a PC, you know about the Control Key. It's not used
as much on the Mac, but newer programs are starting to use it more.

The Shift Key works just like it does on a typewriter, capitalizing the
letter it's used with; it's also used with the Command or Option keys.

DIV A's

There are four special function keys used by Macintosh programs.

If, for example, you wanted to open a file, you might have to hold down the
“O” key while pressing the Command key. Pressing “O” by itself might not do
anything at all — or at the most put an errant “O” somewhere in your impor-
tant report. Pressing “O” while holding down the Command key, however,
modifies the key, and makes it do something it wasn’t originally designed to do.
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Scanners are very popular
in the graphic arte. There

are two basic kinds:

Flatbeds (which have a
glass, sort of like a copy
tmachine, on which you put
the thing you want to
scan), and Drum Scanners.
Almost all high-quality
color scans that you see in
books and magazines are
done on drum scanners.
They're usually much more
accurate and capture more
of the available color when

scanning a slide or print.

SCANNERS

Depending on the nature of the system you're working on, and the environ-
ment in which you're operating, you may or may not have a scanner connected
to your system. There are several different types of scanners, but they’re all

used to get information into your system. There are two ways a scanner might
do that:

The first is to scan images. Images might be pictures, drawings, maps, or
anything else you might want to have in your computer.

The second method is when a scanner is used for something called optical
character recognition (OCR). OCR is used to capture documents that have
already been typed or printed. In this case, specialized software reads the words
on the page being scanned and converts them into word processing documents.

Getting Stuff Out

The next geeky computer term you should know is output. In English, this
means how the information stored in your computer is presented to you or an
audience. There are basically two ways that you can look at what’s on your
system. The first is to look at it on your monitor, and the second is to print it so
you can look at it in a physical form — something that’s often referred to as hard

copy output.

TaE MONITOR

Your monitor is the window into what’s going on inside your Macintosh.
Almost all computers are equipped with color monitors these days, and if
you're going to be using your Macintosh to create graphics and other visual
items, then it is critical to have a color monitor.

The next issue to consider when thinking about your monitor is how big it is.
Since many Macintosh programs use a varied collection of tools that sort of
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No matter what you might
hear about how accurate
today's monitors are at
displaying color, remember
that when you print a
project on a color printer,
or send your files away to a
printer or service provider
for high-resolution output
(such as film for printing
presses), you cannot trust
that your monitor will be
accurate. If you are working
on projects that ultimately
will be used in the commer-
cial printing process, be
sure to consult with your
printer for specific instruc-

tions.

“float” around the screen in their own little palettes (you’ll learn a lot more
about this later), the amount of space you have to arrange your work, the tools
you have available, and other things you might want (or need) to have available
to you at the time, becomes very important. The general rule of thumb is to
buy as good (and big) a monitor as you can possibly afford. If you're working
on your system all day — as many of us are — it’s much easier to sit there if
you're not looking at a tiny screen and spending a lot of time arranging things
on the monitor.

THE PRINTER

The printer your computer is connected to is a critical component in your
system. Without the ability to create hard-copy output, all the work that you
do on your system would be “stuck” on your hard drive — and you wouldn’t
be able to show it to anyone, use it for communicating with the outside world,
or making cool pizza flyers, worldwide best selling novels, or the latest recipe
from your social group.

There are several different types of printers:

Laser Printers  Laser printers are probably the most popular type of print-
ers in use today — especially in the graphic arts. A laser
printer works much like a photocopier, using toner to image

the page.

Dot Matrix ~ Dot matrix printers use a print head comprised of some
number of small pins that drive ink from a ribbon onto the
surface of the paper.

Ink Jet An ink jet printer sprays ink onto the paper from small
nozzles in the print head.

Dye Sub Dye sublimation printers spray a special heat-sensitive
colorant onto the page and heat it, bonding it to the surface
of the paper.

PAGE 14

CHAPTER 1: WHAT 1S A MACINTOSH?



Talking to Other Computers

The price of laser printers
has fallen from almost
$5,000 ten years ago to a
few hundred dollars today.
There are two primary
types of laser printers
that you should think
about: printers equipped
with FostScript, which is a
specialized language that
is widely used in the graphic
arts, or printers without
FostScript, which will not
always be able to reproduce
your work if you're involved

in commercial art.

The Macintosh has the ability to talk to other computers. These systems can be
in your office or workplace, or in another physical location. There are two ways

that your computer can share information with, or gather data from, other

computers: networking, or through the use of telecommunication devices.

NETWORKING

Networking refers to a physical connection between two or more computers.
This is usually done by means of an actual wire or cable that’s hidden in the

wall. There are several different types of connections, including regular tele-

phone wire, special shielded wire called coaxial cable, fibre-optic cable, and

even infrared signals that require no wires at all.

TELECOMMUNICATIONS

Telecommunications refers to a wide variety of methods that take the data

from your computer and sends it — either over regular telephone lines or

through special digital networks — to computers in remote locations.

Telecommunicating with another computer requires the use of special hard-

ware, referred to as a modem. A modem translates what’s on your computer

into an analog signal capable of being sent across telephone lines to the huge

networks maintained by companies like MCI, AT&T, Sprint, GTE, and others..

.

Software

Tuae OPERATING SYSTEM

There are several different types of computers in the marketplace today, the S

two most prominent being Windows-based machines and the Macintosh,

which you're using if you purchased this book.
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The Macintosh comes
equipped with the ability to
communicate with other
computers via a network
(which we describe in some
detail later in the book). If
you want to connect to
networks outside your
building or in other parts of
the world (like the
Internet), you'll need to
purchase a modem.-
Modems allow you to
connect to other comput-
ers via reqular telephone
lines. Many computers
come with modems already
installed — perhaps yours

i one.

These two categories exist because each machine uses a different type of
processor (see CPU). One is built by Motorola (for the Macintosh) and the
other by Intel Corporation (for Windows-based systems).

The fact that the two computers use a different processor isn’t the only thing
different about them; there’s another difference that’s even more important to
you as the operator: they use different Operating Systems — MAC OS for the
Macintosh; Windows for the PC.

The operating system on your computer is actually a collection of programs, or
instructions, that provide the basic functionality that your computer needs to
do anything. This includes things like reading to (and writing from) hard
drives and removable media, displaying graphics, controlling the mouse,
getting input from the keyboard, and a host of other functions. The operating
system also gives you access to so-called high-level functions, such as copying
and moving files, creating and organizing folders, finding things, and connect-
ing to other computers (both in your own location as well as around the world
through the Internet).

Without an operating system, your computer wouldn’t even start up. When
you give it power, it would just sit there with a blank look on its face.

APPLICATIONS

Applications are the tools that you use to perform different functions. If you're
going to be working in the graphic arts industry (which is probably the case if
you're using the Against The Clock series of workbooks), you may find your-
self using various application programs that provide page layout, drawing
tools, painting or image editing programs, word processors, or image capture
software. Any of these terms (applications, tools, programs, software) mean the
same thing,
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Here’s a list of commonly used applications and what they’re used for in a
graphic arts environment:

Common Graphics Applications

The exact combination of

Comment

software programs that Word Processing Word processing programs allow you to enter

you will end up using is a msworde | ANd edit text (often called copy). Today's word
processing programs are quite sophisticated,

urely personal choice (or
e 4 ( and are often used to create lengthy, complex

company choice, in the case documents,
of commercial usage). We lllustration rg Digital illustration programs are very
don't recommend one Mustrator 7.0 | IMportant in the graphic arts. They are used

to create logos, technical illustrations, tables

program over another, (like this one), and many other common

although we naturally have elements.

our own favorites (and no, we Digital Image Editing Programs like Adobe’s Photoshop are used to
BJ . ¢

wor't tell you what they are). Aot manipulate images. They can correct flaws,

and correct the colors so that printed output
matches the original photo. They are also
used as painting programs.

Fage Layout Fage layout programs are used to produce
eagetiker 6.5 | Aigital mechanicals,” artboards that are
used in the printing of books, advertisements,
magazines, newspapers, and many of the
publications we see every day.

The four most common tasks in the Graphic Arts field are writing
copy, developing illustrations, editing or creating photographic
images, and constructing - or laying out - pages using a page layout
program.

This book covers MacOS
version &.x. If you haven't
already upgraded to this
latest software, please do
so before proceeding. Some
features will not work
properly if you do not, and
many of the screens shown

here are unique to 058.
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(HAPTER 2

UsinG THE MAcINTOSH

> CHAPTER Objecrive: ‘

To introduce you to how the Macintosh works; to teach you the basic skills -
< you'll need to operate a Macintosh in a commercial or educational environ-
o= ' ment. Through an intensive series of hands-on activities, you will:

® Learn about the Macintosh Operating System, and the Desktop — the
area within which you do your work.

® How to use the Mouse to control your Macintosh.

® Understand the concept of Windows (the Macintosh kind, not the
Microsoft kind); how to open and close them, how to move them
around the desktop, and how to manage them.

® Be able to use the powerful Help system built into Macintosh System
8.x, and know how to reference topics in several different ways.

® Learn how to create and manage folders, one of the core components of
the Macintosh environment. ;

® Launch your ﬁrst apphcatlon a simple word proce'isor that comes w1th
your Macintosh.

® Use the StmpleText program to change the appearance of text elements
and to save your work.

® Know how to find lost or misplaced files, folders, or applications.

® Learn to print files, windows, the contents of folders, or just about
anything else you might like to tape onto your refrigerator.




The Macintosh is known for
ite ease-of-use, but don't
let this fool you into
thinking that practice and
experience aren't. impor-
tant. The longer you use
the system, the better an
operator you'll be. Another
thing to remember is that
operating systems and
software applications are
constantly being updated
and modified. You should
consider subscribing to a
few Macintosh magazines,

just to stay in touch.

Using the Macintosh

In this section of the book, we're going to be exploring the use of your
Macintosh, starting with the basics (such as turning it on), and moving on to
core functions such as folder management; what the desktop is and how to
move around on the system; what files are, how to create them; and more.

In this section of the course, you should be in front of your Macintosh, and
ready to practice some hands-on activities that will help you learn to use your
system.

Turning Your Computer On

In order for your computer to work, you will need to turn it on. While this
sounds quite obvious, you would be surprised at how many support calls come
into help centers because the computer hasn’t been switched on. Another term
for this is powered up.

Most Macintosh computers created since the eighties have had the power-on
switch on the keyboard. On newer models — particularly the PowerPC models
— the power button is on the front of the cabinet. Here’s an illustration that
shows where the power-on switches might be found on your computer.

Power Up button for
earlier Mac models

Power Up button on PowerPC
and other models
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This pointing finger icon is
something you'll see a lot
during the course. Wherever
you seg it, it means that
there's a hands-on exercise
— a task that you can
actually practice on your

system.

Turning On Your System

If it’s not already on, press the power button and turn on your computer.
A chime should sound letting you know that the system is powered up.
After a brief wait an introduction screen should appear, and the desktop
will appear.

The Desktop

When you first turn on your Macintosh the monitor fills up with a back-
ground color or pattern. This background is called the Desktop. In some cases,
it might be a picture, since you can change the image that’s used for the surface
of your desk. Later on, when we teach you how to control and change the
working environment, you'll learn how.

WHAT 1s THE DESKTOP?

The desktop is the area on which you do all your work. Even when you're using
a program that completely covers the desktop, it’s still there. There are several
aspects to the desktop you should notice. Take a look at this picture:

The Macintosh Desktop

Your hard drive appears on the desktop as an icon, as do
folders, applications, and certain other types of objecte.

In the upper right hand corner is a program picker, which is

used when you have more than one program running at once. The
date and time are also displayed. We'll talk about both features
later in the course.

The Trash Can is where you throw away stuff you don't need anymore. You

can use it to discard just about anything. As is the case in the real world,
you can also dig arcund in there in case you threw away something important
(not that you would ever do something like that). The only difference is that
this Trash Can doesn't contain any old gum or cigarette butts.

The Menu Bar is the most important aspect
of the desktop. It's from here that you control
your Macintosh.

The Macintosh Desktop is the background upon which all your work is done; it is always active, even when you're
working in a program, surfing the Internet, or listening to the latest sounds on your internal CD player.
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At the top of the screen is a white region with words like FILE, EDIT, VIEW,
and SPECIAL inside. This is called the Menu Bar.

In the upper right corner is a picture of your computer’s hard disk drive. This
can be thought of as a file cabinet in which your work is stored. We talked

about hard drives a little earlier. The picture you see is called an icon.

Icons

Commonly Used Icons on the Macintosh

Icon | Type | Description
Standard These are the most common icons
Applications Folder that you will see on your system.
There are hundreds of Svete
. . ] ystem This folder contains the components
different. icons that yo:il SQR“ Folder of the Operating System.
see on your system, and we -
: : Hard Disk Your own hard drive might have a
couldn’t put them all in a lcon different name
table. Each software
CD-ROM CDs containing data or music will
manufacturer makes their Icon appear on your dggktOP,
own icons, and each — . g r ,
1wk B [ Appllcation Each program has a unique icon. This
application saves its files adobe Ilustrator lcon is the Adobe lllustrator icon.
with icons that look File lcon When you create a file, the program
something like that of the Mouseiabs (lustrator EPS)|applies its own icon (EFPS file shown).
program itseif. You can even o= File Icon Some programs show the file itself.
collect icons and change Orenges TIF (Photoshop) Here's a Photoshop document.
them — later, when you Font lcons Most fonts come in two parts, each
really start “hacking” Adobe Serlf AdobeSantiM having ite own icon. More on this later.

around with your machine.
For now, we'll concentrate

on the basics.

lcons play a critical role in the operation of the Macintosh — and
for that matter, almost any popular computer in the world. They
show you, at a glance, the exact nature of a particular file.

As you can see from this table, the look of an icon can show you what the icon
represents. An icon that looks like a folder is just that: a container in which
other folders or files may be located. An application icon is usually a small
picture that (hopefully) is related to the type of tool the program provides; and
finally, each application has specific types of icons that it uses when you save a
file containing your work.
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This might sound silly, but
make sure that the cord is
coming out of the top of
the mouse, or else when you
tove the mouse up, the
arrow will move down. When
we were in the business of
supporting publishing
installations, a support call
came in and this proved to
be the problem. We just

thought we would mention it.

Using the Mouse

The most fundamental skill that you will learn is the use of your mouse.
Without this pointing device to access the various menus, dialog boxes, and
functions available to you, you would need to learn literally hundreds upon
hundreds of complex keyboard commands. An experienced operator makes
use of both keyboard commands and the mouse; depending on the type of
work he or she does, they might lean heavily towards one or the other.

Artists working on digital images, architects, or anyone doing a lot of drawing
and painting all use the mouse much more than they do the keyboard. They
might access various tools from the keyboard, and they often find themselves
entering type or numbers into their designs, but the mouse is their primary
connection to the Macintosh.

Other people, such as copywriters, account supervisors, customer service
representatives, salespeople, accounting personnel, and data processing profes-
sionals spend a lot of time at the keyboard. Their typing skills are usually
superior to those of someone who uses the mouse all the time, but their eye-
hand coordination — the time it takes them to get the arrow onto the right
part of the screen to click a button, for example — might not be that great.

As a student, you should seek to become proficient with the mouse as soon as
possible. You'll get plenty of practice during this course.

CLICKING AND DRAGGING

The first thing to learn is how to click on something and drag it around. While
this might not sound important, you will come to learn that it’s a critical skill.

Clicking and dragging is just that: you point at something, hold down the
mouse button (if you're working on a Windows system it’s usually the Left
mouse button), and move it around. This works for folders, icons, moving
items from one folder to another, or from your system onto a floppy disk or
removable hard drive. It feels a bit clumsy at first, but will become second
nature as you gain experience.
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Clicking and Dragging

1. In the upper right corner of your desktop there’s an icon that represents
the hard drive in your computer. In the lower right corner, there’s a little
garbage (excuse us, Trash) can. We've shortened the distance between the
two for this visual:

Throughout the course
you'll be seeing these

graphics, which are called

. 2 2. Position the arrow directly over the Trash icon and press down — and
screen captures.” Remem-

; hold — the mouse button. The icon will become highlighted. Move it up
ber that our system is

orchablizees upulisie the screen until it’s directly below the hard drive icon. Let the button go —

Aifebrertly st Youes 5o essentially dropping the icon in the new location.
they might differ slightly.

Most of the time theyll be
close enough so that you'll

immediately recognize

what's going on during an
exercise or lesson. 3. Now click and drag the hard drive icon until it is to the left of the Trash
Can icon:

It's important to keep the

hard drive icon positioned in

the upper right hand comer

of the desktop —it's DouBLE-CLICKING
common practice, and the

The next important thing to learn is the ability to click the mouse button twice
machine looks there first . . . ; . e ]
in rapid succession. It’s called, appropriately, double-clicking. If you position
when it's starting up, so if . ) . .
your mouse on an icon and double-click your mouse, something will happen
it's there, the machine will , . ;. .
— as we'll see in this next exercise.

“boot” quicker.
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Don't be confused by the
word Windows — we're not
talking about Intel-based
computers running
Microsoft Windows. The
term Window predates
Microsoft's operating
system. A window is a
graphic that shows the

contents of a file or folder.

Double-Clicking an Icon

1. Position the arrow directly over the icon for your computer’s hard drive.
In our example, the name of the hard drive is MacHD. It might be called
something else on your system, but it should be there.

2. Double-click the icon. It will open into a Window.

3items, 1.5 GB available
F
System Fnlder Applications Documents
[+ |
(| [» ]2
Working with Windows

A Window is a fundamental component of the Macintosh Operating System.
Windows sit on top of the desktop, which is always functional and immediately
available. Windows serve two functions:

+  Displaying the content of folders, hard drives, removable disks, and
CD-ROMs, or

*+  Letting you use different application programs. In most cases, pro-
grams show you a window containing the document that you're
working on and provide different sets of tools that you use within the
window. Many programs will let you have more than one document
open at a time.

We're going to start out with the first kind of window: the one that displays the
contents of a hard drive or folder.
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Working with a Window

1. Position the Arrow over the icon of your hard drive. It’s the icon in the
upper right corner of your desktop. When the Arrow is over the top of the
icon, double-click the mouse button.

2. Itwill open into a Window. Some of the items inside might look different
on your system; you may have more or less folders, or you might have
folders and other icons representing files or applications. Here’s what our
hard drive looked like when we double-clicked the icon and it opened into

a window:
Close Box Title Bar Auto Resize
oD iaEld—— Minimize
i , 1.5 GB available
Number of items — & -
Total Available Space SyemEier _, Agplications  bocuments
Whenever you see an // Hg—— Scroll Bars
illustrated window like this Contents —
one, where we've put titles
and arrows pointing out T | —— Manual Resize
specific features, look at it :
Anatomy of a Window

and read the callouts, We'll
often refer to these
illustrations in that area of 3. Move the Arrow over the lower right corner of the window, to the Manual
the text. Resize handle. Holding down the mouse button, drag the corner inwards,

reducing the size of the window. When you let go, the window will remain
at the size you made it.

— MachD |
3 items, 1.5 GB available

System Folder Applications Documents

X

[z

4. Resize the window until some of the contents are hidden.
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Once you've become familiar
with the basic components
of a window, such as scroll
bars, resizing handles, and
close boxes, you can rest
assured that all Macintosh
software will present
exactly the same type of
window, and that they'l all
work the same way. That's
why once you've learned one
program on the Macintosh,
you've gone far towards
learning the basic opera-

tion of any program.

Scroll bars are an important part of managing windows on your Macintosh,
because it’s not uncommon to have more things in a folder or on a hard drive
than can be seen at one time. That’s where scroll bars come into play. Here’s
how they work:

If you click once on the arrows at
the top or bottom of the scroll bar,
the list will move up a bit at a time;
click and hold the arrow and the list
will scroll continuously.

Clicking and holding the Slider will let
you move the contents up and down at will.

Clicking on the gray area will move the
content area the width (or height)

of the visible area, exposing the next
region of the window.

The Scroll Bar is an important component of all windows.
You can hold the Slider itself, click or hold down the arrows, or click the gray area.
Each method moves the window's contents in a slightly different manner.

5. Once your window is too small to show all the contents, use the sliders to
expose items you can’t see.

0 =——=MactiD——=FH
3 items, 1.5 GE available ﬁ

-

% |

System Folder &pplications Docy—1
|« [T U O » | 7,

The Scroll Bar becomes active as soon as you make
the window too small to show all the contents of the window
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How you organize your work
area is a personal thing,
and often closely parallels
your habits on a real desk
(as opposed to an elec-
tronic, or “virtual” desk). If
you're sloppy, and your desk
is normally buried under
tons of paperwork, so too
will be your Macintosh’s
desktop. If you're a real
control head, and keep
every single thing in its
correct spot in the
universe, then your
Magcintosh will be equally
well-situated. We're of the
buried-under-the-rubble

breed of operators.

10.

Next, move the Arrow over the top of the window (over the Title Bar),
click, and drag the window around. You can position the window any-
where on the desktop — even with part of it hanging off the monitor!

Double-click the Title Bar. Watch what happens:

You could double-click the Title Bar one more time to resize the window
back to where it was before you minimized it, but you can accomplish the
same thing by clicking in the Minimize button (the one in the very upper
right corner of the Title Bar). Do that now.

Click the Auto-Resize button (the second one from the upper right corner
of the Title Bar. The window will get just big enough to show all the
contents:

You will notice that when you're working with a window (resizing it,
moving it, etc.), the Title Bar shows a series of black horizontal lines.
These lines indicate that this is the Active Window. Click anywhere on the
desktop outside the window, and see what happens:

" MacHD

System Folder Applications Documents
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11. You will notice that the Title Bar of that window is now grey — the lines
indicating that it is active have disappeared. Click on the Title Bar again. It
will be reactivated. This is very important when you have several folders
opened at the same time. We will see this feature in action a little later on.

12. Close the window by clicking in the Close box (in the upper left corner of
the window).

Anatomy of a Window

Whether you're looking at the contents of a folder or disk drive, or working in
an application program that provides a window for you to work in, the basic
features of a window can be found almost universally within Macintosh

programs:
The Title Bar contains the name of the folder or hard drive.
The Close Box closes the window.

Auto-Resize expands the window to display all of the contents, or shrinks it to
where you previously sized it. If the contents require more than the space
available on your monitor to display, the Window expands to fill the entire
monitor.

Minimize shrinks the window down to its Title Bar, or, if the window has
already been minimized, it returns it to the size it was when it was shrunk.

The Scroll Bars allow you to move the inside of the window horizontally or
vertically so that you can see items not currently in the visible area.

The Resize Handle lets you click and drag the window to whatever size suits
your needs.
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Working with Menu Bars

Whether you're working on the desktop or you're in the middle of drawing a
masterpiece using an illustration tool, there will be menus available at the top
of the screen. Menus are the fundamental method of controlling things on
your Macintosh.

" & File Edit View Special f Help

This is the standard Macintosh menu bar — the one that appears when you
first turn on your machine, and before you've started any additional programs.

Although all menus work the same way — you click on them and slide down
until you're at the choice you want to execute — menus change, depending on
what you're doing at the time. Menus on the Macintosh are called context
sensitive menus, since they change depending on the context within which
they’re working,. At this level (the desktop), menu choices reflect things like
opening and closing folders, making new folders, shutting down the computer,
or emptying the Trash (more on that later). The options available to you at this
point are related to working on your desktop.

If, on the other hand, you were working in an illustration program, the menus
would reflect drawing and viewing tools — more relative to drawing than to

working with folders:
LN Type  Filter View Window  Help
Transform ¥l :
Arrange »
Group RG
Lock *®L
stk Al
Hide Selection ®U
howAll |
Rasterize..
Path »
Masks y| Bunite
Compound Paths | 4 Intersect
Cropmarks » :_‘E""““
Graphs p| '<bMinus Front
P Minus Back
B Divide
B outline
B3 Trim
B3 Merge
Qcrop
(@ Hard
[ sor...
S Trap...
Options..
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While working in an image-editing program (one that lets you modify the way
scanned photographs appear and reproduce), the menus would show things
like brightness and contrast, and similar image-related functions.

" & rFile Edit BEEETTE Layer Select Filter View Windoy

=i Levels... %L
AL 1 Auto Levels aBL
[=1ENI 1. Duplicate... Curves... BM

- LR Apply Image... ey

LAV S ] Calculations... Brightness/Cantrast...
@7 |
% 243 H Image Size...

EE Canvas Size... tural
C). bl Replace Color...
AW | Rotate Canvas p i, i
hYIE i Invert £
& /" & Histogram... Equalize

L Threshold...
DIK ', Posterize...
E—‘ & Variations...

Throughout the course you'll be working with menus — both from the
desktop as well as from inside of application programs.

Working with the Menu Bar

1. Move the Arrow to the first menu selection. It’s called File. Click once on
the word. A menu will slide down from the menu bar, and you'll see the
choices available to you:

[ Edit  View Special Help
New Folder %N [ R

Find...

Page Setup...
Print Desktop...
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You should notice that to
the right of the Help menu
selection, there is the
symbol for the Command

key and the Question mark.

This is called a Keyvbozard
Equivalent, That means
that there's an alternative
way to access that
particular command (in
this case accessing the

Help window).

Hold down the Command
key, and press the Question
Mark (which is on the lower
right side of the keyboard;
pressing Shift at the same
time isn't necessary). The
Help window will appear
without having to go to the

menu bar,

Learning keyboard equiva-
lents doesn't happen
overnight, but you should
try to remember them and
use them whenever possible
— it will make you a much
more efficient and speedy

operator.

2. Slide over to the next menu — the one called Edit. That menu will unfold
from the menu bar and you'll see more options. Don’t worry about what
they do just yet — you'll have plenty of time later on to learn all the
commands:

“Zilis View Special Help

SelectAll %A [0
Show Clipboard §

Preferences...

3. The next in line is the View menu, where you can change the way files
look and behave on your system. This is another menu that we’ll explore a
little later on in the course:

Edit 81508 Special  Help
=, as lcons
as Buttons

Clean Up
Arrange
View Options...

4. Next, slide past the Special menu, and take a look at the Help menu. Once

it appears, slide the Arrow pointer down until the word Help is high-
lighted. We will discuss the Help system in the following section.

File Edit view Special J1EH

AboutHelp  FEE
Show Balloons :

| Help #?
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The Help System
Buttons
[T ] R R R TR

This section will provide you “ ‘ Mac OS dp 1% | !

) ] , 3 it Topics Index Look For
with some experience in e i
usirg the built-in Help List of e I B = =

i lApplication Programs H i
system that Apple Help Topics s s i Dleoqsﬂ_ons qbout
N g vl ot Help topics will
Prevides-With the pritig appear here in this
onts
Macintosh. The exercises Disks area.
{CD-ROM Discs
are designed to familiarize Sl ~ =]
you with how the system L e
works — not to go through !
2 $ Scroll Bar

the hundreds of topics

available. You should make s . . J ‘
The Help system built into the Macintosh is a powerful and effective aid that

will provide answers to your questions and instruct you to perform specific
functions. While a structured, hands-on course like the Against The Clock
series of instructional guides is the best way to start learning, a comprehensive

extensive use of the help
system as you're learning.
Later, it will become just
another thing that you y .
, , Help system is an indispensable tool as you move forward.
don't use. We always install

Helpfileaheh W punchass The buttons at the top of the window will let you use the Help system in one of

three ways. You activate a button by clicking on it once. It will become high-
lighted, letting you know that it’s selected. The three buttons on the Help

new software. Some of the
systems are very compre-

hensive, while others hardly

window are:
provide any assistance at
all. You will come to love *  Topics, which provides a list of important topics that new users are
help systems if you're particularly interested in.
anything like us — bad at
reading manuals. Help *  Index, which provides an alphabetical listing of every subject covered in
systems are meant to be the extensive Help files that came with your Macintosh, and

available at exactly the

ke yaiheeswhem: »  Look For, which lets you enter words or phrases and then performs a

search of all the available information. When it finds a relevant topic, it
displays it for you.
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Some icons are buttons,
and some aren’t. Buttons
need to be clicked only
once, while a regular icon
needs to be double-clicked.
It's usually not a problem if
you accidentally double-
click a button. Your
computer won't blow up or
anything, so if in doubt,

click away.

1.

4.

Help Topics

Click on the first of the three buttons.

2. Put the mouse on the slider, click and hold it, then move it down. You will

see the list on the left move. When you're done, move it back to the top.
Click once on Learning the Basics, in the left window. The right side of
the window will display a list of basic topics:

[EES

& Mac OS Help |

Topics

Index Look For
1. Click a topic area: 2, Click a phrase, then click OK:
Learnng the Bascs_ ENRGET -
Sound E = About =]
|Application Programs the System Folder e
Vonitors (standard settings) i icons
(Organizing Your Files menus
[Customizing Your Caomputer windows
Printing — How do
Fonts use Mac OS Help?
Disks undo a mistake or cancel an action?
(CD-ROM Discs open an item?
|Color = move an item? =
Speech - resize a window? -

3. You will see that the list is broken into categories. The second category is

called How do 1 and is followed by a list. Double-click the item named

resize a window:;

u]

=1 |

How do | resize a window?

i ;...':T.‘...Zaom
EE box
3.3 MB availsble
Size

-

You can resize a window by dragging the size box (in the
lower-right corner) or clicking the zoom box
{upper-right corner}. The zoom box expands the
vrindow to show its complets content or shrinks the
vrindow to its most recent smaller size.

Read this information, then click the right arrow,

ST v 1 5o

[a]

(1]

In the lower left corner of the window is a small up arrow that looks like
this: [ a |. Click on it and you'll return to the main Help window.
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INDEX

The second way you can use the Help system is through the built-in Index. The
Index provides the same information as the Topics button, but presentsitina
different order. This is the case with all three methods of accessing the Help
system.

Using the Help system, particularly when you’re new to the Macintosh, is a
great way to find important information and, at the same time, it gives you a
chance to practice clicking, scrolling, and working with windows.

The Help system is, in fact, an application program that is built into the basic
Operating System.

Finding Information Alphabetically

1. Ifit’s not already visible on screen, bring up the Help window, either by
using the mouse and selecting it from the menu bar, or by pressing the
Command, Shift, and “?” keys at the same time.

2. Click the middle button at the top right portion of the window; the one
that says Index:

B Mac OS Help |

This special slider Topics

Many different applications
make use of split windows
like this one, where a list
appears in one side, and
the content in another.
Some Web sites on the
Internet also make use of

this technique.

works just like the one
on an old telephone
directory; you slide it

to the appropriate letter
and it gives a list of

all the commands that
start with that letter.

p

W1 Clicka term or drag the slider

JABCDEFGHISXLMNOPQRS
ACCent color
accent miarks
access

acCess parvieges
ACTvating
active program

This scroll bar lets you
view entries that are
= currently outside the
visible window.

3. Move the slider button (the one over the alphabetic categories) until it is
on top of the letter “I.”
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Lots of software applica-
tions make use of visual
metaphors such as this
one, which duplicates the
way an old-fashioned paper
booklet telephone directory
used to work. It makes
using software more
friendly by making a
connection between
something familiar (the old
directory) and something
completely different (like a
digital help system that's
invisible until you call it up

magically).

(] :
& Mac OS Help E=l
Topics Index Look Far
1. Click a term or drag the slider:
ABCDEFGHIPKLMNOPQRS [-]
-
IDE ™|
Info window
initializing disks - |
insertion point ;.E*'J
instalation 2
Internat
IP address -
Key Caps . | |
keyboard v -
ok 1

4. Click once on the first entry in the listing: the word icons. The content
window to the right will fill up with subjects related to icons and how they
work:

[ B Mac OS Help 3]
Topics Index Look For

1.Click a term or drag the slider: 2.Click a phrase, then click OK:

: dragging options
‘| |~ Definitions

desktop

™1 ion

| |~ How dol

i sort icons?

change system fonts?

change the color of an icon?

5. Double-click on the word icon, under the Definitions category, and you
will see a brief description of an icon:

An icon is a picture that represents a disk, program,
document, or folder. You work with these items (for
example, cpen, copy, or mave them) by manipwlating
their icons.

o & (1 @

Hard Disk  SimpleText Letter System Folder

Ej Huh? }"II f:
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These small arrows, used
here to collapse and
expand the topics list, are
another very common
graphic element used
throughout the Macintosh
system. [t's another visual
tool that works the same

way wherever it's used.

You might notice that next to each topic there is a small arrow. You can collapse
topic headings into a more manageable outline by clicking on the arrows:

B

Look For

¥ Mac OS Help

Topics

ndex
1. Click a term or drag the slider: 2, Click a phrase, then click OK:

Help

ABCOEFGHIbKLMNOPQRS (TR,
ons icons

organizing your files
Info window dragging options
initializing disks _| |= Definitions
insertion point desktop
installation icon
Internet i How dol
IP address || M sort icons?
Key Caps change system fonts?
keyboard change the color of an icon?

I

Click on these small arrows and you can
collapse the topics into an outline.

[Hel ;
l}e zhnu! K = i

[»

P About
[ Definitions |> Definitions
7 How do | > How do |
SOrt iCons? P Why

change system fonts?
change the color of anicon?
change the name of an icon?
change the way files are represented?
change an icon’s picture?
assign a label to an item?
= Why
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Look For

Perhaps the most effective method of finding information from the Help
system is through the use of the Look For command.

Looking for Topics

1. Click on the Look For button on the Help window.

2. Click on the small arrow on the left side of the window, enter the word
“Folders,” and click the Search button:

O] AL

Topics Index Look For

1.Click the arrow, then type the 3.Click a phrase, then click OK:
term you want help on: Help

S e R Ao

(b] rocers i | spring-open folders
organizing your files

< Definitions

access privieges

Applications folder

Documnents folder

folder

2 icon

As we mentioned, almost System Folder

window

Tu»

q

all programs come with

some sort of help system

built in. Although they don’t
il 3. Feel free to look around the Help system for a while to familiarize yourself

with how it works. When you’re done, click the Close box (in the upper
left corner) and put the Help system away. You can always access it any
time you need it.

all look exactly the same,
they all work on the same
basic principle of topics

and indices.

CHAPTER 2: USING THE MACINTOSH PAGE 39



If you've used computers
before the Macintosh,
you're old. Just kidding. If
you have, you might be
familiar with the term
subdirectory. A folder is a
visual metaphor for a

subdirectory.

Using Folders

You've already double-clicked an item when you opened the hard drive icon in
an earlier hands-on exercise. That’s going to help you in this section, where
we're going to discuss the way folders work on the Macintosh — and how you
can create, name, arrange, and throw one away when you don’t need it any-

more.

WHAT ARE FOLDERS?

You can tell a folder when you see one: it looks just like a folder would look on
your desk. Well, maybe it looks a [ittle digital, but then again, this is the com-

puter world.
applications
CREATING FOLDERS

Learning how to create folders is one of the most important, fundamental skills
that you will call upon when setting up your system, getting ready for a project,
or backing up your important files; in short, you will be creating folders from
now till those proverbial cows finally show up at the old homestead.

Creating folders is really quite simple, as you'll see from the next exercise. It’s
not making folders that’s the hard part — it’s keeping them organized.
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Creating a New Folder

1. Ifyour hard drive icon isn’t open (displaying a window with the drive’s
name in the Title Bar), double-click it so that it is. Click once in it just to
make sure that it’s active (the Title Bar has lines in it and isn’t just plain

gray):

O MacHD =
3items, 1.5GE available

System Folder Applications Documents

2. Resize the window so that you can see more of the contents:

=] MacHD =
Bitems, | 5 GB available

& 9

Applicatians System Folder Applications Documents

Documents

3. Move your Arrow until it’s in the menu bar at the top of your desktop.
Click on the File menu, let it appear, and slide the pointer down until New
Folder is highlighted. Click the mouse button.

j o LN Edit View Special Help
New Folder L
Open

Close Window
Get Info

Label
Sharing...

Make Alias
Put Away
Find...
Page Setup...
Print Window...
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4. Assoon as you let go of the mouse button, a new folder will appear in the
window. The name of the folder is highlighted. Type in the words:

“My First Project Folder”

Don’t worry if you make a mistake, just use the Delete key on your key-
Throughout the exercises board to back up and retype it:

we say things like “name

the folder Harry” You don't Bz

-~ MacHD - B
have to use our names — 4items, 1.5GB svailable
it will just make it easier,
because that way the System Folder Applications Documents

screen captures will look A

the same as your system.

Click the Arrow anywhere in the window (not on an icon) to deselect the
folder.

RENAMING FOLDERS

It’s important that you know how to change the name of a folder. There are
plenty of times when this is necessary: when you want to add a date to a
folder’s name, when you want to correct a misspelling, or when you want to
change a name in order to better organize a collection of folders. Doing so is
simple:

Changing the Name of a Folder

1. Click once on the folder you just created. It will become highlighted:

My First Project Folder
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2. Hit the Enter key on the right side of the numeric keyboard. If you don’t
have a numeric keypad (or if you just want to do it a different way),
simply put the Arrow Pointer over the top of the name and wait a second
or two. A box will appear around the highlighted name of the folder,
indicating that you can now type a new name. Change the name of the
folder to Project Folder:

[F‘roject Fnlder]

NESTING FOLDERS

Nesting folders refers to the process of putting folders inside of other folders.
We don’t really know why it’s called nesting, it just is. Some old computer geek
needed to come up with a meaningless term to confuse non-computerites, we
suppose.

For this exercise, we're going to use some of the files that came on the CD-
ROM (supplied with the book).

Organizing Folders

1. Double-click the Project Folder you just created. It will open up and
display its (now empty) contents window. Notice how it sits on top of the
folder inside of which it was created:

MacHD
Project Folder
Oitems, 1.5 GB available
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8. Drag the two folders over to the Project Folder. You will see them move.

Drop them onto the window by releasing the mouse button:

0. . Workngwithfolers | . 8| gl s Pl el
6 Hame, 1.5.G8 walloble |
T Berries Berries Preture Capy Files Graphics Ariborrdy
= oy,
SampiaTi'e #1 Rough Rnder Ad
T
] Jusriniia aal]

9. Drag the Banana Boat icon onto the top of the folder called Graphics.

Hold it there a moment, and the folder will open. Drop the file:

- Graphics

2] =]

1 item, 1.5GB available

el

Banana Boat

10. Close the folder by clicking on the Close box. Next, take the Gardening
Panel icon and simply drag it onto the Graphics folder and drop it imme-

diately. It will go into the folder without opening. Remember, if you wait a

moment, the destination folder will open by itself; if you simply drag

something onto a folder and drop it, the item will automatically move to
that folder. Open the Graphics folder and check it out:

Ba

nana Boat

Gardening Panel

O Graphics [=]
2 items, 1.5GB available
A Ao
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11. Put the Berries file and the Sample File #1 file into the folder that you
named Copy Files:

75 CopyFiles =
2 items, 1.4GB available

2
el i

1] |»

12. Put the Rough Rider Ad file into the Artboards folder, and the Berries
Picture into the Graphics folder, along with the other two images you
dragged into it.

13. When you're done, the Working with Folders folder will be empty, and all
the files will have been organized into the three folders that you created:

Q Q Q

Copy Fiben Graphics Artbosrs

0 WerkingwRth Folders = = EEI Frojert falder

'”—*—”"*‘*_’"‘I;‘ ,

14. When you've finished with this exercise, Close all the folders so that your
desktop is empty (or at least the exact way it was when we started the

exercise).

] Copyfies gE| [© Grephics e8| [O — Artosrds 28|
| ]

tema 8 wrwladle 3 fems, 1 468 evailedie 1 fiem, 1 4GB svatloble
N m | i

Barans Bost Gardest g Fare] Berries Picture Rough Bider A2
B
-8 | i
~
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There is no question in our
minds that the most
difficult concept for a
beginning student to grasp
is how to dig around
through folders to find
what they need. This is
particularly true when
you're inside of an applica-
tion, and need to navigate
directly to a specific folder
in order to find the right
file. Take special care to
study this issue until you're
quite comfortable with how
folders can reside inside of

each other.

NavIGATING THROUGH FOLDERS

What you just did in this last exercise was to create a Project Folder with three
sub-folders inside of it. When you're working on projects, especially compli-
cated ones, your folder structure can become equally complex. Knowing where
you are at a given time, and being able to see — at a glance — which folder
happens to be inside of which other folder, is very important.

When you create a folder within a folder it is considered a nested folder.
Another word for nesting is the hierarchy of your files and folders. You can
think of hierarchy as a standard flow chart, with the desktop being at the top,
and all other things being either at the same level, or at some level below the
desktop.

Organizing Folders and Files on the Macintosh

. Things on the desktop include:

Hard Drive Any other file, folder, or item CD-ROMS
(MacHD) that you put on the desktop Vhe Trash G O[;]!:\OP?:'EE
er Media
DESKTOP (these appear
when they're
inserted)

Stuff on your Hard Drive includes:
I

System Folder
You created this folder and the folders

that are now inside of it during the last exercise.

Applications
Documents J
P ————n = e =
Project Foldeq\ ‘ Fiwem, (dCBealatle

i (23] i

Any O‘thr‘ ﬁlc fOMGI’ Bangna Dost Gardening Panel Berries Picture

or item that you put
/
Sample File #1
g =

on the hard disk
You dragged these files into their respective folders from
the Working with Folders folder, which was inside of your Student Files folder

T

Folders are the backbone of file organization on your Macintosh. You should always try to
keep your work organized into sensible, easy-to-understand groups. You do this with
folders.
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Identifying a Folder’s Hierarchy

1. If any folders are open on your desktop, close them.
2. Double-click your hard drive icon.

3. Hold down the Option key and double-click the Project Folder. You will
note that the Hard Drive window automatically closed when the Project
Folder opened. This automatic closing of one folder when you open one
of its subfolders is very important when you're going deeper and deeper
into nested folders. Otherwise you would have to either close each one
individually, or live with a very cluttered desktop.

4. Do the same thing with the Graphics folder. The Project Folder will close,
and the only thing left on your desktop will be the Graphics folder:

Graphics

3 items, 1.4GB available

oo K] B

Banana Boat Gardening Panel Berries Picture

5. Hold down the Command key and click-hold on the folder’s name in the
Title Bar at the top of the window. Something called a Pop-up Menu will
appear. (It’s called a pop-up menu because that’s what it does. You will see
many more of these during the balance of this course.)

2 Project Folder

 MacHD
ot 7= BE i

Banana Boat Gardening Panel Berries Picture

o)
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6. Slide your Arrow down until the word MacHD (or whatever your hard
drive is named) is highlighted. Let go of the mouse button:

| @ Graphics
z{Q2 Project Folder
- D
Banana Boat Gardening Panel Berries Picture

SNE

4] ID

7. Notice that when you selected your hard drive by Command-clicking the
Title Bar, its window automatically opened. You can use this technique at

any time either to open the “containing folder” or simply to look and see
where it is you're working at any given time.

i 3l Graphics i B
Ao, 1.4 63 avatladle

sm%mr mngnu m%m E -

! Banaca Beat Garduning Pasel Barries Pictors

T L

8. When you're done, Close all the windows again.
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CHANGING VIEWS

Another very important aspect of managing and arranging your folders is how
the contents appear when you open them.

So far, we've been looking at icons, and while that’s fine for some applications,
there are other times when a folder contains so many files and folders that it’s

simply impractical to move around using only little pictures of files. There are
times when we need to look at lists. Icons are pretty, but lists are very effective

under certain conditions.

For example, if we open our System Folder (which is a special folder we’ll be
talking about a little later) into a large window, we see these icons:

(] System Folder [ul=]
21 tems, 1 4GB availadle
Fimder Apple Mary Items Control Pansls HDT Extn™ Config MacTCP DNR
[ 51 &l
Fonts Extansions PrintHonitor Documents
B Q
Application Support Claria Clipboard

! oY

Cantrol Panels (Drssbled) Contral Strip Modules Eudors Folder
Q ol 1 & Gl
DataYiz Edite=s Extensions (Disadled) Script Eeitor Stationery

qhypha folger Launcher Items
- o 2l
Preferances Scrapbook File Scripting Adaitions
_— - =,
o ™ o
Shutaown Items Shutdown [terny ( [nsabled) Startup Items

i

Startup 1tems {Disabled) Systen
RV

System Extensions (Disedled)  Text Encofings

This isn’t even a very radical example. Folders might contain hundreds of files
— a catalog which requires 400 or 500 individual scans to complete, for

example — and can be very tough to look at.

Fortunately, there are many different ways that you can arrange your files in an

open window.
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Changing Views

I

2. Go to the menu bar and select Diew:

Double-click your hard drive icon, then hold down the Option key and
double-click the Project Folder you created earlier.

MSpeclﬂl Help L

+ as lcons
as Buttons
as List

v as Window

as Pop-up Window

Clean Up
Arrange

View Options...

»

3. Slide down until the as List selection is highlighted. Let go of the mouse
button. The Project Folder will now display its contents as a list instead of

as 1cons:
0= = ProjectFolder == = == IR
3items, 1.4GB available
| Date Modified |
Today, 10:27 AM [
b G CcopyFiles Todoy, 10:26 AM
b Cq Graphics Today, 10:27 AM
Juf S0P

4. You'll notice that each folder’s name is listed on the left side of the win-
dow, and the last time the folder was modified (or in this case created) will

be displayed in the next column.
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Whenever you close a folder,
it remembers the view
options that you selected
before it was closed. This
ensures that you can keep
some folders all open within
each other, others closed,
and still others with

different view options,

5. To the left of each folder’s icon and name is a small arrow. Click the arrow

directly to the left of Artboards:

— Project Folder !

Date Modified

rds
B8 Rough Rider Ad

b (3 CopyFiles

b [ Graphics

Today, 10:27 AM
Yesterday, 2:42 PM
Today, 10:26 AM
Today, 10:27 AM

K}

6. Do the same thing to all three folders:

- Project Folder -

9items, 1.4GB available

|| Date Modified

- 34
B8 Pough Rider Ad
< Q Copy Files
[ Berries
[5) sample Fits =1
= [ Graphics
[l Banana Boat
Il Berries Picture
Gardening Panel

Today, 10:27 &M
Yesterday, 2:42 PM
Today, 10:26 AM
Yesterday, 2:32 PM

Mon, Nov 17,1997,

Today, 10:27 AM

Yesterday, 2:20 PM
Yesterday, 2:13 PM
Yesterday, 2:18 PM

2

L

[»

7. The list view contains a lot of information about each file that doesn’t

show in icon view. Enlarge the window to the right, until you can see all

the categories:

Project Folder 0Enmimiini IR

9 itama, | 450 wvallable
Date Hodifled

e l YRR

Todsy, 10:27 AM

Rough Rider M Yestarday, 2 42 PM
~ 3 Copufites Today, 1026 AM
[2) serrien Testarday, 232 PN
[CE ] Fen, Nav 17,1997, 12 55 PH
w [ Graobics Teduy, 1027 AM
[l Bavans Boat Yesterday, 220PH

[ Berries Pcture
3 Gardening Pasal

Yestereay, 213 PH
Vesteron, 2 18 PH

fotder
258K Phateatep® PICT file
- tolder
1296 StmpleTaxt text scument
1296 SimplaTaxt atativsary
- foldar
1296 Phateshap® PICT File
1946 Photeshop® PICT file
2580 Photeshep® PICT file

8. Click on the arrows again to collapse the outlines until you only see the

three folders again.
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When you get a chance, you
should check out View
Options. Access it by
Control-clicking inside the
window, and selecting It

from the pop-up menu:

This window lets you set
the way icons behave within
a window. We normally keep
large icons, and don’t
automatically arrange
them to an invisible grid.
Try changing a folder's view

to as lcons, and messing

around with these settings.

This time, instead of going to the menu bar and accessing the Diew menu,

hold down the Control key (on the lower left of your keyboard) and click

inside of the window.

Another pop-up menu will appear:

ﬁrlboar 5
b (3 CopyFiles
b [ Graphics

3 items, 1.4GB available
, Date Modified |
ik ;27 -
Help L 10:27 4M =
RS Eoldan L} | et
W

Close Window | b iR
Get Info
Sharing...
View >
Sort List »
View Options... -

' vl

i

10. Slide down until the View pop-up menu appears, and slide down that list
until you highlight the “as Buttons” option:

Project Folde|

p [ Artboards
B Cq Copy Files
b CJ Graphics

3 items, 1.4 GB available
Date Modified
10:27 &M
Help  liozeam
New Folder 10:27 AM
Close Window

Get Info
Sharing...

~ as lcons
as Buttons

Sortlist )

View Options... [v as List
: _|v as Window

as Pop-up Window

11. When you make this selection, the folders inside the Project Folder will
appear as buttons — just like the ones we used to select how to use the
Help system (remember?).

O=

... ProjectFolder=—— — = HB

Q

| P——
Copy Files

3 items, 1.4 GB aveilable

Graphics Artboards

<]
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If you've ever used a
Windows-based machine
(the Microsoft kind), you're
probably familiar with the
Minimize command. This
command reduces a window
to a small button at the
bottom of the Windows
desktop. That's basically
what Windows as Fop-ups
does to a Macintosh

window.

12. Try opening one of the folders. Now you don’t have to double-click; a
button only needs to be clicked once:

= Copyflles——————[Q
2 items, 1.4 GB available

&

13. When you're done, Close all the windows again.

WiNDows As Por-up MENUS

As we've already stated, there will be times when your monitor is so filled with
folders that you can’t find the forest (an important file) for the trees (jillions of
folders opened and all over the desktop). There’s a third way to view folders
and their contents: it’s called a Pop-up View.

We’ve used pop-up menus already; that’s how we accessed the View menu in
one of our exercises (by holding down the Control key and clicking in the
window). This is a different sort of pop-up, though. It takes the active window
and collapes it into a button that sits at the bottom of your monitor. You click
the button and the folder opens into a tabbed window. Click it again, and it
goes back to the bottom of the monitor and waits patiently until you need it.
That way it’s close at hand, but still out of the way of a busy desktop.
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Turning a Folder into a Pop-up

1. First, double-click your hard drive icon to open it, and double-click the
Project Folder to open it as well:

MacHD

diterna, 1.6 GE available

L Applications Documents

Project Folder

= Project Folde
3Fitems, 1.6 GB available

[»

Copy Files Graphics Artboards

4]

] ¥ |7

N

2. Hold down the Control key, and click inside the window (Control-click).
A pop-up menu will appear. Slide your pointer down to View, then down
to as Pop-up Window:

=== Project Folder =
3 items, 1.6 GB available

Copy Files Graphics New Folder
Close Window

Get Info —

=

Sharing... ——
2 v as lcons
Clean Up as Buttons
Arrange b as List
View 0ptions__l, a5 window

4
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This might be a good time
to check out the Label
function. Select a folder

and Control-click:

[Ereln
Open

_ MoveToTrash
Label »
Sharing...

Duplicate
Make Alias

Slide down and choose
Label: You can then set a
color and a label from the
pop-up. Later, when you
learn to use the built-in
Find command, you can use
these labels as a search

method.

I Essential
I Hot

B In Progress
% Cool

Il Personal
B Project 1
Il Project 2

Get Info 4
:

3. The window will resize and assume its position in the lower left corner of

your monitor:

Project Fnlq:gr

Jitems, 1.6 GB available

Copy Files Graphics Artboards

As you can see, the Title Bar is no longer in the center of the window.
Indeed, the folder isn’t even displaying a conventional window anymore.
The Title Bar is on a “tab” at the left side of the pop-up window. Click on
it:

. Project Folder

Click on it again. Double-click the Graphics folder and turn it into a pop-
up window by Control-clicking and sliding down to as Pep-up Window.
Now you'll have two “tabs” on the bottom of your monitor:

. Project Folder I Graphics .

Experiment with your viewing options. You can, for example, have one of
the pop-up windows view as Icons, another view as List, and another view
as Buttons.
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Using the Trash Can

We know people who could best be described as a computer-age pack rat. They
have every file, folder, icon, picture, game, saved game, email, and downloaded
file that ever hit their computer’s hard disk. At some point they buy more hard
disks, hook them up, and continue building their electronic equivalent of
Idaho’s The World’s Largest Ball of Twine and Other Useless Stuff museum.

In the real world though (the one you occupy, hopefully), there will be times
when you want to throw something away. It might be a file that’s been super-
ceded by another, it might be something you just don’t need anymore, or it
might be something you hate — like the stupid game that you paid $60 for and
can’t make it out of the very first room of the 12,000-room dungeon.

At times like this, it’s fortunate that you have the Trash Can. The Trash can is
your friend. It lets you junk, trash, rip-up, discard, and otherwise get rid of
stuff you don’t want anymore. It also lets you discard important stuff that you
need really, really badly (fret not, you can always dig around in there and find it
— at least until the garbage truck comes, so to speak).

Throwing Things Away

1. Open your Project Folder. Make sure the view is set to as Icons and as a
Window. Make three new folders inside. Call them Junk, Misc., and Stupid
Games:

copy Files Graphics Artboards

2. Open the 6raphics folder. Make sure the view is set to as Icons and as a
Window. Position it so that you can see the contents, and can also see the
three new folders you just made.
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Want to try something
useless but cool? Control-
click on your desktop and
choose Change Desktop

Background:

Help
New Folder

View
Clean Up

Arrange »
View Options...

Change Deskiop Backyraund...

From this dialog box, you
can select a different
pattern for your desktop.
We get into this a little
later, so don't waste too
much time here. Just
thought you might need a

break:

O == = = - Desktop Picturas E oL |

Pis

=

)

Blue Cord

Fattern 139048
Ry LB

Drag the Junk folder to the Trash can. Just pick up the icon, hold down
the mouse button, and move it over top of the Trash can icon.

As soon as you drop the folder in the Trash, the icon changes, so that it
looks just like our garbage can does — filled up and overflowing with
junk, misc., and stupid games:

ol

it

Trash

There’s another way to throw something into the Trash: by using the
Control-click method. Position your Arrow pointer over the Misc. folder.
Control-click the mouse. Slide down until you highlight Move to Trash.
Let go of the mouse button. The folder will fly away, landing directly into
the Trash can.

Move To Trash

Get Info
Label [ 2
Sharing..
Duplicate
Make Alias

OH NO! That Misc. folder contained the latest revision of your next great
novel? The keys to the code of the ages? The latest Martha Stewart direc-
tions for making those cool Halloween death masks? Don't fret, little one.
Double-click the Trash can icon:

| |7

N

7. That’s right, you can simply drag either of these folders (or, by digging

into them, something inside one) back to the land of the living. Unless...
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There are several ways to
recover a file even afterthe
Trash Can has been
emptied. There are eeveral
popular Utility programs
that can recover deleted
files. The most popular one
is probably Norton Utilities,
which can be purchased at
your local computer store.
The program comes with
several other critical tools,
including virus protection,
and tools to speed up your
hard drive — or recover the
contents if the whole thing

crashes and won’t restart.

8.

10.

11,

18

13

14.

Control-click the Trash can icon. Take a look at the pop-up menu that
appears:

Help s
Open

Empty Trash G

Get Info
Label »

Select Empty Trash. The can is empty. At this point, you would need
special utility programs made especially for situations where you did
throw away something critical. They can usually recover trashed files, at
least for a while after you threw them away and emptied the trash. They
are not included with the Macintosh, but have to be purchased from a
third party. Don’t ask us why.

There’s another way to empty the trash, and that’s from the regular menu
bar at the top of the desktop. Drag the Stupid 6ames folder to the Trash,
and empty the Trash from there. Good riddance to bad rubbish.

Special g0
Empty Trash
Eject £E
Erase Disk...
Sleep

Restart
Shut Down

Create another new folder and call it anything you would like (not literally,
just figuratively). Drag it to the Trash can.

Double-click the Trash can. It opens:

2=

-

Anything You Like

-

4] D=

You could choose to drag this item out of the Trash and back to a folder.

You can empty the Trash now.
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When you start getting
comfortable with the
system, you might be
tempted to turn off the
trash warning. We can tell
you from personal experi-
ence that even the most
Jjaded operator should leave
this message turned on.
It's one last chance to
check yourself before you
trash something important
— like a three-hundred
page course book that's
just gone through eighteen
edit cycles. (did we say
that?)

In general, you should be very careful before you empty the trash. It can easily
destroy something you didn’t mean to discard, because once you choose
empty, it’s pretty much over. You can, however, get the trash can to ask you just
one more time if you're sure you want it emptied.

Turning on the Trash Warning

1. Position the pointer over the Trash can. Control-click the icon, and slide
down until you highlight et Info:

Help =y
Open

Get ln
Label P
Make Alias

2. A dialog box will appear and provide you some information about the
icon:

¥here: On the desktop

Contents: The Trash is empty.

Modified: Mon, Nov 24, 1997, 10:23AM

[J'warn before emplying

3. See the small box in the lower left corner, in front of the words Warn
before emptying? Click once inside of it. A check mark will appear in the
box, indicated that the option is active. This is a very common interface
item, and it’s called a Checkbox. You will see them from time to time when
presented with a choice of something being turned on or off (as is the case
with this warning option):

[ ¥arn before emptying
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This is called an Alert Box,
and you should always pay
attention to them when-
ever they appear — they're
usually trying to tell you

something important.

4. Create two more junk and stupid folders, so you have something to throw
into the trash. Drag them there, and Control-click the icon and choose
Empty Trash. You'll see the warning message you just turned on:

The Trash contains 3 items, which use zero K
of disk space. Are you sure you want to
remove these items permanently?

(T

When first learning how to use your system, it’s probably not a bad idea to

keep this warning active. Once you're an experienced user, you can turn it off,
so that if you want to throw something away — no matter how critical it might
be — you can do it instantly, darn it.

Working with Files

So far, we’ve explored the Desktop, Menu Bars, and Folders. Now, it’s time to
talk about data files. What is a file?

WHAT ARE FILES?

A file is something that’s been created from within an application. It contains
data. That data might be words, pictures, sounds, combinations of items,
tables, numbers — in short, almost any information that might be important
to you. There are dozens and dozens of different types of files that you will
encounter as a Macintosh user — particularly in the graphic arts, where file
types are especially important. For now, it’s sufficient for you to know that files
contain data.
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SimpleText lets you enter
copy, do some simple
formatting, open certain
types of pictures, and
record sounds. Since it's
provided with your
computer, we're almost
positive it's installed on
your system — and
therefore it's very likely
that you'll be able to
perform the exercises in
the book.

Examining a File

1. Open the Project Folder, and then open the Copy Files folder:

Project Folder
== Copyflles=————— HB8
2 items, 1.5 GB available

<] Tv]7Z

2. These files were created with a very simple application called SimpleText,

which came with your Macintosh (specifically, it’s included with the
operating system supplied with your Macintosh). Double-click the one

called Sample File #1. This action — double-clicking on a file — will cause

the application to Open with the document active:

" @& File Edit Font Size Style Sound Help

] = untitied =

e P o]

What is a File?

A file is a collection of text, tables, pictures, sounds, video, or other information that you have either
created yourself, or received from somewhere else. A file appears on your desktop as an icon, or small
picture.

r:lip art, sounds, or interactive products, such as educational CDs.

In this Against The Clock course, you will learn how to create files, copy them, throw them away, and
organize them in folders.

In some cases, you might buy informetion from other pecple, as is the case when you purchase games,

—
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3. You'll notice that the document itself is in a window — one that acts the
same way as a folder window. The only difference is that this window
contains data — not files and folders. You can size the window, move it
around the desktop, or close it just like a folder window.

4. 'When you're done looking at the file, close it by selecting Close from the
File menu, clicking once in the Close box (at the upper left corner of the
window), or by pressing Command-W.

CREATING FILES

With few exceptions, all of your activities on your Macintosh will result in the
creation of files. Each application creates its own type of file, and under normal
circumstances, these files are directly connected to the application that you
used to create them. This is why double-clicking the file in the last exercise
started up the SimpleText program (another word for starting up an applica-
tion is Launching).

At the end of the last exercise, you opened a file, then closed it. The application,
however, was still running, or active. You can tell this by looking at the menu bar:

" & File Edit font Size Styie Sound Help

Creating Your First File

1. Choose New from the File menu:

1 file [0
SR T

Open...
Close VY
Save

Print... #P
Print One Copy B8

_Quit
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Although we tried to supply
you with a good collection
of hands-on activities,
don't be afraid to experi-
ment. We do suggest that
you make a copy of any files
you want to mess around
with, so that when you do
try to follow one of these
exercises, the machine acts
the way we say it should.
You can copy any file by
holding down the Option key
and dragging it to another
spot — either in the folder

or into another one.

2. A new document will appear. If you look in the Title Bar, you will see that
it’s called Untitled. Enter the following copy (to make blank lines, just hit
the Enter or Return key a few times):

My First File

[type in your own name]

Dear Ma:

This is the first file I've created on my Macintosh.

The Kid

SavING A FILE

At this point, you've entered some text into the file— but the file exists only in
RAM memory. It doesn’t reside in a folder somewhere on your hard drive.

Saving files is obviously a very important function, and that’s what we’re going
to do at this point. We just thought it would help if we took a moment and
mentioned that when you save a file, you should always think about where
you're going to save it.

Whenever you're working in an application, the Macintosh is keeping track of
what folder the program was “looking” into the last time you saved something,
If you haven’t saved something recently, it’s likely that the program will just
save the file in the same folder that the program is stored in.

That’s usually the last place you want to save a file. You usually want to save
your files either inside of a folder, or directly on the desktop. Some people
choose to save stuff on the desktop while they’re working, and drag the files
into the appropriate folder before they quit for the day. We think files should
always be saved into folders, but either method works.
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Saving a file

1. Choose Save from the File menu:

8N
Open... 780 ]
Close BW

Save As...

Page Setup..:
Print... ®P

29

' Quit

This is the first file I've created on my |

The Kid

2. When you do, you will see something called the Save Dialog Box. Almost
every program you will ever use has one, and although some have features

that others don’t (depending on the exact application), they all work

exactly the same way.

This pop-up shows you the contents of 1
the current folder

A list of items in the current window™|

—
You can enter the name of the

o MacHag—

Gl System Folder
K] VM Storage

C)
(Cossttogg

(Cancaig) -

- Shows you the current drive. If you
have more than one you can click here.

- Takes you to the Desktop
[~ Creates a New Folder
|- Cancels the Save action

I~ Saves the file

i
eFlwi

| Let's you choose between a regular

document and a stationary document.

3. By dlicking the pop-up menu, double-clicking the names of folders, or by

clicking a folder and using the Open button, you can explore your hard
drive (also called Navigating) until you find the folder where you want to
save your file. Alternatively, you can choose to click the Desktop button

and save the file there.

4. Type the name of your file (My First File) in the region reserved for the

file’s name. Click the Save button and save the file inside the Copy Files
folder, which is inside of the Project Folder that you created earlier.
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A Stationary Document is
one that is specially locked
by the Macintosh. You can

tell a stationary document
by its icon:

Sample File =1
A stationary file opens
automatically into an
untitled window, protecting
the original from change.
That way, when you open
one and make charges,
you're forced to save it
under a different name

than the original.

SimpleText, as well as
certain other applications,
allows you the option of
saving a file as a Station-
ary document. Another way
is to change the
document’s attributes
under the Get Info
command, which we discuss

later in the course.

10.

11.

@ CopyFiles %

1 Berries a

A sampie File =1

| Come
—

Save this document as:

My First File Q O
4

After you click the Save button, the file will be written onto your hard
disk, safe from (almost) anything.

Once you've saved the file, choose Close from the File menu.

Note the upper right corner of your desktop’s menu bar:

Tue 757AM €8 7

=
| MecHD |

See the little icon in the very corner? Click on it:

Hide SimpleText
Hide Others
Show All

B Finder

<¥ SimpleText

This portion of the menu bar is called the Application Picker. It lets you
switch back and forth between programs when you have more than one
running at once.

Try using the Hide 0thers option. It will temporarily hide the desktop.
Same thing when you're running the Finder (which is the Macintosh
operating system).

When you're done, choose SimpleText from the application picker, and
choose Quit from the File menu to exit the program.
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CHANGING THE NAME OF A FILE

There will be occasions when you'll need to change the name of one or more
files. You can do this directly from the desktop. It works the same way as

changing the name of a folder.

Changing the Name of a File

1. Open your Project Folder, then Open the Copy Files folder.

2. Highlight the file you just created:

- Copy Files

3items, 1.5 GB available

Berries

£l
Sample File #1

B -

i

3. Put the Arrow cursor inside the name. Wait a moment, and a box will
appear around the name. Type a new name for the file: Sample File #2:

' Copy Files

3 items, 1.5 GB available

Berries

- V]
Sample File *1

Sampe File #2

<]

[+]7

4. Hit the Enter key or click anywhere else on the window or desktop. The

file will be renamed.
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CoprYING FILES

There are numerous cases where you will need to make copies of files. A very
simple and basic example would be where you wanted to make a backup copy
of a file onto a floppy, or into another folder somewhere on your system.

You can make copies quite easily on the Macintosh. There are several ways to
accomplish this basic function.

Making a Copy of a File

1. Click once on the file you just renamed (Sample File #2).
2. While the file is selected (highlighted), go to the File menu and choose

Duplicate:

" & BN Edit view Special Help
New Folder

Open %0

Print %P e
Move To Trash %G CopyFiles ==—————HH
Close Window W [, 1.5GB available

Get Info 21
Label 4
: Sharing..

| Duplicate %D

Make Allas ®eM
Put Away wBY
Find... ®F

Show Original #R

" Page Setup...
Print Window...

PI

4items, 1.5 GB available

Berries

Samp f z
Sample File *2 copy

Sample Fi

E

e =1
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4. Drag the copy to the Trash (and empty it if you would like).

5. Click on the Sample File #2 file again. This time we’re going to copy it to
the desktop. Hold down the Option key and drag the file out51de the
folder to the desk@p O\ TG G fly DSt W o/

This graphic is called 2 6. You will see a graphic appear. It’s called a Progress Bar:

Progress Bar, and acts as

. o 217 Copy to “Copy Files” ©
a time indicator for slower < By

Items remaining to be copied: 202

o l

P Time remaining:

processes. The faster your

computer, the faster the

bar moves. That's why

people always want the You should notice that the visual we used here shows almost 300 files
fastest, biggest, baddest being copied. We used a large folder to make this picture so that we would
T —— have time to capture and discuss the function of the Progress Bar. With a
that they won't have to tiny file like the one you're working with, the bar appears and disappears
look at these bars too very quickly.

much.

If you're copying a large file, or group of files, you can click the arrow to
the left of the Time remaining text (at the bottom of the bar) and the
window will expand to show you the time required to complete the
process:

5 Copyto “Copy Files” ©

Items remaining to be copied: 292

=\ 1

= Time remaining:

Copying: BMO Part One
From: Desktop
To: Copy Files
Buytes Copied: 2.6 MBof 30.4 M8

7. Once you've dragged the file to the desktop, there will be two different
copies of the file; one inside the folder (the original document), and
another one on the desktop:
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If you check “Locked” in the
Info dialog, the file cant be
thrown away, at least not
s0 easily. Try locking one of
the Sample Files, dragging
it to the trash, and then
emptying the trash. You'l

see a dialog box appear:

Tha Trash cannot be emptied, becanse all of

o the Items In it (other than folders) are
locked, To delete locked items, hold down
the Option key while you choase Empty

==

As the message says, you
can choose to delete a
locked file. Make sure you
take that file out of the
Trash and don’t delete it.

L.

Get Info

With the file highlighted, select Get Info from the File menu. An informa-
tion window will open:

Sample File #2

Kind: SimpleText text document
Size: 129K on disk {462 bytes)

¥here: MacHD:Project Folder:Copy Files:

Created: Mon, Nov 24, 1997, 1:24 PM
Modified: Mon, Nov 24, 1997, 1:24 PM
Yersion: n/a

Comments:

[ Locked [] Stationery Pad

Notice the Comments box. You can enter info about the file or any com-
ments you feel are pertinent, and they will be stored with the file.

When you're done looking at it, you can put it away by clicking in the
Close box in the upper left corner of the window.
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Although the Macintosh
operating system has a
pretty solid “find” capabil-
ity built in (as you'll see in
this section), it's no
substitute for really good
and structured organiza-
tion. We

mentioned

before

that the

way

someone

keeps their desk in real life
will probably reflect how
they'll keep their computer
desktop. We just want to
say that with a computer,
it's even easier to lose
something than it is in the
real world — unless of
course you have a demon
dog like we do, who routinely
chews up important
documents. Unless you end
up with a really faulty and
sick hard drive, this
probably won't happen on

your Macintosh.

Finding Stuff

“Now where did I put that file? I know that I had it on the desktop!”

If you use a computer long enough, you're bound to say these words. And
worse. Nothing is more frustrating than losing a file. You know it’s there
somewhere, but you just cannot find it. You click, double-click, look through
lists of files, and slowly get increasingly frustrated.

Fortunately, the people who write computer operating systems know what a
problem this can be. They are constantly losing stuff themselves, and at some
point decided to build tools for finding troublesome, lost files.

The function is called finding.

Getting Ready

1. Open your Project Folder.

2. Create a folder called “Folder Lessons”:

' Project Folder © 0
4ditems, 1.6 GB aveilable

Copy Files Graphics Artboards

-

1] [*Z

3. Put the three folders that we’ve been using (Copy Files, Graphics, and
Artboards) into it. You should have only one folder showing, the Folder
Lessons folder that you just created.
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4. Open the SF-Basic Macintosh Operations folder on the CD-ROM that
came with the book. Drag the Finding Stuff folder into your Project
Folder:

[ &=—————=rrojectfolder &=—0H
2 items, 1.6 GB available

Folder Lessons Finding Stuff

5. Open the folder, and Control-click the window, setting the view to as List.
Click the arrows to the left of the folder names to open them into the list
view:

Today, 10:44 AM
ﬂ Brands 2 Article Today, 10:44 AM
w [ Harrison Project Today, 10:43 AM
) Brands Article Mon, Nov 10, 1997, 2:18 AM
Brands Text File Today, 10:43 AM
Mean Boss. TIF Today, 9:58 AM
= ( Littie Files Today, 10:37 AM
[E] Mean Boss.TIF Today, 10:37 AM
]

6. Asyou can see, this set of folders contains several files with the same
names, some with different modification dates, and some with different
sizes. This is the typical kind of mess that occurs when you’re working on
a dozen things at once.

7. Close the folder by pressing Command-W or by clicking in the Close box
in the upper hand corner of the window.
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FINDING BY NAME

By far the most common method you will use to find files is by searching for
their name. Usually you know what you called a file. You might not remember
exactly what you called it, but you know about what you called it. This is
normally enough to find what you're looking for.

Using the Find Tools

1. Close all the windows on your desktop.

2. Press Command-F or use the Find function on the File menu:

Edit View Spe:
New Folder &N
Open ®0
Print #®p
Move To Trash #<&1
Close Window %W

Get Info 81
Label »
Sharing...

Duplicate %D
Make Alias 8BM

Show Original 2R

Page Setup...
— PrintWindow...

Everyone has their own

3. TheFind File dialog window — the first of two parts of the Find tools —
personal favorite ways to

will appear:

search for stuff, but
without a doubt, the LT T

El& s Flnd file Ve
easiest and (usually) most e e T wrose
eFF i i R B e T T e T e P ST

ective is by knowing ’[ = e .

some part of the name of T —— = J
the file.
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4. There is a blank box where you can enter your criteria. Type in the word
“Brands” and click the Find button. The second of the two tools will

b

appear. This one is called Items Found: Rt

&5

s tems found e = PR
Size Kind Last Modified
[ e ands o Artule 129K MS Word & document 11/25/97  10:44 AM |~
[ Brands article 129K MS Word 6 document 11/10/97  2:18 AM
[ Brands Text File 129K MS Word & document 11/25/97 1043 AM

4]

S MacHD -

€3 Project Folder i

B Finding Stuff ;

€2 Big Files -
Found 3 Items | __ |z

5. Asyou can see, the function has found three different files with the word
Brand somewhere inside it. The first item is highlighted, and in the
bottom portion of the window, you can see that it is inside the Big Files
folder, which is inside of the Finding Stuff folder, which is inside the
Project Folder, which is on your hard disk. Simple, right? While this may
sound complex, seeing the hierarchy visually in the window makes it
pretty easy to understand. Click once on the second item in the list. Its
location will be displayed in the bottom portion of the window:

===
Name Size Kind Last Modified
D Brands 2 Article 129K MS YWord 6 document 11/25/97 10:44 AM |~
[ lEr and= Articl 129K MS Word 6 document 11/10/97 2:18 AM
[ Brands TextFile 129K MS Word & document 11/25/97  10:43 AM

This view is a very powerful

al

tool, because you can

Project Folder

€2 Finding Stuff
3 Harrison Project
[ Brands Article

actually drag stuff from

here to the desktop, make

| MR

aliases (a pointer file that Found 3 ftems

you'll learn about later),
and copy files. You can also
open the folder in which a

specific file happens to be.

CHAPTER 2: USING THE MACINTOSH PAGE 75



Don't forget that you might
see file names or stuff in
the background here in the
course that could be
different from what your
system shows. No two
systems are set up exactly
alike. We tried to minimize
this happening, but we're

sure we didn't catch every

6. The Brands Article, the one you were looking for, is inside the Harrison
Project folder. You can automatically open the folder this item is in by
choosing Open Enclosing Folder from the File menu or by pressing
Command-E (for Enclosing):

" &

Edit View Label Help

Find... ®F =0 Items Found S
Close Window W
= 7 Size Kind Last Modified
More Choices &M
Hwer thuices PR Tartioe 123K MS Word 6 document 11/25/97  10:44 AM| =]
Open Item ®0 [HER 129K MS Word 6 document 11/10/97  2:18 AM
Open Enclosing Folder %E [extFie 129K MS Word 6 document 11/25/57 1043 AM
Print Item ®P
Get Info =®1
Sharing...
Quit I~
———
€3 Projeot Folder
€3 Finding Stuff
2 Harrison Project
[ Brands Article
Found 3 tems I |7

O Harrison Project =
3items, 1.6 GB available

=4 wld
Mean Boss.TIF Brands Text File

instance.

7. At this point, you could drag the file to where it should have been in the
first place (before you lost it). You don’t have to move this file — we’re
trying to visualize here.

8. Close all the windows. You can leave the Find windows open for the next
exercise.
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OrHER FIND METHODS

There will be times when simply knowing the name (or part of a name) will
not be enough to find the specific file you're looking for. In these cases, there
are several other methods of finding files.

The first thing to notice is that when the Find command locates a list of files
that match your criteria, the view within the Items Found window gives you
some insight into the differences between items in the list.

Let’s say, for example, that you had two pictures of your mean, whip-wielding
boss. One (the original) was black and white. For publishing in the company
newsletter, though, you wanted a color version. So you took your painting
program, colored the original, and saved it into a different folder.

You know that the colored file must be bigger, since it contains color data,
where as the original was only black and white. You know the name of the file
is Mean Boss.

More Finds

1. Press Command-F to access the Find command. If it’s already on your
desktop from the last exercise, type in the name Mean Boss and click the

Find button:
Oessenseesre s i FfindFlle e ——e - 0l B
Find items [ on local disks 4 | whose
[(name % ][ contains il
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2. When you click the Find button, you'll see that indeed, there are two

copies of the same file. But notice that the size of the file is displayed, as is
the last time the file was modified:

idff=— === temsfounl=———————HI"
Name Size Kind Last Modified
e ———
B I 129K Photoshop document 11/25/97 958 AM |+ |
[ Mean Boss.TF 193K Photoshop document 11/25/97 1037 AM
I~
&2 Projeot Folder a
& Finding Stuff r
0 Harrison Project =
D Mean Boss.TIF :j
Found 2 tems | | Z

3. At this point you could see that the larger file — and the one that was
modified last — is the one in the Harrison Project folder.

4.

You can put the Find windows away. Either click in the Close box for each
file (upper left corner of the window) or press Command-Q to quit the

program.

UsinG OTHER SEARCH CRITERIA

The Find command that comes with your Macintosh is a relatively powerful
search command, providing several methods of locating information on your

system and connected disks.

You can expand your searches in many ways.

Expanding the Search Command

1. Press Command-F to access the Find command. When it appears, click on

the pop-up menu that currently says contains:

O0——————————————-=FindFile =08

S

Find items [ on local disks £ | whose

mame :
starts with S eae =

Find

is not
doesn’t contain
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2. Asyou can see, there are several different ways you can use the name
search. You might want an exact match, for example, or you might need to
exclude certain letters or numbers from your search. You could find things

There are search criteria
here that we've never used
in the ten years we've been
working on the system.
That's not to say they
won't be the most impor-
tant to you, though. Who

knows when you might

that end with or begin with certain characters, or look for files that don’t

contain certain text.

3. Click on the More Choices button. The window will begin to expand to
make room for the Size find option. You can see there’s a pop-up menu
there that lets you look for a size smaller than or larger than a specified

size:

R T

Find items [ on

local disks

| %] whase

E[ name

%[ contains

%] 1Menn Boss

is nreaterthan

I More Choices ]

[ rewer mulces

K

4. Open all the Choices by continuing to click More Choices:

desperately need to find 2 find items | on local disks ' 4 ] whose
locked file, or an empty l"“n = T$) [contains =) [Miean boss |
folder. | ( ;.izg : [4][isless than 2128 | K
| (ind (s %) (anas 3
[ Tabel [ :_]‘r.ls = % ][ None £
: [ date created $)[1s %] 11726097
( date modiied 5] (15 %) 1126097 ;
(version I 3] ]
[ comments % ][ contain B | |
I'_rnluer attribute | 2 |[is ¢ | empty 3 :
i 1 M.nre Choices | [ Fewer Choices |
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Date Created and Date
Modified searches will
prove very important if
you're in the graphic artes
industry, when you're often
faced with picking from two
or two thousand files with
similar names. How many
different ways can you
hame a file that has a
picture of a man on a

beach, or a dog in a car?

5. Take note of two important search methods that you just uncovered.
These are the date created and date modified. Click on either of these
date-related pop-up menus and look at your choices:

=" e
Find items (_on local disks ¢ | whose
[ name #j [ contains % | [Mean Boss | |
é[slze % |[isless than $][128 [Kz
(Cm 20 =) (atias 3
(Jabei 2 (s 2] (None 3|
:[mﬁ s 11/26/97 ,
! is before |
is after 11/26/97

is not

verch S Tiswmmmrgayor ||

_m is within 2 days of ;

| is within 3 days of
ock attribute s

" Iswithin 1weekof  ked s .
is within 2 weeks of !

| folder attribute % is within 3weeks of pty ¥ A
T N is within 1 month of ey
ag | Fewsd is within 2 months of
L is within 3 months of :
is within 6 months of [

| Mare Che

6. Asyou can see, you have a broad range of date-related searches. Trust us
when we say that this method — the “T know I did that work last Thursday
or Friday” search — will come in handy as you become more experienced
on your system.

The second search criteria you should take note of is the comments selection.
Earlier, you learned how to “Get Info” for a file (click the file and press Com-
mand-I or Control-click the icon and select Get Info). In the Info dialog box is
a Comments field. You can use this search method to look through those
comments and display any files that contain (or don’t contain) specific infor-
mation.
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Customizing the Find Dialog Box

1. Click the Fewer Choices button until only two search criteria are showing

(name and size):

0
Find items [ on local disks 4 | whose
‘ [name 2] [ contains | Il
(size 2] [isless than %128 Il
[ More Choices | [ Fewer Choices | | Find |
N

2. Name is important, so we'll leave that as the first search method. The next
most important method is, let’s say, date modified. Click the Size button
and use the pop-up list to put date modified next in the window:

Find items [ on local disks 4 | whose

| name ¢ ][ contains 2l I

name 1
|| size [(is less than $][128 |k
kind - e :

label

date created Srthaices
date modified

version

comments

lock attribute
folder attribute
file type
creator

3. Click the More Choices button, then click the Size button (it’s moved *
down the list) and replace it with comments and contain:

O=—= =T
Find items [ on local disks 4] whose
|[ = _;thntnins e c_” et o | |
|[date modified 2] [1s ¢] 11/26/97
[ comments | [ contain = [Ii
[ Mare Choices | [ Fewer Choices | @

Now, whenever you access the Find command, these three criteria will be the
first in the list. You can, naturally, customize the command to fit your needs.

CHAPTER 2: USING THE MACINTOSH PAGE &1



R

This artwork was done in
Adobe lllustrator, one of
our absolute favorite
programs. Oops! We said we
wouldn't tell you what our
favorites were, for fear of
improperly endorsing them.
Oh well. It's too late now.

“Jury, disregard that last

Formatting Text

When the Macintosh first came out, it was the first popular, mass-produced
computer that gave its users the ability to change typefaces. It was that func-
tionality, more than any other — including icons, the mouse, and other
innovations — that led to the desktop publishing revolution. The way the
Macintosh handled text (also called fonts) and graphics brought real computer
power to designers, publishers, artists, and other people in the graphics indus-

try.

While this isn’t a course on graphic design (there are over 20 such books in the
Prentice Hall/Against The Clock library), it is important that you know the
basics of formatting text elements in a document.

Almost all Macintosh programs allow you the opportunity to select text, and
apply characteristics to that text. For example, there’s italics, which you've seen
throughout this book (and many others); there’s also bold text, which is darker
than the text around it. And let’s not forget outline text, Shadow text, super-
script (x*) and subscript (H,0), underlined, strikethrotrgh, and something
called SmaLL Caps.

How AppPLICATIONS HANDLE TEXT FORMATTING

Almost all applications on the Macintosh allow you to change and manage
type styles — some with more precision than others. Applications designed for
the graphic arts, for example, are more likely to provide you with tools to really
fine-tune the appearance of type — both on screen as well as in printed
output. With these tools you can do some really neat stuff with type.

Something Fishy

Other programs, such as accounting or bookkeeping programs, statistical
analysis programs, and applications that are more concerned with the accuracy
of data than they are with the appearance of type, may provide you with less

statement!” control over type. If you're in the graphic arts industry, though, it’s likely that
you will be working with page layout and illustration software that will let you
accomplish almost anything when working with type.
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Working with Text

1. Find the file called “Formatting Text.” Double-click the document. This
will launch the SimpleText program that we used earlier.

am.m.....m sy _swuns_tety

7 Tormatiing Text - e ] |
mnwm =
anovel
Harman Malviila

Fillad with slvgory end symol sm, 1S <I8ssIc story ot goad snd wll unf saracsy e

cor
cn.ﬂtuumAnc:l 2 prier Batlls with Lhe levintha
i

bzl

Aberd U pequad, Ansd and his men ch ot acecss the woriey s, et toey
firally meet him — 87 thair CoTRIned CHRTInIes == i 8 11l Erutal battle af will
SHterTIPation, and cdsession

A Bock ol 1he Honth Club Selection

2. When you move the cursor into the area of the type, it will turn into a
small “I” beam. Use the I-beam to “paint” the first line: Moby Dick. It will
become highlighted (much the same way that the titles of folders or icons
become highlighted when you click on them):

| Size Style Sound Hel,
= Formatting T

& novel

Herman Melville

Filled with alegory and symbolism, this classic story of good and
evil unfolds among the whaler community in the 1800's. The
great white whale, Moby Dick, is pursued by the obsessive and
cruel Captain Ahsb. In 8 prior battle with the leviathan, Ahab had
lost & leg, and many say, his mind

Aboard the Fequod, Ahab and his men chase the beast across the

) -
In case you're wondering world's oceans, until they finally meet him -- and their

combined destinles - in & final, brutal battle of will,
Why this window is smaller determination, and obsession

. A Book of the Month Club Selection
than the one you're

probably looking at, it's
because we resized it so
that the screen capture

wouldn't be a million

Jigabytes.

NEl
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3. Go to the Font menu. Click on it and move the mouse down the list until
the font name Palatino is selected. Click on it. (Your font menu will
probably look different than ours. We have hundreds of fonts on our
systems since we publish books):

LT Size  Style Sound Help
-~

Palatino

Poplar

RFrutiger Roman
Shelley Allegro Script
Shelley Andante Script
Shelley Volante Script
Symbol

Tekton

Tekton Bold

Tekton BoldOblique
Tekton Oblique

Zapf Chancery
Zapf Dingbats

4. The words “Moby Dick” will now be in a different type face: Palatino:

File Edit Font Size Style Sound Help

a ncwel

Hermen Melville

5. With the text still selected, go to the Size menu, and select 24 points.
When you do, the title will become considerably larger than it was:

Foints are a measurement

used for type size. A point

e o .fﬁ",‘!%'"', S
is exactly 1/72 of an inch. — . aona
Hermen Halville o]
Fillag with slagery his clansic story a novel

of Good and evi) unfol whaler community
it whit

Herman Melville

Tnvtats
end many soy. Mg mind

6. Now make the title bold using the Style menu. Bold type is slightly darker
than normal type, providing a means of making something stand out
from the rest of the text:

d File Edit Font Size Style Sound ﬂeip
g “ Farmatting Text | IE

Mnb Dl(_k =

8 naovel

font Stre JETTT Sousd_Help
F Y

Herman Melville
Harman Helville
Filted with alegory and symbolism, this classic story
of good and evil unfolds emong the whaler community
in the 1800's, The great white whale, Moby Dick, is
pursued by the obsessive and cruel Captain Ahab. In a
prior bettle with the levisthan, Aheb had lost e leg,
and many say, his mind

Filled witn alegory and symf
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7. Highlight the words “a novel.” Using the menus, select 10 point, helvetica
and make the words italic:

" @ Fle Edit Font Size Style Sound Help

===: Formatting Text

[Moby Dick H

a novel

8. Look at the changes that we’ve made to the document. One hint: we
changed all the text below the “a novel” to Times, and played around with
the sizes a bit. We also italicized some of the words within the text itself:

anoval :

Herman Melville §

Filled with alegory and symbolism, this classic story of good and evil .
unfolds among the whaler community in the 1800's. The great white !
whale, Afoby ¥k 1s pursued by the obsessive and cruel Captain Ahab. |
In a prior baitle with the leviathan, Ahab had lost a leg, and many say, :
his mind. |

Aboard the Faguod Ahab and his men chase the beast across the
world's oceans, until they finally meet him -- and their combined
destinies -- in a final, brutal battle of will, determination, and
obsession.

A Book of the Month Club Selection
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9. See if you can make your document look like this one. When you're done,
select Save As from the File menu and give the document a name that

you'll remember:
(& Working with Copy | % ] = MacHD
rr] Formatting Text ol i_ Ljrrt
Desktop
(@ Mew ]

Save this document as: .
[My formatting | @ &}

10. You can keep the document open if you want, or close it. We suggest that
you put it in the Copy Files folder.
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Although the Macintosh is
certainly respected in the
internet, interactive, video,
and animation industries, it
is in the printing business
that the Macintosh has its
strongest hold and most

loyal supporters.

Don't let us give you the
impression that the
Macintosh can in any way
replace talent. The
software tools used by
professional artists are
just that — tools. Being a
good designer takes a lot
more than good tools. It
takes talent, vision,
experience, training, and a
productive and supportive

working environment.

Printing

As we've seen so far during the course, the Macintosh is quite adept at display-
ing your work on the screen. When you begin to work with various commer-
cial tools, either at school or at work, you will see programs doing amazing
things: creating the most complex artwork and page designs imaginable. You
can create almost any artistic vision or design using the system. What once
took airbrushes, cameras, paints, markers, razor blades, tape, and a myriad of
hand-skills can now be executed on a Macintosh without leaving your desk.
Although this can certainly be a bad thing, it also means that an artist can
apply their talent to a project with a minimum of distractions.

Displaying your work on a monitor, however, is only half the battle. The other
half is putting your work on paper. And that’s where printing comes in.

How Applications Print

With the possible exception of some game software, all commercial applica-
tions on the Macintosh can print what you see on the screen. The ability of the
computer to show you what you've “got” on screen is called WYSIWYG, or
“wizzy-wig” — “What You See Is What You Get.”

Printing stuff on a Macintosh is very easy. That’s not to say you will not en-
counter problems — you will, we can assure you. Complex documents created
with sophisticated imaging, illustration, and page layout software will some-
times cause you sleepless nights when they absolutely refuse to cooperate at
printing time. But for the most part, printing is the same, and simple to
perform.
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As people who do a lot of
printing, we wanted to say
that the entire issue of
print drivers, FostScript
Printer Description (PPD)
files, and output in general
is an area that no one
understands fully. You will
have problems printing
documents that should
print just fine — no big
graphics, ho complex
illustrations, no weird
content at all. Other times
documents that have all
kinds of screwy stuff in
them will print in moments.
If you really figure it all out,
call us and let us know.
Right now we're trying to
output this file, so we

gotta go.

THE SYSTEM

There are three different components that come into play whenever you want
to print your work on a Macintosh:

The Application. The first thing that is usually involved in a printing
event is the application program that you used to create the file. We say
“usually” because you can print directly from the desktop (or finder).
This is a useful technique when you need a hard copy of a folder’s
contents.

The second component of the process is called a Printer Driver. A
printer driver describes a specific type of printer. To pick a printer
driver, we use a program called Chooser, which is under the Apple
Menu. You will see this program in a moment. Another word for a
printer driver is a PPD, or PostScript Printer Description file.

The third component of the printing cycle is the actual printer to
which you send your work. There are many different types of printers
in the Macintosh world. The two most popular are dot matrix printers
and laser printers. If your work is destined for high-end commercial
printing, you will also learn about devices called Imagesetters or
Platesetters, which are a lot like laser printers but with the ability to
output very small dots. The smaller the dots, the higher the resolution
of the device is said to be.

THE CHOOSER

Chooser is a specialized application located in the Apple Menu (the small
multi-colored apple in the upper left corner of your menu bar).

&D Anple System Profiler
&3 AppleCD Audio Player
(§ Automated Tasks

B caiculator

Control Panels
@Findfile
@ Graphing Calculator
[ ligsaw Puzzie
[zl key caps
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Early in the course, we told you that the System Folder contained special files
and applications used by the Operating System to run your Macintosh and to
provide services such as printing. Within the System Folder is a folder called
Extensions. When you (or the people at the store) first set up your Macintosh,
certain types of extensions (small files) that represent different printers are
placed into this extensions folder. These appear in the left side of the Chooser
window. You can remove these extensions if you want, and have less printer
icons appear in the Chooser window.

If you click on a specific printer icon (on the left side of the window), any such
printers connected to your system will appear on the right side. If several
printers are listed in this window, you should click on the name of the one that
will be used for the current print job.

Lists the devices available on your system

Selecl a PostScript Printer The name

@ - | of the device
AppleShare Color W 1500 ' aPPeam hew
‘ once you click
CobrSY 2500 Color SV Pro | onit.
|
Inageriter Laserriter 300/L8]
Creates a PPD (driver)
L @ - for a new, unlisted
Stylewriter 1200 device
The icon that's called |
B | applerane @ Active ¢ Allows you to turn Arplstalk
AppleShare will come into _Oetve 750 | (the bullt-in networking software)
on or off.

play later on when you learn
about networking. It's not a
printer — it represents the
network that your com-
puter (might be/is)
connected to.
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When you first install your
software, many different
types of printers are put
onto your machine. You can
go into the Extensions
folder (inside of your
system folder) and find
these names. If you take
them out of there, they
won't show up in the

Chooser window.

AcCESSING THE CHOOSER

When you click on a printer icon in the left side of the Chooser (a.), the
window they are in takes on a black outline.

The name of the device appears in the window on the right side (b.). When
you click on the name to select it, that window takes on the black outline (c.).

o
AppleShare Color SW 1500

Color S 2500 Cokr SV Pro
Innage Writer Laserwriter Z00/LS

L)
e X
StyleWriter 1200

@ Aclive
(<1 | AppleTslk
X @ Inactive 760

Laserriter 300/L5)

r
Esa=d
Stylewriter 1200

@& Active
@ Inactive

41

AppleTalk

760

Setting Up Your Printer

If your printer does not correspond with any of the default icons that are
resident in the left side of the Chooser, check with the documentation that
comes with your printer to see if a Chooser Extension is available. In most
cases, a floppy disk comes with the printer that contains the extension. The
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In this section, we talk
about Spooling, or making
something print while you're
doing something else. This
process is also called
Background printing, since
it ocours in the “back-
ground” while you're doing

something else.

L]

.

extension is put into the System->Extensions folder, then the computer is
restarted.

Your printer’s icon should then be in the Chooser when it is accessed.

Because your printer is a newcomer, it needs to be setup. The button under-
neath the PostScript Printer selection window will say either Setup or Create.
This button allows you to create a new printer driver for your printer.

Create — If the button says Create, it will read your printer's specifica-
tions and create a configuration to match its requirements.

Select a PostScript Printer:
o

s
Color SW 2500 Color SW Pro

&

Laser'riter Z00/LS|

StyleWriter 1200 g —
L Create |

@ Active
@ Inactive

AppleTalk

setup — If the button says Setup, it will take you to a window with
several options for you to choose from to setup your printer.

Current Printer Description File (PPD) Selected:
“LaserWriter |1 NT”

=

(_Printecinfo ] (_ configure ) (Lcancet ]

Auto Setup — reads your printer's requirements and sets up a PPD.

Select PPD — goes to the PostScript Printer Description (PPD) window
to allow you to manually select the appropriate PPD for your printer.
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Each of the three ports on
your Macintosh has a
different icon. Look on the
back of your machine, where
the cables are plugged in,

and take a look.

Select a PostScript™ Printer Description File:
(@ Printer Descriptions | #) = Snooty

LaserWriter 4/600 PS -~ r" Eject

[ LaserWriter Color 12/600 PS

[\ Laserwriter Color 12/600 P... Desktop

[] LaserWriter Color 12/660 PS B
[ LaserWriter 1IN 1]
[ Laserwriter 11 NTX

[ LaserWriter 11 NTX v50.5
[] LaserWriter 11 NTX v51.8 ——
] Laserwriter 1| NTX-1v505 [+
Printer Model:

Apple LaserWriter 11 NTv47.0

*  Printer Info — reads your printer and shows you the specifications.

== Current Printer Description File (PPD) Selected:
“LaserWriter 11 NT”

Printer Information:

Printer Name: Personal Laserwriter NT a
Zone: *

Product Name: LaserWriter Personal NT

PostScript™ Level: 1

PostScript™ Version: 51.8

PostScript™ Revision: 1

(UpdatemntoJ [_ox ]

*  Configure — sets up those printers which can be programmed to
receive configuring software that can customize its settings.

Tae Output PORTS

There are three ports in the back of your Macintosh computer that correspond
to the needs of your particular printer.

*  Printer port
+  Serial port
+  Modem port

The Printer port is the most commonly used port for printers. But some
printers, such as those of IBM configuration, require the Serial port for con-

nection.

PAGE 92

CHAPTER 2: USING THE MACINTOSH



If you have a Fax/Modem connected to your computer, it will need to be
connected to the Modem port.

Here are some examples of what options are available for some of the default

icons that come with the computer. The LaserWriter 300/LS asks for the Serial
port.

Connact to.
B «Seriol Port> -
AppheEhere Coler 5¥ 1300 %5 <Serial Port>

8

Bsckground Printing
em Qo

|| @ Active
StylVrher 1200 =] | AoPIOTOK D inactive 560

Laservriter 8

The Color SW 1500 asks for the Printer or Modem port. Some color printers
require that AppleTalk be turned off to work on the Printer port. Be aware.

Connecl to:

D

i 7 e e
el
@ Printer Port
AppleShare Mogem Port

Cokr SW 2500 Cokr S¥ Pro

nageiriter Laser¥riter S00NS|

) £
Laservniter 8 PSProter Beckground Printing
L3cwe. )™ e onoon
StyleVriter 1200 I<] | applaTalk @ active

(Q Inective 760

The AppleShare icon is for networking and sharing with other connected
computers. The right side window, where printer names appear, is where the
names of Servers will appear to choose from. When you click the Server IP
Address button, a window to enter the Server's Address appears.

R R —_
a] | Select o file server:
& I -
Cokor 5 1300

Cobr W20 Calor SYPro Il I

' Enterthe Serveri@drgss:

> |

Lesar¥rtier & Pefriter (GeverPassrese ) o ) 1

Stywvrrer 1200 I | Apptetoi 3 ::::r““ r60
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Using the Chooser

Go to the Apple Menu in the menu bar and scroll down to launch the
Chooser. Make sure that your printer is connected and online.

In the left side of the Chooser window, click on each of the icons to see
what appears in the right window.

Click on the items that are in the right window. Make no further selec-
tions, other than to click Cancel in the warning windows that appear. You
do not want AppleTalk to be altered unless you know that a printer needs
it turned off.

Click on the icon of your own printer that is on the left side of the
Chooser window.

. When the name appears in the right side window, double-click on the

name. This will bring up the Setup dialog box.

&= Current Printer Description File (PPD) Selected:
“LaserWriter Il NT”

([ AutoSetup | [ SelectPPD.. | [ Help
[ Printerinfo | [ Configure | [ cancel |

Click on the Select PPD... button. You will be taken to the PostScript
Printer Description window. Scroll through the various PPDs to view
what is available. Click Cancel.

Click the Printer Info button. View the information about your printer.
Click oK.

Click the Configure button. You will probably see a warning of No
Installable Options. Click OK.

Back in the Setup window, click Cancel. In the Chooser window, click the
upper left button to close the Choeser.
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You can use the pop-up
menu to change from one
printer to another (Set as
Default Printer). While you
can also do this from the
Chooser, it makes more
sense to have_all your
printers on the desktop,
where you can access them
and change them with the
Control-click option.

Desktop Printer Icons

In order for your Macintosh to print, you have to select a printer and ensure
that you have the proper driver. Whenever you use the Create or Setup button,
the Operating System sets up a special file on your desktop that’s called (appro-
priately) a desktop printer icon.

On the system we’ve used to write this course, we have several printers. Here’s a
picture of the desktop printer icons for our printers:

LasarJet 5

B Loserriter

You will notice that one of the two icons (the one for our HP Laserjet 5) has a
dark outline around it. That’s because it is the selected printer. Once you've
used the Cheoser to setup one of your printers, you can then change printers
by Control-clicking the printer’s desktop icon. You can also control print jobs
from here as well:

Ll LIRS

Open
v Start Queue

Stop Queue
Get Info
Label 13
Make Alias

« Set as Default Printer

Spooling

As you can see, you can access the Help menu from this pop-up menu. You can
also start and stop a Queue. A Queue is a list of jobs that are waiting to print.

In the old days of the Macintosh (and most other computers as well), when
you wanted to print something, you clicked the print button, answered a few
questions (like how many copies you wanted, which pages you wanted to print,
etc.), and then waited until the whole job printed. This could take days (well,
maybe not days, but it sure seemed like days when you were sitting there
watching the monitor do nothing).

CHAPTER 2: USING THE MACINTOSH
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Today, a common process called Spooling is used by most computer operating
systems. Spooling refers to the fact that when you print a job, it’s sent into a
special container (that’s the Queue) and printed from there. In the meantime,
you get your computer back so that you can continue to work (which makes
your boss a happy camper).

To show you a queue, we sent a few chapters of this book to the printer. Once
we did, we double-clicked the LaserJet 5 icon on our desktop. Here’s the dialog
box that appears:

) T . Zitems {
H l > 16 a I mfauatprin%r
b 2.2-Firdingto Forts (print) Page: 1 of 1
E user: Harrison Ford ; document: 2.2-Finding to Fonts;
Status: warming up

e e R

@ 2.3-Printing (prim) 1 0 MNormal

This dialog box gives us total control over the jobs being printed. Here’s how:

(1] If we highlight any job, we can use this button to pause the job, or hold it
until later, when we have the time to print it. This is good in case we want to
send something to the printer, but not have it actually output.

If you pause, or hold a job, it moves back into the list at the bottom of the
dialog box, and shows that it’s being held under the Print Time listing:

O =i laserlot 5 ——————— 3
| 2items
L EI @ Default Printer
Name | Pages _I Copies
[8) 2:3-Printing (print) 1 0
- 2.2-Finding to Fants (print) 1 0
ll-l i
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When you hold one job, the next one moves in to take its place:

HH

= Laserjet5

2 items

ey Ty i s
LR Defoult Printer

b 2.3-Printing {print) Page: 1of |

user: Ellenn Behoriam Poyssick; document: 2.3~ Printing; Status:
preparing data

Name | Pages | copies
[8) 2.2-Finding to Fonts (print) 1 0 Hald

[»] This icon lets us restart a job that was on hold. Simply click on the name of
the job being held, click the 6o button, and it starts printing again.

[@®] This clock icon allows us to select a job and specify an exact time at which
we want the output to occur. This is extremely useful in a busy environment,
where certain jobs are better left to the evening so that they don’t tie up the
printer during critical times:

() Urgent
) Normal
®attime [127 897 |12 | 1{iAm H‘

If we set the print time to Urgent, it will go next — no matter how many jobs
are in the queue. Normal keeps it where it is, and At Time let’s us enter the time
at which we want the job to start printing. Pretty cool, if you ask us.

If you have a lot of jobs in the queue, you can also drag them around, moving
them up or down in the list as necessary.

Lastly, we have the old trash can. You can take any job that’s in the queue
and drag it to the trash, eliminating it from the queue. When it’s trashed, it’s
gone, and if you want to output it again later, you'll have to send it to the
printer from the original application.
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Printing a File

1. 0pen the file that you created in the Formatting section (My formatting).

'_aémgit Font Size Style Sound Help
O= New ®N |y formatting=——————

B
M Open.. %0 k -]
| Close BW
2 no Save ®S

lism, this classic story of good and evil
unfo! pmunity in the 1800's. The great white
by the obsessive and cruel Captain
leviathan, Ahab had losta leg, and many

Aboand the Feyretd, Ahab and his men chase the beast across the
world's oceans, untl they finslly meet him -- and their combined
destinies -- in a final, brutal battle of will, detenmination, and obsession.

A Book of the Month Club Selection

2. Go to the File menu and select Print:

New 8N [yfnrmatting—"—:__
Qpen.. %0

Close xBW
Save 3

[lism, this classic story of good and evil
unity in the 1800's. The great white
y the obsessive and cruel Captain

Aboard the Py, Ahab and his men chase the beast across the
world's oceans, untl they finally meet him -- and their combined
destinies - ina final, brutal batle of will, determination, and obsession.

A Book of the IMonth Club Selection
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3. The Print Dialog box will appear:

Printer: “Laserlet 5 822 [ Print |
cﬂpleszm Pages: @Al O Frum:]__] To: L_] [ Cancel l
rl’aper Source !,Destlnntlnn_

%QMI O First from: iQPﬂnter
; ] |OFie
{ |

4. Click the Print button, and the document will be sent to whichever printer
you've selected in Chooser or from the desktop icon, and shown at the top
of the dialog box.
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(HAPTER 3

CONTROLLING
“ENVIRONI

Cuarter Osjecrive: :
To provide hands-on activities that will teach you many of the Macintosh
Operating System’s environmental controls; the settings, commands, and

tools that allow you to customize the way your machine looks, acts, even
talks Through study of Chaptel 3, you will:

® Learn about Aliases, tiny “pointer’ ﬁles that dramatically reduce mouse
clicks and keystrokes by letting you organize them anywhere on your

system while retaining the identity of the original application, file, or
- folder. :

e Know how to use the Launcher, a ‘popplar and highly—éffe(_:tive applica;—
tion that puts any document, program, or tool at your fingertips.

® Learn about Control Panels, a specialized folder within the System
Folder that’s accessible from the Apple Menu.

® Learn about many of the individual Control Panels and tools which
affect the way your Macintosh looks, sounds, and operates.

® Learn about the Apple Menu, a collection of programs, folders, recent
applications, and helpful tools.

e Learn to use the Calculator, the Notepad, StickyNotes, and, most impor-
tantly, the Apple Audio CD Player, which provides background music
for those difficult days at work or school. ~

® Understand Networking, a method of connecting your cornpufer to
others — either in your building or around the world.



Customizing your working
environment is something
that's really a process, not
an event. You'll always be
fine-tuning your system.
When you start working
with application programs,
like Adobe lllustrator,
Microsoft Word, Photoshaop,
QuarkXpress, FageMaker, or
others, you'll find that each
of them also allows you to
modify the way they look,
feel, and act. When
changing a program’s
environment, it's called
changing the Preferences of

the program.

Controlling Your Environment

At this point, you're probably getting comfortable with the basics of running
your Macintosh. These basics include creating folders, managing your desktop,
creating files from within a simple application, changing fonts, and printing
your work.

As you become more and more familiar with the basic operations of your
Macintosh, you will increasingly find yourself wanting to customize your
working environment. That’s what we’re going to explore in this section of the
course.

Using Aliases

An Alias is a special file — one that occupies almost no space at all on your
hard drive. What it does is poirnt to another file. The file to which the alias
points is called the original, and the alias acts just like that original in every way.
You can put an alias anywhere on your system, and when you double-click it, it
acts exactly as if you had found and double-clicked the original.

When you start working for real, you'll eventually end up with lots of files, and
many levels of nested folders. To access any program or file on your system will
require double-clicking your way through the maze of folders until you have
found the correct item — the one you need at the moment.
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Here’s an example:

drd Click

Throughout the book we've Drawil}g IPrograms
()

der
talked about how impor-
tant it is to minimize . .
keystrokes and mouse
clicks. Aliases are an 1st Click
Hard Drive lcon
excellent way to make your

system more productive . bth (ﬁnal) Click

and faster to use. Application lcon

M
Adobe Nustrator

2nd Click
Applications
folder
4th Click
Adobe lllustrator
folder

Nesting items inside of folders is a great technique for organizing your folders,
data files, and applications, but can easily lead to an awful lot of double-
clicking to get where you need to go. In this case, you have to double-click five
different times to launch (another word for start) the Adobe Illustrator pro-
gram. That’s a lot of clicking.
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In this next illustration, we've created an alias of Adobe Illustrator, and placed
it on the desktop. Check out the savings in clicking time:

1st Click
Y Alias points directly to the application,
no matter where you might have it located
for organizational reasons

Hlustrator alias

i
|
|
|

Adabe IMustrator

Using an alias allows you to create custom pointers that act just like the original
item, whether it's a folder, a data file created by a program, or a program iteelf.
In this example, double-clicking the Adobe lllustrator alias on the desktop
immediately starts up the application — saving four double-clicks.

The alias keeps the same icon as the original, but italicizes the name text for

quick identification.

MNew Folder Al Folder siiss
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Here are some rules and guidelines for using the alias concept.

«  An alias can be duplicated many times, and each copy, regardless of
where it’s placed, relates to the original.

+  An alias can be Trashed without hurting the original. And if the origi-
nal is a folder, it will not hurt any of the contents.

«  An alias can be renamed. This does not affect its connection to the
original file.

* Analias can be created (once the original is selected) either by going to
File->Make Rlias or by pressing Command-M.

* If an original has been moved to another location that you can’t recall,
it can be tracked and found by selecting the alias, then going to
File->Show Original or by pressing Command-R. The last folder that the
original resides in will come to the desktop, showing the original.

«  Any item with an icon — the hard drive, the Trash, the System Folder,
control panels and extensions — can have an alias.

+ If the alias is of a folder, then you can put items into the original folder
simply by touching the items to its alias. In some cases, you might
prefer to hold the Option key to send duplicates of the items into the
folder.

DUPLICATING AN ALIAS

Once an alias is made, you do not have to trudge back to the original to make
more aliases for other access locations.

+ Ifyou select an alias, then go to File->Duplicate, a copy will appear.

New Folder A Fo 85
Mew Folder sliss copy
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PuUTTING ALIASES IN LOGICAL LOCATIONS

The best locations to put an alias are:

*  The Apple Menu

*  On the Desktop

+ In the Launcher

To make an item more accessible, duplicate the alias several times and put
them in these locations.

If the desktop is covered with folders, and you can't click an alias located there,
the Apple Menu will let you quickly select the alias duplicate placed there.

If you open the Recent Applications or the Recent Documents folders, you
will see aliases of the items that your computer keeps track of. The computer
instantly makes an alias of an application or document and places the alias in
the appropriate folder. This is a good example of how the Apple Menu uses
aliases put there.

Items that are dragged to the Launcher window on the desktop are turned into
aliases and placed automatically in the Launcher 1tems folder.

ACCESSING THE ORIGINAL

There might come a time when you actually need the original on the desktop
to make some modifications. You do not have to go digging through folders to
locate it. You also might have forgotten just where the original resides.

Merely single-click on its alias, then go up to File->Show Original. The folder
that the original is in will open on the desktop.

Edit View Spe
New Folder N
Open ®0
Print ®P
Maove TaTrash ®<&
Close Window  #WY

Get Info =1
Label »
Sharing..
Duplicate ®D
Make Alias ®M
Put Away sy
Find... %F
Show Original %R

Page Setup...
Print Desktop...
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ERROR MESSAGES

If you have aliases lying about in various folders, and you choose to remove or
delete the original, you will see a warning message if you double-click on one
of the related aliases. The warning tells you it could not find the original.

Pl The allas “New Falder altas® could nothe -
i H’ | ‘cpened, bacause the criginal Iltem coutd not:

i befdunds :

The best thing to do in this case is Trash the defunct aliases.

Creating an Alias

1. Go to the Hard Drive and open its folder. Listed in the Hard Drive should
be an Apple Extras folder. Open it.

2. You should see an AppleScript folder. Open this folder.
3. Inside this folder you should find the Automated Tasks folder. Open it.

4. Inside the Automated Tasks folder, press Command-N to create a new
folder. Rename this folder “Hidden Tasks.”

5. Click on the About Automated Tasks document to select it. Press
Command-M to make an alias of it. Drag the alias into the Hidden Tasks
folder.

6. Select the Hidden Tasks folder. Go to File->Make Rlias to make an alias.

XRect View Sper
Newfolder ~ %N
Open’ 80
Print «°p
MaveToTrash %G&
Close Window %W

Get Info 81
Label 14
Sharing..

Duplicate %D

Put Away xRy

Find. ®F
Show Original %A

Page Setup..
Print esktop...

Drag the alias out of the Automated Tasks folder and onto the desktop.
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7. Now close all the folders you opened in this exercise.
8. On the desktop, you will see the Hidden Tasks alias you placed there.

9. Double-click on the alias. The Hidden Tasks folder, which still resides deep
in the folders, will open on the desktop. Inside this folder will be the About
Automated Tasks document alias.

10. Double-click on this alias. The application, SimpleText, will launch in
order to open this text document.

11. You have succeeded in manipulating items without needing to dig deep in
folders to get their originals. Close the SimpleText document. Close the
Hidden Tasks folder.

12. Make an alias of the Hidden Tasks alias. Go to the Hard Drive and open its
System Folder. Drag the “Hidden Tasks alias alias” to the Apple Menu
Items folder. Close the System Folder.

13. Go up to the menu bar and pull down the Apple Menu (colored apple in
upper left corner). Scroll down to the “Hidden Tasks alias” and access it.

14. The Hidden Task folder should appear once more. Keep this folder on
your desktop.

15. Go to the System->Control Panels folder and double-click on the

Launcher icon. This will put the Launcher on the bottom of your screen at
the desktop.

16. From the Hidden Tasks folder, drag the About Automated Tasks alias to
the interior of the Launcher window. You have just put another alias into
the Launcher.

17. The About Automated Tasks icon in the Launcher has turned into a
button. Single-click on this button in the Launcher. Observe how the
document becomes launched and open.

18. Close the About Automated Tasks document. Close the Hidden Tasks
folder.
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Launcher

Launcher is a window that appears at the bottom of your desktop screen.

= e s

Items that are placed in the Launcher 1tems folder (which is located in your
System Folder) turn into buttons that, when single-clicked, will launch/open
the corresponding folders, documents, or applications.

Even though the Launcher is a control panel, it does not have a dialog box to
make setting changes in. When you double-click on the Launcher icon in the
Control Panel folder, the Launcher appears at the bottom of your screen.

If you do not want to activate the Launcher control panel manually each time
you start your computer, you can set it to appear automatically by choosing
Show Launcher at system startup in the General Controls control panel.

Here are some rules and guidelines to using the Launcher.

* Items placed in the Launcher Items folder can be either the actual
document, folder, or application, or can be an alias.

« Items can be dragged, on the desktop, to the actual Launcher window
to be placed there. This will not affect the original, because Launcher
makes an alias of the document, leaving the original intact, in its
current location.

* Items cannot be dragged back out to remove them from the Launcher
Items folder. To remove any item, this folder must be opened on the
desktop, and undesired items dragged from it.

*  Launcher can be divided into category folders. These are helpful
when keeping items together to access them through the Launcher.

*  Launcher buttons can be sized (small, medium, large) by clicking on
the Launcher window while holding the Command key.
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PraciNG/REMOVING ITEMS IN THE LAUNCHER

Placing items into the Launcher can be done two ways:

* By placing the actual item (or alias) into the Launcher Items folder,
found in the System Folder.

+ By dragging, on the desktop, the item to the Launcher window, when it
is present on the desktop.

To remove items, though, requires that you go to the System Folder and open
the Launcher Items folder. You will see the icons of the items and can drag any
out of the folder.

Seript Editor SimpleText

The buttons in the Launcher need only a simple, single click to operate. If you
do not like the size of the buttons, you may change the size by holding the
Command key and click-holding on the interior of the Launcher window. You
will see the pop-up menu to select from.
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Basic Uses of the Launcher

Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Launcher control
panel icon. What appears at the bottom of the screen?

Click on the desktop with your pointer arrow. Press Command-N to
create a new untitled folder, which will appear on the right side of your
screen.

Drag this folder into the Launcher window, at the bottom of your screen.
You have added a new selection. Click on this new Launcher button of the
untitled folder. Did you hear a click, as if you were flipping a switch?
What else happened?

Hold the Command key and click-hold on the interior of the Launcher
window. Select “Large Buttons” and observe how the icons appear in the
Launcher. Hold the Command key and click to bring up the same
submenu. Select Medium Buttons.

You now need to remove the untitled folder from the Launcher. Go back
to the System Folder and view it as List from the View menu on your
screen’s menu bar.

In the System Folder, scroll down to the Launcher 1tems folder, and
double-click on its icon to open it.

‘System Falder
23 itema, 345.1 MB available

b a Extensions
B Findér

Dl CORroT STrip rioguies

HMacTCP DNR

You will see the icon of the untitled folder. Drag this out of the Launcher
Items folder and into the Trash can on the desktop.

With the Launcher Items folder still open on your desktop, drag the
actual untitled folder you created earlier to be inside the Launcher Items
folder. Stay selected in this folder, but able to see the Launcher window.
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7. You will see that the untitled folder is not present in the Launcher win-
dow. Now, click on the Launcher window on your desktop. Did the folder
suddenly appear?

8. Drag the untitled folder out of the Launcher Items folder and to the
Trash.

9. Close the Launcher Items folder, then close the System folder.

LAUNCHER CATEGORY FOLDERS

You can use the Launcher I1tems folder to keep items in categories, just as you
do with regular folders. These special folders will appear in the Launcher
desktop window as extra category buttons that you push to see the content
icons of that folder. The icons will become Launcher buttons.

Seen here, the three Category buttons are Applications (default), Clients, and
Games. When Category folders are used, the intial Launcher window defaults
to become the Applications button.

In this example, the Games category is selected, and we see the AppleCD button
present. If this button were pressed, the AppleCD Audio Player applications
would launch.

4 [
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The restricting guideline to creating a Launcher Category folder is that you
must be in the Launcher Items folder on the desktop when you create the new
special folder. You cannot create a new folder on the desktop and drag it into
the Launcher Items folder.

These Category folders act the same way as stated in the rules and guidelines of
the Launcher, discussed earlier. The advantage to Category folders is that you
can have more buttons at your service, just a simple click away.

Creating and Managing Category Folders in the Launcher

1. At the desktop, go to the System Folder and double-click on the Launcher
Items folder icon to open the folder on the desktop.

O Launcher items __ e15|
e sé0s e

25 items, 345.1 MB available

Srmpletext Seript Editor

S

2. Inthe Launcher Items folder, press Command-N to create a new folder.

O 7 7707 7 2 Launcher items [0 B
3 ftems, 344.6 MB avatlable

T»

Seript Eter Symplelext

untitled folder

] D

&

3. Click on the name of the untitled folder and before the name, type a bullet
(+) by holding the Option key and pressing “8” on the keyboard. The name
of the folder should now be "suntitled folder."

e ] i_,quhtﬁgr Items =
3 1tems, 344.4 MB available

ol

Script Egrior SimplelText suntitled folder
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4. If the Launcher is not currently on your desktop screen, go back to the
System folder->Control Panels folder and double-click on the Launcher
control panel icon.

5. With the new Category folder created, the Launcher should look like this.

l|  Script Editor SimpleText

6. Go back to the Launcher I1tems folder. Rename the “~ untitled folder” to
“s Games.” Create another new folder and rename it “» Movies.”

SimpleText Rript Etvier

{

® Games

[ 1»1?:@

7. Click on the Launcher. You will see the two new Category buttons.

I I |v-@

8. Go back to the desktop where the Launcher 1tems folder should be
accessible. Go to the Hard Drive folder and open it. There should be a
folder called Rpplications. Double-click on its icon to open it. You will see
this.

available

AppleCD Audio Player AppleCD Audio Player Guide

 Applicatio
4items, 3252 MB

Movie Player SimpleText
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9. Click on the AppleCD Audio Player icon. Press Command-M to create an
alias of this application. Drag the alias over to the Launcher Items folder
and touch it to the “> Games” folder, so that it will move to this location.

10. In the Applications folder, click on the Movie Player icon. Press Com-
mand-M to make an alias of this application. Drag the alias to the
Launcher Items folder and touch it to the “* Clients” folder.

11. Now, click on the Launcher. When you click on the Games category
button, you should see this.

4] [+

12. Click on all the Category buttons of the Launcher to see what buttons..
appear. You will also notice that each Category has its own color the
window changes to when its Category button is clicked.

What do you do if you would like these Category folders to be accessible
in the Launcher? You can’t put a folder inside of itself. And to put its alias
inside another Category folder would really confuse the issue.

13. Do this. Go to the Launcher I1tems folder. Click on the “» Games” name to
insert the cursor in the text. Put one space before the bullet. Click on the
“sMovies” name text and add one space before its bullet. Go back to the
Launcher and click on the Applications button. The two Category folders
will be present.

14. Close all open folders that are on the desktop. Keep Launcher active if you
like it. Some users love it, others never keep it open. We're of the former

group.
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We could spend hundreds
of pages talking about
Control Panels. What we're
going to try to do'in this
section is familiarize you
with their basic usage, so
You can experiment to your

heart's content.

There are commercially
available control panels
that you might find
yourself using as well.
Naturally, we're going to
cover only those that came
with your basic system. If
you do purchase commer-
cial control panels, be sure
to check the documenta-

tion that came with them,

Control Panels

Inside your System Folder is a special folder called Control Panels. Open your
system Folder, and you will see two folders with the name “Control Panels.”
One of the two has the word Disabled in parentheses. This folder holds control
panels that have been turned off:

Double-click the Control Panels folder and look at its contents:

b €3 control Pansis wed, bec 3, 1997, 2:09}
b I3 Control Pancls {Disabled) Fri, Nov 14,1997, 12:0} ;

] Castors veutodf.
[] cotorsyne= sestam Profile LR
[T contrel strip wed, b
Oete & Time X8
Bhiﬁ' Pictures Mea,
Eitor Setun fri.
Encrgy Sevar T, £
(8 Extecatons tizager DX &
FrleSaarieg .y
D] Gonerel cantrats T g
A reyacers te.}
] tacncrer o, of
£ 1 05 EsnyOpen. wed,
] MactinkPics Setep wed,
B *on,
(3] rtorory Tu,
[¥] renn o,
[ recturs & Socnd o,

Bl tooe se1,
8 nembers Hon,

ikaad X
QuickTime™ Settings The,
Spoech wea, |’
Startop Disk Sun,
B weene (LN 3

Text ron,

This collection of software tools, supplied with your Macintosh and installed
when the system was first set up, provide you with extensive controls over how
your system functions. Some are fun, others are critical to the operation of
your system. All will prove important at one time or another. In this section of
the course, we’re going to explore these controls.
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APPEARANCE

The Appearance Control Panel allows you to set some of the colors you see in
the folders and text you see on the desktop.

For customizing colors you see on the Desktop

| || ~Shows colors

Choose colors
with slider

For text on
the Desktop

=

The second choice offers you Dptions to change the way folder and dialog box
windows work, and to change the System typeface fonts, and the platinum,
metallic look of the windows.

CoLrLApsIiNG WINDOWS

When you have quite a number of folder windows on your desktop, it can get
very confusing to the eye. When a window collapses, it is also known as the
windowshade effect. The folder window collapses up into the title bar, keeping
the folder on the Desktop, but does not obscure other folders you need.

|

Collapsing a window can be done two different ways: by double-clicking on the title
bar of the window; or, by single-clicking on the top right button of the window.

Double-click in Single-click
the window header this button

Technique 1 Technique 2
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The double-clicking can be toggled in the Appearance dialog box through the
Options button. Also, you can control whether you hear a zipping noise when
the window collapses.

For customizing Desktop windows

Gives you the
Windowshade effect of
a collapsing window

Toggles hearing a
zirplng sound when
windows collapse

Lets you choose the
typeface for all menus,
windows, dialog boxes

Toggles the metallic
look of window borders

Managing the Appearance Control Panel

1. Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Appearances
control panel icon. The Color option will be what you see active.

B sma
i,
U NS S

L =T T— |
o
plilaliciieci

2. Scroll through the Accent Colors to see the tints available. Select Lime as
the chosen color.

3. Click-hold on the Highlight Color menu button. This affects the highlight-
ing color you see when you use the cursor to highlight text on the desktop,
such as a folder name. Select Yellow as the highlighting color.
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.

11,

B Black &White
_Eoter., -

Double-click on the window title bar where you see the Appearance
name. Observe how the window collapses. Did you hear a zipping sound
as the window collapsed?

In the Collapsing Windows section, toggle both options Off. Now double-
click again on the title bar. What change took place? Did the window
collapse?

Click on the upper right button of the window. Did the window collapse?
Click on the button again.

In the Collapsing Windows section, toggle both options back On. Now
double-click again on the title bar.

Altering the System Font and the Platinum Appearance requires the
computer to be restarted, so we will not address this now.

Go back to the Dptions section of this control panel and set the Highlight
Color back to Blue.

Close the Appearance control panel by clicking the upper left button of
the window.
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AppLE MENU OPTIONS

The Apple Menu, (the upper left colored apple icon of the screen’s menu bar),
is an instant access to other utilities, folders, aliases, and applications.

When an item in the Apple Menu has more selections to offer, such as folders,
the submenus of these items are indicated by the small black triangle. The
Submenus option must be On to do this. If Submenus is Off, you will be able to
access only the items listed in the Apple Menu.

QOn Qo

— Recent ltems
4 Remember recently used items

Documents:
Applications:
servers:

Using Apple Options

1. Open the System folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Apple Menu
Options control panel icon.

2. Go to the menu bar across the top of the screen. The extreme top left icon
is the colored Apple Computers apple. Click-hold on this icon and you
will see a menu of choices. This menu is the Apple Menu.

Some of the selections are folders. To recognize these, you will see a small
black triangle pointing to the right. If you move the Arrow to an item with a
triangle, the submenu will pop out, showing further selections in that folder.

@Apple System Profiler E Automated Tasks About Automated Tasks .
&3 Apple Audio Player H calculator Add Allas to Apple Menu
(§ AutomatedTasks b 2.hooser :::: : :g:g:‘; (o Guest)
B catculator &4 control Panels » .

& Find File Start file Sharing

Stop Fite Sharing

4\ Graphing Calculator
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3. Make no choices in the Apple Menu. Let go of the menu and you will be
back in the Apple Menu Options control panel. In the Submenus section,
click on the Off button option.

4. Go back to the Apple Menu and observe if any of the items have
submenus. Release the menu without making any selections.

AD Apple System Profiler

3 AppleD Audio Player

(] Automated Tasks

Calculator

S Chooser

E3 Control Panels

42 Find File

< Graphing Calculator

Jigsaw Puzzie

[2) Key caps

[CINate Pad

[@ Recent Applications.
Recent Documents
Recent Servers

{# Scraphook

& SimpieSound

@ Stickies

5. Go to the Apple Menu Options control panel, click the Submenus On
button to make the submenus active again.

6. Close the control panel by clicking the upper left button of the window.

APPLETALK

AppleTalk is a control panel in which you choose the output port to which you
need to send your information. You can select from Ethernet, Modem Port, or
the most common, Printer Port. Most devices you buy will inform you which
port needs to be used.

Connect via: | Printé: F 1 « Printer Port

Setup

Current zone: < no zones available >

2
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No matter how tempted
you might be, don’t trust
your monitor to show you
exactly the colors you'll get
when you output your file to
someone else’s printer, or
to film that will be used to
generate commercial
printing plates, Consult the
technical staff at your
printer before doing any
important work on your

system.

CorLorSyNc™ SysTEM PROFILE

One of the most common problems that occurs when doing color printing
from the computer is that the colors you see on the screen are not always the
colors you get on the printed paper.

To try to synchronize the two, the ColorSync™ System lets you choose the
Profile of the monitor you are using. In the control panel, you can click on Set
Profile. This will bring you to a new list of monitors from which you can
choose the monitor that best suits your own.

Select New System Profile:
@ ColorSync™Profiles |3 ]

o) Avpic 12 ea standard |

(2] Apple 13*RGB Standard

[#) Apple 16™ RGB Page-white

[®) Apple 16" RGB Standard :

[#) Apple 21" RGB Page-White |

=] Apple 21" RGB Standard |

@] Apple Multipie Scan 14 -l

Apple 12" RGB Standard

[:] Rl Set Profile...

Apple 13" RGB Standard

CONTROL STRIP

When your computer has started, on the desktop, in the lower left corner, you
will see a small button. This is the Control Strip. If you drag the button to the
right, you will see icons that give you instant control over certain functions, or
will tell you the current state of others, such as monitor colors and display

resolution.

When you click-hold on any one icon, you will see a pop-up menu telling you
the current information, and giving you other choices to make.

AppleTa{ File Sharing Printer Sound

Click to close CD Music Color Size Click to shrink

player | display dlsplayl or expand

Monitor Settings

+  AppleTalk lets you make it active or inactive.
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*+  CD Music Player lets you play, eject, or make settings to a CD you
might be playing.

+  File Sharing lets you see and change the current status.

+  Color Display lets you choose if you want gray or color for your moni-
tor, and just how much resolution.

*  Size Display shows you the current settings of your monitor.
*  Printer tells you which printer the computer defaults to.

+  Sound gives you a volume slider to adjust how loud you want your
warning alerts and other sounds.

The Control Strip control panel allows you to choose if you want the strip to
show, and gives you the option to assign a hot key to toggle this manually.

The font and size of the Control Strip's pop-up menu’s typeface can be set
here, as well.

2T Control Strip =]
Show/Hide =

. O Show Control Strip
i O Hide Control Strip m :
| @ Hot key to show/hide
rent hot key
e e |

Font Settings
N —
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Managing the Control Strip

1. Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Control Strip
control panel icon.

2. If the Control Strip is not stretched out at the bottom of the screen, to see
all options, click on its button. Click-hold on any item to see its window.

3. Inthe Control Strip control panel, click on Hide Control Strip to toggle it
Off. Observe the actual Color Strip as you click. Click on Show Contrel
strip. Did the Control Strip appear again?

4. In the control panel, click-hold on the Font option button to set the font
for Helvetica Regular. Click-hold on the Size button to set the size for 14.

5. Click on any of the items in the Control Strip to show their windows.
Observe how the type size and font has changed. In the control panel, set
the Font back to Geneva, and the Size back to 10.

6. Close the control panel by clicking the upper left button of the window.
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DartE ¢ TIME

In the upper right corner of your screen’s menu bar, you will see the time. If
you click on the numbers, you will see the current date set in your computer.

818AM B 11/27/97 K1

You can adjust your date and time to be correct in the Date & Time control
panel. You can also turn the menu bar clock on/off, and set your Time Zone.

iy oot rormats:

— Long Date —Shertiiete. e e

prefoc [ | | | [Month/Day/¥ear |2
[weekday [ ] '_, Separator:
Day - [ Leading zero for day
= L [l Leading zero for month
=
[ear =] | | [] Show century
[ Leading zero for day
~ Samples 3
Thursday, January 2, 1992 &n_!f!_l
Thu, Jan 2, 1992 5 3
17292 a

Crock OPTIONS

The Clock Options affect the menu bar appearance of date/time. You can also
set the clock to chime at various intervals, plus set the font and size of the
date/time that appears with it on the screen.

234 | Qock Options

HMenubar Displag Format ___________ _Chime Settings
[ Display the time with seconds | | [J Chime on the hour

(2 Append AM/PM to the time | ] ~same number of times as ¢
'O the day of the i [} —~unless a screen saver is rui
| Select Chimes

[J Aash the time separators O [ e chime

[] Show the battery level 3 JF""F}'&“;'“"“ -

[J Use custom clock color: | Ll LR,
‘ [ = Q@ [mochime | %]
| [ Select tolor... | | ‘ @ | mochime 3]
T T R I T R Y S ' _ Font I T P
{ soan ) || Fone

| Size: [0R | &
based on SuperCiockl, by Steve Christensen x|
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Managing the Date & Time

1. Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Date & Time
control panel icon.

2. In the Current Date section, click in the white part of the box where the
date is shown. The first item in the date will highlight. If you click directly
any of the numbers, they will highlight.

v =]
11/27/97 =

Next to the date box are two arrows, Up/Down. Click on the Up arrow
one time. You will observe the month date go numerically higher one
digit. With the month still highlighted, type in the number of your current
month. You can use either the arrow buttons or the keyboard to modify
the numbers.

3. In the Current Time section, click directly on the minutes. Type in a
different number of minutes. With this still highlighted, use the Up/Down
arrows to bring the minutes back to the number it should be.

E =
4:15:52 AM =]

4. Go up to the menu bar and click on the time in the upper right corner.
Observe how it is set, in sequence, as Month/Day/Year. Go to the Current
Date section, click the Date Formats... button. In the next window, under
short Date, click the submenu Menth/Day/Year. Choose the option
Day/Month/Year. Underneath this, set the Separator to be a “-” (hyphen).

Click Leading zero for day and Leading zero for month, then click 0K at the
bottom of the window. You will be back at the main Date & Time window.
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Go up to the menu bar again and click on the time. Observe how your
changes affected the appearance of the date.

Go back to the Date Formats... and set the date formats back to Month/
Day/Year, with a separator of a slash (/). Leave the leading zeros, unless
you do not want the date to show this way. Click 0K.

5. Inthe Date & Time control panel window, click on the Time Formats...
button.

6. In the Format section, click in the AM box and highlight AM. Change it to
lower case “am.” Highlight the PM and change it to “pm.”

7. Click in the Separator box and it will highlight. Change the separator to a
bullet (+) by pressing Option-8.

8. You will see all these changes at the bottom of this window, under Sample.
The samples change as you make modifications in the window.

9. In the Clock section, click on 24 hour, and watch the samples as you do.
Now click back on 12 hour.

10. So that none of these changes take effect, click on Cancel.

11. Back in the Date & Time window, click on Clock Options. You will be at the
Clock Dptions window.

234 | Clock Options

- Menubar Display Format .. . . ChimeSettings
' (1 Display the time with seconds [ Chime on the hour

| 4 Append AM/PMto the time @ Same number oftimes-‘as cl
i C] Showthe day of the week [[] -.unless a screen saver is ruj
| Select Chime

| [ Fiash the time separators e >

Q@ | o chime :
O | o chime

| ] Show the battery level
| [0 Use custom clock color:

| t—— —_—
i tizehistoloe. J 11
T N SR e
r 1250 AM I ‘ Font: [ Charcoal 2]
| | | Size: =
based on SuperClock!, by Steve Christensen [ cancer | [ ox 1}
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12. The lower left corner of the window has a Sample section to show some of
the visual changes. Experiment with some of the many settings and
observe how they appear in the Sample section. When you are through,
click cancel.

13. Back in the control panel window, close the panel by clicking the button in
the upper left corner of the window.

DEskTop PICTURES

The image of the desktop is a pattern of the logo you see at startup. You can
customize the desktop by using the Desktop Pictures control panel.

In the left column of the panel, you will see two options:

» Pattern
» Picture

When you click on Pattern, you will see this window. You can use it to scroll
through the many choices of images, then press Set Desktop to apply the
image.

Choose "Pattern" to apply patterns to the Desktop

Patterns
appaa r
here

Use slider
to scroll
through the
samples

|| Click here to
= apply the pattern
- tgrt,:he scrgen

There are many attractive patterns to choose from. Here are four samples.
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Musical Notes Colored Textures

The Picture option changes the panel to let you select an actual photographic
scene and apply it to the desktop.

Choose "Picture" to apply photo to your Desktop

Set the screen
style or position
of the picture

Use this to go
select the picture
for Apple Extras

CIicII< he}:-e to
apply the picture
tg Ft,:he scrgen

When you want to choose a picture, the Select Picture button is clicked to
allow you to go to the Apple Extras folder on your hard drive. From Apple
Extras, the pictures are located in the Sample Desktop Pictures folder.

Using Desktop Pictures

1. Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Desktop Pictures
control panel icon.
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2. You will see the Mac OS color pattern in the viewing window.

Keep in mind that the T

Launcher will not activate &

at startup unless you click
3. Under the image is the viewing scrollbar. Use this to scroll through the

selections offered. When you come to an image you like, click on the Set
Desktop button in the bottom right of the window.

"Show Launcher at system
startup” in the General

Controls control panel.

4. Observe how the desktop of your screen becomes filled with this pattern.

5. Scroll through other images in the viewing window and Set Desktop to
experiment.

6. Click on the Picture option, underneath Pattern. Click on the Select
Picture button in the bottom right corner. Use the next window to go to
the Apple Extras folder on your hard drive. Open the folder Sample
Desktop Pictures.

L @ Apple Extras ¢ = Snooty
@ Avplescript™ = (e
C Firewire
(] Mac 05 Info Center Desktop
(§ Monitors Extras Folder
Open Transport/PPP
Rt
e o Oy
(gt (3} Sound Control Panel =] @
' [ Show Preview

7. From the choices, select Beach on Ko Samui. Click Open.

8. You will be back at the Desktop Pictures control panel. Click-hold on the
Position Automatically button. You will see other choices. Experiment
with selecting the various position choices, then click Set Desktop.
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Pattern

Pioture

B8 Tile on Screen
[E) Center on Screen
B 5cale to Screen
B Fill Screen

+ Position Automatically Select Picture...
Set Desktop

%

9. Use your own judgment to select either a Pattern or Picture to be the
background image of the desktop. Set Desktop, then close the control
panel by clicking the upper left button of the window.

EXTENSIONS MANAGER

The Extensions Manager is like a light switch. It toggles the listed utilities on/
off. This is a utility that operates on both Extensions and Control Panels that
reside in their respective folders. It is simple to turn utilities on/off. The small
box to the left of each name is the object to click to toggle it on/off.

Extensions Manager has the ability to save the settings in Sets that you can
name and access later. This is handy when you are working on jobs that require
certain utilities to be on/off. It is timesaving to select the Set, rather than
scrolling and finding all the necessary items.

At the bottom left of the Extensions Manager window, there is an option to
Show Item Information about the item selected in the window. It tells general
information about creation date, file size, last time modified, then goes on to
tell what functions it performs.

There are also three option buttons that will Restart your computer, Revert
back to when Extensions Manager was last opened, and Duplicate a Set that
you want to customize.
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If you're having a problem
with a program, such as it
stopping or bombing
whenever you try to open a
file, try starting your
machine with all the
extensions turned off. You
can do this by holding down
the Shift key at startup.

Extensions that are On/Off can be
saved into Sets that can be accessed later

These
Extensions
are On,

This
Extension
is Off.

Click here to see more information about the
selected Extension.

File Sharing control panel )

Use this control panel to turn on
| file sharing and moniter eny file
aharing sctivity. Also use this
“{control panel to enter a name and
psesword Tor the computer
Jowner.

Orive:System Folder-Control
3 _t'(bi_!&ﬂd): 35

GENERAL CONTROLS

General Controls allows the customizing of certain features you see on the
desktop, as well as permitting folder protection.

et S SIS e B=_F
Shut Down Warning -- =
[ arn e #f computer was ‘

[~ Folder

AL
a s e a | mmwmm-wm,m.'mu!
1| (D Fodder that is 30t by the awplication.

1
M Last folder used In the apglication.
[ Protect agptications foléer (© Documents fokar J

+  Show Desktop when in background — eliminates from view all the
distracting folders and icons on the desktop when you're in an applica-
tion, and not at Finder level.

+  Show Launcher at system startup — is the only way to get the
Launcher to appear on the desktop at startup. You cannot put a Launcher
alias in the Startup Items of the System Folder. It doesn't work.

« Insertion Point Blinking — When the cursor is in a text block, it
blinks. This is where you set the blinking speed for slow, medium, or
fast.
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+  Menu Blinking — Some applications have menus that blink and you
can set the number of times it blinks, or turn the blinking off.

* Warn me if computer was shut down improperiy —ifyour com-
puter locks up and you have to do an emergency abort, when you start
up again, you will see a warning window telling you the computer was
shut down improperly. If you prefer not having this warning, you turn
it off here.

*  Protect System Folder — prevents the accidental Trashing of the
System Folder and its contents, with a warning.

*  Protect Applications Folder — prevents the accidental Trashing of the
Applications folder and its contents, with a warning.

* Documents — when you are opening or saving a document, you have
three choices of where the computer does its placement.

Using General Controls

1. Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the General Controls
control panel icon. You will see the General Controls window.

Insertion Point Blinking ——— l

o
stn.mumnmwm ﬁ = ;_; ® Q i
el S'hv Fast
1

LS TER
— Shat Bawn WarRMg — oy | 3 ? ? ?
Bv-mmumwm was m.n ﬂwmf | L
Folder Pratuction e =
[_Elmmlsmmuu. h F“ﬂmwnﬂmm.m.mu
| {3 Folder that s set by the apphication

| @ Last fodder used in the application

|
| [ Protect Appiications folder | | O Documents falder |
. Lo R Q ’ el ‘}

2. Click on the Show Desktop when in background button to turn it Off.

3. Click-hold on the Apple Menu icon (colored apple at the top left of your
screen), and scroll to highlight the Calculator to activate it.

4. When the Calculator appears, what happens to the desktop? Do you see
any icons in the background? The desktop filled with icons has been
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turned off because it is in the background behind the Calculator, which is
the current application choice.

5. Go to the Applications Menu (the colored icon in the top right corner of
your screen). Pull this menu down and select Finder. Now, what has
happened to the desktop? The desktop (Finder) is now the current selec-
tion, so it is not in the background.

6. Go back to the Applications Menu and choose Calculator. Observe how
the desktop icons disappear. Close the Calculator by clicking its top left
button.

7. Go back to the Applications Menu and select Finder. You will see the
General Controls window again. Click on the Show Desktop when in
background button to turn it back On.

8. Close the control panel by clicking the upper left button of the window.

KEYBOARD

The Keyboard control panel has two sections in which to make desired
choices. The Keyboard Layouts pertains to people who do international work,
and need the keyboard to reflect the language they are typing in. If you have no
use for another language to type in, it is best to leave this section alone.

Key Repeat is an option to customize how the keyboard keys react to your
typing speed. The default settings are the best for the average user. If you want
speed and delay between keystrokes to change, you should experiment with the

settings.

_ Keyboard Layouts :
Gelected keyboard layouts will display in the
Keyboard ments when more than one is selected.

e o v—
Ij E= swedish
(=] Swiss French
=] Swiss German
& B Us.

=] Use Command-Opticn-Space bar torotate |
thwough selected keyboard lagouts.

KeyRepeat
[_m Repeat Rate Datlay Unti] Repest

e e Ty
1-3'?- ‘-?' Fast | Bhort Long OfFF |

(21
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LAUNCHER

The Launcher control panel is a valuable accessory. Its only function is to make
the actual Launcher window appear at the bottom of your screen.

This is done by going to the Control Panels folder in the System Folder. If the
Launcher control panel icon is double-clicked, the Launcher will appear.

Script Editor SimpleText

qii 7
—

It is a very useful item for accessing your applications, documents, and folders.
More about the Launcher is discussed elsewhere in the book.

Mac OS Easy OPEN

Often you will be given a floppy disk from other computer users (especially
from PC to Mac) that contain files you do not have the application for. Mac 0S
Easy Open analyzes the incoming file and gives you a listing of equivalent
applications that could open the file, especially if it is only a text file.

You can make your own selections to the options for quicker accessing of
incoming documents.

Automatic document translstion: @ on () ofr

Translation Choices Dialog box ——
] Always show dialog box 1 B Transiate "TEXT' documents
[ include applications en servers

I B tutopick orly 1 oke | [Tholete Preferences

113
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Map

The Map control panel gives you a visual look at the globe and can tell you
specific information of latitude, longitude, time zones, etc., for a desired
location. It is an added attraction to see the points specified blink on the globe
in the control panel.

[Miami
Latitude 235 |°
Longitude 80 |°
Time Zone o h
mi 0 11:15 &M

MEMORY

The Memory control panel pertains to RAM (Random Access Memory) in
If you know the latitude and y p P ( rY)

et your computer. RAM memory is one of the most needed, and at the same
ongitude ot your location,

_ time, misunderstood aspects of a computer. RAM memory and Hard Drive
you can add it to the map.

, storage memory are two very different elements of computer operation.
It's very cool to know where

¥ dire a-Al e snd We will not go deeply into RAM memory, but we will offer these notes.

checking the map will show

you where you are relative Disk Cache is an extra RAM memory pocket that the computer uses to store
to Madagascar, India, and items temporarily while it is operating. Depending on how much RAM your
other very important computer is equipped with, you do not need a tremendous amount of cache.
places. From 512K to 2000K is more than enough. You should certainly contact the

company you bought the computer from to know a more exact amount you
can set the cache for.
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Virtual Memory is a makeshift way of utilizing a segment of your hard disk's
permanent memory as RAM. Some applications do not run well under
Virtual Memory, and if you do not have the available memory on your hard
disk, it is not a good idea to have Virtual Memory on. Again, consult the
company who sold you the computer to know more about its requirements.

g Always On [m] g
Seleot Hard Disk :
@ @ Avaflable on disk: €02
QON Available built-in memory : 32M <
Percent of avaflable memory
RAM Disk to use for 4 RAM disk:
@ore 0% 50% 100%
ot sr (B
.--‘:n '] ﬂ
¥7.58 3 Defaus

Ram Disk is a rarely used option that utilizes an external disk for extra RAM
memory. It is best just to ignore this option, unless you are a power user.

MobpEMm

If you have a modem, the Modem control panel should be set to Modem
Port. The Setup requires that you choose the modem, or equivalent, from
the Modem submenu of names and styles. If you desire sound, such as
ringing as the modem attempts to connect, leave Sound on. The default
Dialing is set for Tone, unless your modem software requires a different
setting.

Diating: @ Tone (@ Pulse
Ignore dial tone
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MONITORS ¢~ SOUND

The Monitors & Sound control panel has three sections: Moniter, Sound, and
Alerts.

The Color Depth is the only option you should change, and only if you need to.
The depth can be changed from Grays to Colors. In Colors, you can choose

I yiswgnt eallggosd from 256 levels to Thousands. Some monitors will offer millions. The more
sound, add a couple of colors a monitor displays, the slower it refreshes (another word for redrawing).
regular speakers to your This may not be true if your system is equipped with a specialized graphics
Macintosh. It cranks with display card.

good speakers!

ors&Sound

ColorDepth . .. Resolution i el e

SR
=l | show: [Recommended [ 3]

256
Qrays | ssssaears: i
& Colors - ‘mm PR TET

4]

| B

SounD

The Sound section lets you customize the output and input of sounds it creates

Or uses.

B Monttors&Soundc. -
O @ . -
_ Sound Out Level . Computer SpeakerVolume
4; e ;@) | 4; e ] :qg)
| 0 Mute i O Mute
. Sound Out Balance 20 ster Speaker Balance |
! @hm?m < : (@Pm?.——_—-—. =]
_ SoundOutput 7 3 sdﬁ.}a_u{;m PRl
s | Cmmnen T3}
L Dumu

_ Sound Output ounlltv b e )

|

i
1
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*  Sound Out Level — controls the volume of computer sounds other
than the Alert sounds. This could be Speech effects, or sounds that
games make.

« Sound Out Balance — controls the balance of the sounds, if this is
available on your computer.

+ Computer Speaker Volume — adjusts the volume on external speak-
ers, if you have them hooked up to your computer.

+ Computer Speaker Balance — adjusts the balance of the external
speakers.

*  Sound Output — defaults to Built-in.

+  Sound Input — lets you select the source of sound input. It can come
either from an external microphone, or from an internal CD.

v AMicrophone

nternal

ALERTS

The warning alert sound you hear can be changed to others listed in the Rlert
Sound list. When you click on each one, you will hear its sound to detésmine if
you like it or not. The volume of the alert sounds can be adjusted with the
System Alert Volume slider.

! AlertSound ____________ System AlertVolume
Droplet - =il
' { % =)
s S :
{ - AR AR :
Sosumi -
Yild Ee hd

] Add.. l [ Delete ]
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Managing the Alert Sounds

Mouse

4. Choose the Alert Sound you like, and set the volume.

5. Close the Manitors & Sound control panel.

1. Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Menitors & Sounds
control panel icon. Select the Alerts option.

2. There are several options in the Alert Sound list. Click on each one of
these sounds. As you click, you will hear the sound.

3. With any one of the sounds selected, move the System Alert Volume
slider back and forth to adjust the sound volume.

2 8 2
Q (eYe) Jelele)

Very Stow  Shw Fast

AR
*o te 30
Double-Click Speed

The Mouse control panel adjusts the speed that the arrow pointer/cursor
travels across the screen as you move the mouse. This is Mouse Tracking. The
Double-Click Speed buttons control the speed that you need to double-click
the mouse button to activate clicked items. It defaults to the medium speed.
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Managing the Mouse Controls

1. Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Mouse control
panel icon.

2. Click the Very Slow option. Do not press the mouse button. Merely move
the pointer arrow around the screen. Is this painfully slow? Most artists
with electronic drawing tablets use this for their pen cursor.

3. Click the button above Slow. Now move the pointer arrow around the
screen. Still too slow?

4. Click the button above Fast, then move the pointer arrow around.

5. The default speed is the third button from Slew, which would be about
medium. Set the Mouse Tracking at this speed, or at whichever speed you
feel comfortable with.

6. Close the Mouse control panel by clicking the upper left button of the
dialog box.

NUMBERS

If you are working on text items that require special character formats, deci-
mals, dollar ($) symbols, then the Numbers control panel gives you these
necessary characters.

B —————Nifbers mame—————pg|

e ——|
- Separators — Currency —
Decimal: DE] | Symbol: EI |
i | | @ Before number |
Thousands: D@ i Graterimbier |

e S
$1,23456 ]
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PC EXCHANGE

If you're on your Macintosh computer, and someone hands you a PC format-
ted floppy disk with information on it, what do you do? Answer: just insert the
disk into your floppy drive. The control panel PC Exchange, which is on by
default, acknowledges the PC disk and reads it as if it were a Macintosh disk.

We don'tc know about oL, You can customize PC Exchange to assign Macintosh applications to open the

PC files. Press Add when you want add more formats to the PC Exchange list.
You will see a new window that says “Assign an application to a DOS suffix:”

but we have a hard time if

we change the numbers

mebting ea that there You then type in the DOS suffix and go to a folder that contains the appropri-
arEN G Aecimale i the ght ate application that can open the type of file assigned. 0K is then clicked to add
place, and commas don’t this to the list.
appear when the numbers
are in the thousands. We're EEET—)
bad with numbers, anyway. W 1l
R i IR =] P
o
= A::::mmn-uu LB
() ((Ghmge) (ita o
®m oo (o) Spwents

PC Exchange has On/Off buttons, as well as Change to modify an item, Re-
move to delete it, and Options to make further customizing choices.

PPP

The PPP Control panel is used to connect with commercial internet providers,
or with other networks within your organization. For information about
setting up the PPP control panel, be sure to contact your internet service
provider, or commercial on-line service, such as AOL or Compuserve. Here’s a
picture of the control panel:
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O PPP(Default)

Connect via: Modem

— Connection s

@) Registered User {0} Guest

Name: |qpt0932|| I

Password: |-ll"-¢- ]

BSave password

Number : 2769824 |

= e

Idle.

2 | options... | [ Connect ||

From the PPP control panel, you enter your User Name, a password, and the
telephone number that you use to access your specific service. You can have
multiple settings stored on your system, which allows you to use different
providers for different services. You can also access an Options dialog box by
clicking the Options button:

= e ptions =

J’ Redialing \ /° (:onneciimv Protocol \

Redial:  ["Redial main number only_ %]

Redial times.

Time between retries: I:I seconds.

2 [(cancel ] [ ok

This dialog allows you to set the number of times the system tries to redial the
number (in case it’s busy or not answering).
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The Connection dialog (accessed by clicking on the Connection tab at the top
of the Options dialog) gives you a place to set up the actual connection to your
service provider. The “Connect Automatically” option logs on to your service
provider anytime you launch a program like Netscape Navigator, Microsoft
Internet Explorer, or an email program. It will also let you automatically log off

in case you forget that you're on the internet and leave your house or some-
thing:

/ Redialing \ / Conneotion \ / Pratecel \

B Connect automatically when starting TCP/P applications

Use verbose logging
Reminders:
Bmﬁﬂe«\hm«ub&f\vm&nmﬂd

[JPrompt every 3 minutes to maintain connection

[ Otsconnect if idie for minutes

2 [cancet ] [ ok |

The Protocol tab is an area where you might need to talk to your service
provider before selecting the proper settings:

Srzm = Options ==

/ Redialing \ / Connection \ / Protocol \

B Allow error correction and compression in modem
[J use TCP header compression

[ connect to a command-tine host:

<no seript selected >

Y (T T
Poampor Utenpt DD boptmarrt

3]

[ cancet ) [[ ok ||

CHAPTER 3: CONTROLLING YOUR ENVIRONMENT PAGE 145



QuickTIME™ SETTINGS

The QuickTime™ Settings control panel offers the choice of playing or starting
your CDs automatically. You can click on the appropriate buttons to toggle the
AutoPlay either On or Off.

[ hags ol 04 1 bl vt rter
[ ety vhon verrted.

! E3Enadte D-aMAutortey
Alews swne (D AP et simutinaly vhes
———:

SPEECH

Some applications such as SimpleText have speech features. They will speak the
selected text in various voices that you can choose. Also, the rate that the voice
speaks can be adjusted.

The Options pop-up menu lets you choose from either a voice that speaks
selected text, or the Talking Alerts.

TALKING ALERTS

The Talking Rlerts are vocal sounds or words that warn you of certain mis-
haps. The Speak the phrase submenu has various alert phrases that are often
quite humorous, such as “Rats” or “Yeow!”

The Taking Alerts cpticn aTlows alerts to be anncnoed
5y speaking a phrase and/or the alert text.

[ T o~ sa——
] 8peak the atert text
Wait before
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Experimenting with Speech

1. Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Speech control
panel icon.

2. The options will be set to Ueice. If you click-hold on the Voice menu,
under Options, you will see a list of the voices to choose from.

Experiment with the voices by choosing one, then click on the speaker
icon to the immediate right of the Voice menu.

win: F 5 @)

3. Set the Options menu for Talking flerts.

4. Click on Speak the phrase. In the menu to the right of this option, you
will see a list of alerts to choose from.

& Alert!
1t's not my fault!
Blast!
Pay attention!
Dh dearl
Rats.
Yeow!
Attention!
Oh myl
Shoot!
‘Whoa!
Excuse mel

Rext in the list
Random from the Hst

Edit Phrase List

5. Set the Wait before speaking to 0 (zero) for immediate results. Experiment
by selecting an alert, then clicking the speaker icon to the right of this
option. You will hear the alert. When finished, Close the control panel.
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StaRTUP DISK

The Startup Disk control panel shows you the various external or CD drives
that you can startup from, if your computer has them connected.

Be aware that these drives must have functional System Folders with all the
necessary files in order for a new startup to take place from them.

It is suggested that you do not modify this unless you are sure that you need to
startup from a drive other than your main hard drive.

TexT

The Text control panel is only for those who are dealing in international
languages, such as these shown here.

If you are typing a document in a language other than English, you can choose
the language from the Behavior submenu.

Text Behaviors

Script:  ((Roman |3

. French.canadian-
b ian:

Behavior: [ English |$

Affects sort order, case . Norwe

conversion, and word definitions.

“Spamish: .
- Swadish -
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The Apple Menu

The Apple Menu, represented by the colored apple located in the extreme
upper left corner of your screen, is a quick and easy means to access docu-
ments, folders, applications and utilities that could be scattered throughout
your system. The convenience of the Apple Menu is that it is available most of
the time, no matter what application or document you are in.

When Macintosh OS 8 is installed, it creates several standard items that would
prove useful. They will be discussed after a look at the Apple Menu and how to
use it to your advantage.

- . D Apple Systam Profiler
" 'E3AppleAudio Player
-~ [§ Automated Tasks
" calculator
" (SChooser :
- B Control Panels
. @Ffndfile.
- b Graphing Calculator
- [ stgsaw Puzzte -
(gl Key caps

: Note Pad .
. Gl RecentApplications -
) Recent Documents

B84 Recent Servers

_ ([ scrapbock

€ SimpleSdind
. QP stickies

How do you get items into the Apple Menu, or take them out? The controlling
folder is known as Apple Menu Items, located in the System Folder. If you
open the System Folder, and Uiew it “As List,” alphabetically, the Apple Menu
I1tems folder will be at the top of the name list.

So as not to disturb, or lose, certain valuable documents or appliations, it is
best to create an alias of the item and place it into the Apple Menu I1tems
folder.

il
System Folder Sysiterm Folder sFigs
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Managing the Apple Menu

10.

11.

At the desktop, go up to the colored apple in the upper left corner of your
screen. Click-hold on the apple. You will see the objects that reside in the
Apple Menu Items folder.

Several of the items have triangles pointing to the right. These are folders
that contain more items. Drag the mouse down to highlight any of these
items and you will see the contents.

Do not select anything in the Apple Menu. Go to the System Folder and
open it. Use the desktop menu View->As List to see the items alphabeti-
cally. You will see the folder Apple Menu Items.

Keep the System Folder open on the desktop. Go to the Trash icon in the
lower right of your screen. Single-click on the Trash icon to select it.

With the Trash icon selected, go up to File->Make Alias in the menu bar.
The alias “Trash alias” will appear.

Drag this alias to touch the Apple Menu 1tems folder icon in the System
Folder.

Now go up to the actual Apple Menu in the upper left corner and click-
hold on the apple. Scroll down the menu to see if the Trash alias is present.

Make no selections from the Apple Menu. Go back to the System Folder
and single-click on the Apple Menu Items folder to select it. Press
Command-M (keyboard shortcut) to Make flias of the Apple Menu
Items folder. The alias will appear just below the original. Drag this alias
out of the System Folder and onto your desktop.

Close the System Folder,

Still on the desktop, double-click on the Apple Menu Items alias. The
folder from the System Folder will appear. Drag the Jigsaw Puzzle item
out of the folder, onto your desktop.

Close the Apple Menu Items folder.
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12. Access the Apple Menu at the top of your screen. Scroll through the menu
and look for Jigsaw Puzzle. It will not be present, because you removed
it. Make no selections, and go back to the desktop. Locate the Jigsaw
Puzzle you dragged to the desktop.

13. Drag the Jigsaw Puzzle over to touch the Apple Menu Items alias. This
will place the puzzle back into the Apple Menu. To make sure, go back and
access the Apple Menu at the top of your screen.

14. Scroll down the menu and see if the Jigsaw Puzzle is back.

15. On your desktop, place the Apple Menu Items alias in a convenient
location, so that you can access its folder more readily.

16. For clean-up purposes, double-click on the Apple Menu Items alias to
open its folder. Drag the Trash alias you placed there earlier to touch the
actual Trash icon. You want to Trash it. You cannot place items in the
Trash through the Apple Menu.

APPLE SYSTEM PROFILER

The Apple System Profiler is a profile or data analysis of your computer and
its specifications. It tells you code and processor numbers, amount of RAM
memory, and other pertinent data. Use this only if you are interested in the
inner workings of your computer.

Customer Care Code:
Machine:
Machine 1D:

8169 0565 4401 0491
MacOS compatible
514

Finder:
System:
Processor:

OpenDoc:

Active Enabler:

vB.O

yB.OUS

PowerPC 603ev at 180 MHz
n/a
vi.2.1

Memory Installed:
Virtual Memory:
Total Memaory:
Disk Cache:

32 MB

is on

43 MB

is on, 256K

Startup Device:

Unknown
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AppLE CD AupIo PLAYER

The Apple CD Audio Player is a great means of playing musical CDs on your
computer. It is very convenient to use if you want background music of your
choice while you work. The playing of a CD does not affect or interrupt any
other operations you might be involved in. It is purely in the background.

To Play, Stop or Eject a CD is accomplished just by the simple clicking of the
buttons shown. Other data, such as elapsed time, is shown as the selection

plays.

«  Normal — The Normal button is the standard sequence listed on the
CD. The selections will play in this order.

+  Shuffle — The Shuffle button will randomly shuffle and select items on
the CD to play. The list will show below the buttons. Each time you
press the button, it will reshuffle the selections.

*  Program — Program allows you to drag the selections to the sequence
you want to hear. When Program is clicked, the list divides into a Tracks
side, and a Playlist side. You merely drag the tracks you prefer over to
the Playlist. Then, when you press the Play button, you will hear only
the chosen tracks.

Apple CD Audio Player

Track playing Stop Play/Pause Eject CD

N il 14 Hk:38 = Volume
orma _ o il | SO B slider
*Shuffle Woown Lourne oo B — W [~~~ NI
® Program (S8 i
Playing time
of eac
selection

FLAYLIET
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AUTOMATED TAsks

Automated Tasks are preprogrammed scripts that can perform several opera-
tions, saving you the time of having to do it manually. If you want more
information, choose “About Automated Tasks” from the submenu.

If you get into the Scripting act of programming, you can make your own tasks
and place them here for future use.

% Automated Tasks About Autonrated Tasks.
CBIEUTato dAllas tody -

CALCULATOR

The Calculator is a small, pop-up program that allows you to click its keys the
same as you would press the keys of an actual hand-held calculator. Remember
that the “*” symbol is the symbol for multiply. The “/” symbol is to divide.

I} Coleutotor
R T -

FIND FILE

Reviewing what you've learned, items can be moved, renamed, accidentally
Trashed, or lost in many different ways. You will probably rely on Find File
quite a bit when this happens.
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The specifications you can search by are extensive. Find by name, size, date
created, locked, etc. You can specify that the string of text starts with, ends with,
contains, doesn’t contain certain criteria. The size, kind, label, etc., can be
searched for, and the number of file size “is less/greater than.”

¥ name
size.
kind
label
date created
2 ::-.I:c::‘dﬁis ' date modified
on mounted servers version
comments
onihedeRDD lock attribute
in the Finder selection folderattribute |
file type i
creator
v size
kind
label
date created
date modified
version
comments
lock attribute
Tolder attribute
file type
creator

Using Find File

1. Go to the Apple Menu and scroll down to Find File and launch it.

2. TheFind File dialog box will appear on your desktop. You will need to set
specifications and click Find to see how Find File operates.

3. Here s a setting to find items that the name contains the word “panel”
Make these setting in Find File, then press Find.

| :

Those items found that fit this criteria will appear in a separate window
underneath the first Find File window.
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4. Go back to the top Find File window and make these settings, then press
Find. It will find items that the name starts with “control.”

5. Go back to the top Find File window and make these settings, then press
Find. It will find items that the kind is an alias.

6. Go back to the top Find File window and make these settings, then press
Find. It will find items that the date modified is the current date you set

with the up/down arrow buttons.

7. Go back to the top Find File window and click on the More Choices
button. You will see the size and is less than option. Make these settings,
then press Find. It will find items that the kind is with an extension, and its

size is less than 25.
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8. Go back to the top Find File window and make these settings, then press
Find. It will find all items (nothing specified) that the size is less than 5.

T I R Bl e

R ARAT I #

9. The exercise is finished. You have seen how Find File operates, and how
you choose the settings. Close both of the Find File windows.

GRAPHING CALCULATOR

Since we’re not math heads, the best thing we can tell you about this fairly
weird and incredible calculator is to tell you to go through the self-running
demo that comes with it. Good thing, too.

Now graphing y as a function of x.

44

-24
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JiGsaw PuzzLE

The Jigsaw Puzzle is a map of the world, shown here (left). To begin the puzzle,
you must go up to the menu bar and pull down its Option menu and select Start
New Puzzle. You will be given the choice of selecting the sizes of the puzzle
pieces. The puzzle will split up so that you can move the pieces around to put the
picture back together. You can also paste your own picture to customize.

Choose size of pieces:

@ Small
@ Medium
Q@ Large

Cancel_

KEey Caps

There are many characters in the fonts that you might need, such as accents,
the apple icon, or international symbols. Key Caps shows the different charac-
ters available from fonts you choose from the menu bar at the time Key Caps
is on your screen.

To see the various characters, the keyboard of Key Caps can be clicked. The
corresponding symbol will appear in the Key Caps window above its key-
board. If you hold the Shift or the Option key, you will see what characters go
with the key you press. You can also hold the Shift and Option keys together
and get more characters.

Key Caps is simply a guide to show the hidden characters of various fonts.
Then, when you are using the font, if you hold Shift or Option, or both, you
get the character designated in Key Caps.
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NortE PAD

The Note Pad is a convenient electronic note pad to keep notes, phone num-
bers, addresses, etc., that you need quick access to. There are several note pages
that come standard with MAC OS 8. You flip through these pages by clicking
the left corner flap. To back up through the pages, you click the area next to the
flap, as show here. To create an additional page, you go to the File menu and
pick New Note.

B —tNotepad =——
People tocall ---- =t

Warren Peace

Helen Highwater

Click here
togoto
next page.

Click here i =
to go back
a page.

|

RECENT APPLICATIONS

The computer system keeps track of when applications are launched. When
they do, the system makes an alias of the application and puts it into this folder
that appears in the Apple Menu. This is another handy use of aliases, because
you can instantly launch an application that was used previously again.

I Recent Applications p ‘Adobe lllustrator® 7.0

4 RecentDocuments ) | Adobe PageMaker 6.5
Bl Recent Servers ﬁﬂ:’gn‘:msh;p

(® Scrapbook AppleCDAudio Player
AN CimnlaCnund. SimpleText

RECeENT DOCUMENTS

The same way the system keeps track of applications that are launched, it
makes an alias of documents opened and puts it into this folder. If you want to
go back to a document that was used earlier, and don’t want to dig through the
folders to find it, you can access it here.

AgainstThe Clock
RecentServers Baggy Gator Stories
[ Scrapbook Behooving a Behoriam
4 simplesound Catching Tarpon on a Fly Rod

sick’s Oriental Cookbook

#2 CimnlaTov
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SCRAPBOOK

The Scrapbook is a storage file in which to keep text and images. To put text/
images into the Scrapbook, the item must be in the Clipboard, Copied from a
different source. Scrapbook is then accessed and the item pasted.

The Scrapbook shows the pasted image, and gives other information. To see all
the items stored, you use the scrollbar to view them, one by one.

Image shows here

Tells how many
items are in
the Scrapbook

Graphic format : o ooy

File size
Tells size of image and the
percentage it is shown at

To remove an item from the Scrapbook, you can use either Cut or Clear from

the Edit menu when Scrapbook is active.

o Text ‘Lj:..'i::::::;mumw
e
] = Shorw u distribution s ar ofber frecuaenily used iest
+  Graphics
+  Sound
<
[y ot §
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Using the Scrapbook

L

At the desktop, go to the Apple Menu, and scroll down to the Scrapbook.
Highlight it and release the mouse button to launch it. You will see the
Scrapbook window.

O==—=-—scaphosk ===

Dimensions: 158 by 189 pixels
(shown at 93%)

Wem: 20f 10
| | Type: picture
- | Size: 13K

2 i '.f-:--:_gz_

Scroll through the selections to see the objects that are stored there. Stop
when you reach the Party Hat image.

Press Command-Shift-3 which will take a snapshot of the desktop while
the Scrapbook is open.

Go to your Hard Drive folder and look for a file called "Picture 1."
Double-click on the file's icon.

%.

This will launch SimpleText, the resident word processor of the Apple
computer, which can also show snapshots taken of the desktop.

You will see the desktop, with the Scrapbook, as captured when you took
the snapshot. With the cursor in the SimpleText document, drag a border
surrounding the image of the Scrapbook. Copy the marqueed image.

Press Command-V to Paste the image into the Scrapbook.
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Hem: 12013
Type: picture

6. Use the Applications Menu to go to SimpleText. Press Command-N to
create a new document, which will have the cursor in it. Type the words:

"Now is the time for all good people to come to the aid of their party."

7. Highlight this text with the cursor, and press Command-C to Copy the
text to the Clipboard.

8. Use the Apple Menu to go back to the Scrapbook. Press Command-V to
Paste the copied text into the Scrapbook.

Now is the time for all good people to come to the aid
'J of their party

Use the Serapbook as a place to keep pictures, text, movies,
and sounds that you want to access quickly,

* Build a graphics library

¢ Store your favorite sounds and movies

* Keep a letterhead design to paste into your memos
* Store a distribution list or other frequently used text

See your user’s guide for more information.
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Press Command-C to Copy this text to the Clipboard. Use the Applica-
tions Menu to go to the SimpleText document where you typed "Now is
the time..." Click the cursor inside the document after the phrase you
typed. Press Command-V to Paste the Scrapbook text into the document.

Now is the time for all good people to come to the aid of their party. Iad

Use the Scrapbook as a place to keep pictures, text, movies, and sounds
that you want to access quickly.

¢ Build a graphics library

* Store your favorite sounds and movies

¢ Keep a letterhead design to paste into your memos
* Store a distribution list or other frequently used text

See your user’s guide for more information.

10. In the Scrapbook, scroll to the left until you come to the Sound item. Press
the Play Sound button you see in the viewing box.

11. Close the Scrapbook window.
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SiMPLESOUND

Your computer comes with six standard Alert Sounds. SimpleSound is a utility
that allows you to record your own Alert Sounds. But, you must have a special
microphone that plugs into your particular model of computer. Read the
documentation that came with your computer to find out the type of micro-
phone you need. One microphone does not fit all models.

Droplet
Indigo
Qum:lcj

Sosumi
Wild Eep

__Add..

Record Stop FPause FPlay

0 seconds 38 \

Maximum seconds  The seconds appear
of recording time here as you record

STICKIES

When Post-it Notes™ came out, people went bonkers with sticky notes that
could be stuck anywhere, for people to read.

All kidding aside, they are extremely handy, and now, in this computer age,
even the computer must have its own version. The version is called Stickies.
They are small notes, very similar to the Note Pad, that can be located on your
screen as if stuck there with an adhesive backing.

e WELCOME TO STICKIES!
S R =
Stickies lets you write notes (like
Bus"less these) and stick them to your
screen. You can use Stickies to jot
Meetlng ﬂt quick notes, to write reminders,
or to store frequently used text.
9:00 a.m. Your notes are visible whenever
theStiokiey, pogr TIE ARGV
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Stickies have a few more features than the Note Pad. They can have their type
fonts and size changed, they can be be saved, imported and exported, and can
appear on your desktop at Startup, to act as a reminder of an appointment or
something you need to remember.

" Stickies Preferences = ——— Hew Nobe TN

S Ay

[ Confirm window-closing — Save All RS

[ Seve AT on deactivate St - ].::;i{f' s

[ Zoom-box collapses window Style: [ Plain [ Outtine WportText.

Launch af system startup [ Bold [ Shadow ExportText..

[ -..in the background gnmc gmmma ~ PageSetup..

ST, Underline Extended 3 l’l‘lnﬁh'te... sp‘

— . PrintAllNates...
(Cancer] |[_ok_] P it

(Gones) e

Using and Managing Stickies

B 1. Go to the Apple Menu and scroll down to the bottom of the menu to

access Stickies.

2. You will see several of the default Stickies, advertising what Stickies are all
about. Close each one of these, and when warned about closing them, do
not save them. You want to start a fresh with a new Stickie.

3. With the other Stickies gone, and still in the Stickie application, go to the
File menu and select New Note.

4. An empty Stickie will appear on the desktop. Click the cursor inside this
Stickie note, and type “Love is a many-splintered thing,”

il 2SS e s
Love is a many splintered thing] |

|
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5. Highlight the text and go up to the menu bar to pull down the Note menu.
You want to access the Text Style selection.

Stee: (RETE]

Style: (g Plein [E] Outtine
[ Bold [E] Shedow
[ italie [&] condensed
Underline Extended

7. Deselect the text, but click on the Stickie itself. Go to the menu bar and
pulldown the Color menu.

This will change the color of your Stickie. Set it to any other color that
appeals to you.

8. Leave this Stickie intact, and go back to the File menu to create a New
Note. An empty Stickie will appear. Go to New Note three more times and
create three more empty Stickies.

9. Select each empty Stickie and go to the Coler menu to color them all
different colors.

10. Click on each of these empty Stickies and type whatever text you desire in
them. Highlight the text in each and use the Note->Text Style to set the
font and size to different settings.
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11. Go to the Edit->Preferences dialog box and click on the Launch at system

startup button

12. Do not Save your Stickies. This does not matter, until you try to close each
Stickie. With the Stickies spread around your screen, go to the desktop and
do a Special->Restart.

13. When you computer starts again, and you come back to the desktop, you
will see your Stickies. This is one way of having reminders appear for the
next time you use the computer.

14. Close each Stickie, without saving.
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The Macintosh was the
first popular computer to
have networking built in at
the factory. Today's
computers often come
equipped with Ethernet,
which is the name of a very
popular networking
hardware and software
combination. The original
networking scheme built
into the Macintosh was
called AppleTalk. It is still
built into the Mac, but
most people in commercial
environments use Ethernet
as their networking

method.

Talking with Other Computers

The ability to communicate directly with someone else’s computer is called

networking. Networking is a special function that uses a combination of

hardware and software. The hardware is built into your Macintosh, and the
_software is installed when you first set up your computer.

NETWORKS

The first issue concerning networking is a built-in ability to let other people see
your system. This is called File Sharing. You can let people see absolutely
anything that happens to be on your hard drive(s), or you can let people see
only what you want them to. In most cases (since we all have our little secrets),
you will be limiting access to certain folders or drives. This way your secret
stuff remains secret, and your public stuff is readily accessible to other people
you might be working with.

A computer network is like a long line with different items “hanging” off it.
These items can be computers, printers, specialized modems, and other types
of devices.

Many networks are built around something called a Server. A server is a com-
puter that isn’t used by individual operators running regular applications.
Servers are meant to be resources available to anyone working on the network,
and can provide centralized storage, or be used to run special programs, like
automation software, databases full of images, common text, and similar items.

Designer llustrator

ﬂ N
n L
— .«

Server

Copywriter

&
S8

Scanning and Image Retouching Printer
-ﬁ-app
o

AN W
“\?u

Networks allow people working together in a group to share files,
programs, and even centralized resources, such as printers or servers.
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In some of the screen
images we use in the book,
there's a small icon in the

menu bar:

ic

It's highly likely that you

don't have this icon visible
in your menu bar, because
it's a commercially available
program called Stuffit.
Written by a company
called Aladdin Software,
it's a very popular utility
program that allows you to
compress files. Compres-
sion is important when you
have to move files around a
lot over modems and the
internet, or if you just want
to save some space. In this
case, you can stuff a file

before you put it away.

Using your Macintosh on a network is quite easy — like most other functions
on the machine, it’s just a matter of pointing and clicking. As a matter of fact,
you really don’t need a complex network and expensive file servers to network
two or more Macintosh computers. All you need is the appropriate cabling
(talk to your computer dealer for more information about setting up a mini-
network) and you can get started. Any two Macs can talk to each other right
out of the box with an $8 cable.

SETTING UuP AUTHORIZED USERS AND GROUPS

There are two types of people that can access your machine, once you turn file
sharing on (which we’ll get to in a minute). The first type is called a guest and
the second is an authorized user. Guests are anonymous users — anyone that’s
connected to the network in your offices or building can access the system.
Authorized users are people who need a password — that only you can change
— to access the system.

There are times when you might let anyone on the network access certain stuff:
pictures, text, logos, and the like. Another instance where guest access might be
OK is when you're setting up a server that contains stuff that everyone in the
company needs.

Most of the time, though, you will set up each user as they need to access your
system. This way, you can deny them access simply by turning off their access
privileges.
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For security purposes, if
you're going to allow people
access 1o your computer,
you shouldn’t let them
change their own pass-
words. All environments
operate slightly differently
concerning network
security, but in most larger
companies, only certain
network managers can
change passwords, set up
sharing, or allow access to
specific machines and
devices on the network.
Security can be a major
issue, but it's not within
the scope of this work. We
do suggest, though, that
you check with manage-
ment before setting up a
network (if you're working in

a company environment).

Setting Up Users

1. Go to your control panels, and select Users & Groups. The Users &

Groups dialog box will appear:
0 E=——————=\sers&Groups =————————H|H
Kind i 3|
& Guest guest user el
[ Jour e oo tore R Lot
@ New Group
G Duplicste |
£ Delot
; =

2. All Macintoshes that use file sharing or work on a network need to have
an owner. You can type in your name as the owner of this system.

3. Click the New User button. Add a user named John down the hall. Assign
him an appropriate password. (You can always check the little box and let
him change it if he wants):

[
[

John down the hall =~

shov: (Tdenty %)

Name: [John down the hall |
Password: {Dufuy |

|
|
B4 Allow user to change password :
|
|
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4. Before you put away this dialog box, click the Show pop-up menu at the
top of the window. Select Sharing from the list:

Show: T (Y

5. This dialog allows you to turn sharing on or off for this specific user. This
lets you have some users with access privileges, and others without:

O John down the hall - E’
show: (Tharing %)
- File Snaring

(B Allew waer 1o connect to this computer
[

. Program Linting
| [J Miow wmer to link to progrems on ths computer

6. Another check box at the bottom of the window would let John down the
hall actually launch applications from your system. This is rarely a good
idea, though, so we suggest you leave it alone for now.

7. Putaway this dialog, and double-click Guest. Check the Sharing setup and
make sure that guests can access your computer:

e 7

r Show: e R

CFleSharing— = - 0 o e
|
| B4 Allow guests to connect to this computer

Program Linking i S .

] Allow guests to link to programs on this computer

8. Put away the dialogs when you’re done.

PAGE 170

CHAPTER 3: CONTROLLING YOUR ENVIRONMENT



FILE SHARING

Now that you've set up users and guests, you can provide them with access to
specific areas of your system. To do this, you have to turn file sharing on, so

that it’s active in memory. You do this by accessing the File Sharing control
panel.

Turning on File Sharing

1. Select File Sharing from the Control Panels menu. The File Sharing
dialog box will appear. It has two tabs: one for turning sharing on or off,
and another that you can use to monitor activity on your system.

Computer Neme: [ATC Central

@ File Sharing off
Status
"Cﬂck Start to turn on file sharing. This allows other

users to sccess shared folders.

Program Linking off
Status

|VC11ck Start to turn on program linking. This allows other

users to 1ink to shared programs.

2. You can see the Owner’s name, their password (which you cannot see
since it’s blocked out), the name of the computer (which you can change),
and several buttons. Click the Start button. You will see a brief message
that says that file sharing is starting up, and then the icon will change:

n
r Status |

m File Sharing o
| Click Stop to turn off file sharing. This prevents other

users from accessing shared folders.

3. Putaway the dialog boxes when you’re done — they don’t have to be
visible for File Sharing to work.
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It might seem to be a super
idea to buy one version of
an expensive program and
allow two or two thousand
users to access it —
simply by clicking that little
“Program Sharing” button.
It's not that easy though.
First, and most impor-
tantly, the people who write
programs know about the
button, and their stuff
won't work on more than
one machine at a time —
even though you might
think it will.

Secondly, letting someone
run an application from
your computer means that
they will be using your CFPU
(central processing unit) to
do the work of two ma-
chines. This translates to
your system runhing verrrry
slowly — if at all. Only
certain types of programs
lend themselves to this
type of use (we haven't

found any yet).

Sharing a Folder

1. Highlight the Project Folder that you created early on in the course. As
you probably remember, there are several folders — most containing files
— within this folder.

2. Go to the File menu and select Sharing:

" @GN edit view Special f§ Help

New Folder

Open

Print #P
Move To Trash £&

Close Window

Get Info
Label

Duplicate b
Make Alias BM plder Applications Documents
Put Away BY

Find... ®F
Show Original 2R

Page Setup...
PrintWindow...

1

3. The dialog box that appears provides you with the ability to set all sorts of
access privileges for this folder:

ﬂ%wﬁm@%‘
h Whore: MacHD:

[JCan’t move, rensme, or delete this item
— (I Shere this item and its content

Privilege

Neme
Over: (WA Cleaver 15) [ % (2
Wser/Group: (T %) [ == (3]
Everyone ] - @

Copy these privileges to all enclosed folders |  Copy i

4. First of all, check the can’t move, rename, or delete this item box. This

means that no one can accidentally (or otherwise) delete, rename, hide, or
lose this folder.
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You cah access any system
on the network simply by
going to the Chooser and
selecting AppleTalk. All the
available machines on the
hetwork will show in the

window:

a T Eelnctafie seever
: Pr—t

|
] Comwmn ) (=]

: @act
2] st G res

At this point, all you have
to do is double-click, and
sign on as a guest, or as a
registered user (which will
require a password). Once
you do, the folder or hard
drive will appear on your
desktop — just like any

other.

You can tell that a folder or
drive is being shared,
because their icons change
to show that they're
connected to the network:

Q

Project Folder

5. Next, click Share this item and its contents. That will activate the Owner

and User/Group sections of the dialog. It’s here where you can get fancy.
First, you can change the Owner of this specific folder (the one that gets to
change stuff like passwords and access privileges):

— [ Share this item and its

<Any User> h;m
& Harriet Stowe p
John down the hall

Dwner:

 User/Group: (=
: Everyone e @

. Copy these privileges toall enclosed folders

For example, if you click on the button to the right (the one that’s called
Privileges), you can change the way a specific user can interface with this
folder:

CICan"t move, resame, or delete tis item
.sammmmmmnmm

[
Dhmea
|

Or, let everyone (except you and old dufus) be able to put stuff into this
folder — like a public drop box — but not read from it:

E @ﬁmn Folder =

£§u‘n'1 movs;rannme, or delete this item

Prlvﬂeqe

WW@
; [ (=)

- Copy these privileges to sl enclosed folders

8. Lastly, the Copy button lets you set all the folders inside the Project Folder

to the same privileges as this one. You also have the option of setting them
all individually. When you're done, put the dialog box away.
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Notes:
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Final Review

CHAPTERS T THROUGH 3 A Al o

C it

* Monitors & Sound, and others. ; e

’ Understand the use of Launcher, and how to use aliases to mmrm:ze

o™
¥

. In Basic Macmtosh Opemtmns An Introductwn to the Macmtosh you have
learned much about the functlonahty of this hlghly popular wo,rkstatlon
Now that you've completed the course, you should :

NN

Know the components that make up your Macmtosh These mclude the :

‘hardware compon‘eﬂts, such as the monitor; storage, including mternal and>

external hard drwe, and external storage devices like floppy disks, Zip = !
drives, and C'D ROMs You should also understand the difference. between

an operatrng system, an apphcatlon program ,and data files. e
" Bel famrhar ‘with the use of the’ Macmtosh Help system, 1ncludmg several

ways of' ﬁndlng answers or guxdance on specific issues.

" Know how to control a Window ‘how to posmon it, resize- it, and close it

Know about the Mefiu bar, and how to select or access functrons both there'

_‘and from the keyboard : SRR ;

v

* Understand folders, how to create them, organize them, nest them, change 5
E -thelr v1ews, and how to turn them into pop- up menus.

Know how to start a srmple apphcatron, how to format type elements, how <
to save files, and how'to throw them away when you don’t need them

-anymore.

Understand how to access the prmter(s) cormected to your computer

-through the use-of the Chooser, and how to prmt afile. =

Understand the Apple Menu, and how to use some of the tools and aecess.
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Be comfortable controlhng your workmg env1ronment through the use of
control panels such as General Controls, Txme and Date, Desktop Prctures,
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keystrokes, reduce the number of times you have to. chck the mouse, and

".generally organize yourdesktop G g g w e

Be able to connect your machlne to others that are on the same network o

. -and know how to control access- privrleges for folders and files that reside,
' on-your system i o
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anonymous users 168
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Apple Computer 4, 16
Apple Extras folder 108
Apple Menu 88, 94, 149
Launcher 107
options 121
Apple System Profiler 151
AppleTalk 122, 123
Application Picker 67
Applications 6, 16, 116
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protecting the folder 134
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AT&T 15
Authorized Users and Groups 168
Auto Setup 91
Auto-Resize 30
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Automatic type entry 13
AutoPlay 146
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background color 22
bookkeeping 82
Browsers 145
Buttons 10

view as 54
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Calculator 153

cameras 87

Can’t move, rename, or delete 172
Category Folders in Launcher 114
CD Music Player 124

CD-ROM 9
Autoplay 146
drives 4
Central Processing Unit 4
Changing
sounds 141
the name of a file 68
the Name of a Folder 42
the system date 126
Views 51
chime 22
Chooser 88, 89
Clicking and Dragging 24
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Close Box 30
coaxial cable 15
Collapsing Windows 118
Color
depth 139
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highlighting text 119
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options 119
system profiles 123
ColorSync™ System Profile 123
Command Key 12
Command-F 77
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Complex documents 87
Components
CPU 4
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Storage 3
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context sensitive menus 31
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appearance 118
disabled 117
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managing 119
map, using the 137
modems 138
mouse 141
options 118
QuickTime settings 146
Control Strip 123
managing the 125
Controlling your system
the menu bar 23
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Copy Files 44
Copying 159
Copying a file 69
Copying Files 69
Copying files
the progress bar 70
corrupted 7
CPU 4, 16
tower-based 4
crash 6
Create 91
Creating
a new folder 41
an alias 108
files 64
folders 40
Creating Your First File 64
Current Time 127
Customizing the Find Dialog Box 81

D

Data files 62
Date
formats 127
Date & Time 126
date created 80
date modified 80
Definitions 37
Delete key 42
Deleting files 58
from the Trash can 60
Desktop 4, 21, 22, 62, 107, 118
environment 4
pictures 129
printer icon 95
Die Sub 14
digital cameras 3
Disk Cache 137
Displaying the content of folders 26
Displaying your work 87
Documents 134
Dot Matrix 14, 88
Double-Click Speed 141
Double-Clicking 25
drawing 16
Duplicating an Alias 106

E

EDIT 23

Email 145

Empty Trash 60

Enclosing Folder 76

English 148

Environment
desktop 4
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Error Messages 108
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Examining a File 63
Expanding the Search Command 78
Extensions 89, 91
manager 132
External storage 8

F

Fax/Modem 93
fibre-optical cable 15
FILE 23
File menu 98
File Sharing 124, 167, 171
Files 4
copying 69
creating 103
creating new 64
data 62
finding lost 72
renaming 68
saving 65
Find command 74
Find Dialog Box
customizing 81
Find File 153
Finding 72
Finding Information Alphabetically 36
fixed external hard disk 8
Fixed media 8
Floppy Disks 8
Folder
untitled 112
Folders 40, 62
aliases for 106
changing the names of 42
changing the way the contents look 52
changing views within 51
control panels 109
creating new 41
creating practice 45
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hierarchy 49
managing 21
managing your practice folders 47
nesting 43
organizing 43
printing the contents of 87
protecting the applications folder 134
protecting the System Folder 134
renaming 42
sharing 167, 172
system folder 117
the extension folder 91
trashing 58
using within the Launcher 113



viewing as pop-up menus 55
viewing contents as a list 51
folders 4
Font menu 84
Fonts 82
changing 103
Formatting 98
numbers 142
Function Keys 12

G

geek

bug-eyed computer 9
General Controls 110, 133
Get Info 61, 71, 80
gigabyte 5
graphic arts industry 82
Grapbhics folder 57, 58
Graphing Calculator 156
Groups

of users 168
GTE 15
Guests 168

H

hands-on activities 21
hard copy output 13
hard disk 23
Hard Drive 7
Hard Drive storage 137
Help 34

System 36

Topics 34
Hierarchy 48, 49

using aliases to control 104
high-level functions 16
Highlight Color 119
HP Laserjet 5m 95

I

IBM 5
Icons 23, 51
printer 89
Identifying a Folder’s Hiearachy 49
illustration 87
image capture 16
Images
scanning 13
Imagesetters 88
imaging 87
Index 34
the help system 36
infrared 15
Ink Jet 14
Input 9

devices 3
keyboard, using the 11
optical character recognition 13
scanners 13
sound 140
Input methods
the mouse 9
Insertion Point Blinking 133
Intel 5, 16
Internal hard disk 7
internal hard disk 7
Internet
world wide web 4

J

Jigsaw Puzzle 157
K

Key Caps 157

Keyboard 11
commands 11

kilobyte 5

L

Language options 148
Laptops 4
laptops 4
Laser Printers 14, 88
LaserWriter 93
Launcher 107, 110, 136
show at startup 133
using the 112
Launching
applications or files 64
List selection 52
Look for 34
lost files 72

M

MACOS 16
Mac OS Easy Open 136
Macintosh 15, 21, 87
Operating System 7
maintenance 7
Make Alias 108
Making a Copy of a File 69
managing your desktop 103
Map 137
markers 87
MCI 15
Media
removable 3
megabyte 5
Memory 5, 137
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virtual, using 138
Menu Bar 23, 52, 62
Menu Bars
blink rate, changing the 134
mice 9
Microsoft Internet Explorer 145
Minimize 30
Modem
PPP Settings 143
modem 4, 15
Modem Port 122
Modem port 92
modifier keys 12
Monitor 13, 22, 87
controlling the color depth of 123
Monitors & Sound
control panel 139
Month/Day/Year 127
More Choices 79
Mouse 9, 141
pads 10
Movie Player 116

N

Navigating Through Folders 48
nested folders 103

Netscape Navigator 145
Networking 15

Networks 4, 167

New User 169

Norton Utilities 60

Note Pad 158

Numbers 142

numeric keyboard 43

O

OCR 13
Open Enclosing Folder 76
Operating System 7, 15, 16, 95
optical character recognition 13
Optical disks 9
Optical storage 3
Option keys 157
Options 118
Organizing Folders 43
original 103
Other Find Methods 77
Output 13

devices 4

printer categories 14
Owner 171

P

page layout 16, 87
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Pasting 159
Pattern
background 22
PC Exchange 143
Placing items in Launcher 111
Platesetters 88
platter 7
Pointer files
aliases 103
Pop-up Menus 55
Position Automatically 131
Post-it Notes™ 163
PostScript 91
printer description files 88
power-on switch 21
powered up 21
PowerPC 21
PPD 88
PPP 143
Preferences 103
Preparing to share a folder 172
Print Dialog box 99
Printer 14
drivers 88
icons 95
port 122
with Postscript 91
Printing 87, 103
afile 98
printer port 92
resolution 88
setting up the printer 90
spooling options 95
the printer 88
using Chooser 88
Progress Bar 70
Projects Folder 43, 45, 54, 58, 63
Protect Applications Folder 134
Protect System Folder 134
Protecting shared resources 172
Protocol 145

Q

Queue 95, 96
QuickTime 146

R

RAM 5, 137

Random Access Memory 5

Recent Applications 158

Recent Documents 158

Recent Documents folder 107

Recovering
after you have emptied the trash 60
lost data 7



trashed files 59 Storage 3, 6
Removable media 8 external 8
Removable storage 3 : fixed disks 8
Removing items from the Launcher 111 floppy disks 4
Renaming Folders 42 hard drives 7
Resize Handle 30 input 9
resolution 88 Random access memory 5
Restart 132 removable media 8

the file cabinet 23

§ Student Files Folder 45
Sample File #1 47 Subfolders
Saving files 65 sharing the contents of 173

System 88

Scanners 3, 13
System Folder 51, 89, 110, 117, 150

Scanning protecting the 134
S c::;)g::zp ltz;;e 16 System folder 109
formats 159 T
Scroll Bar 30 -
Search Criteria 78 Talking Alerts 146
sectors 7 Telecommunications 15
Security of information 6 Text 82, 148
Select Throwing Things Away 58
Picture 130 Time
PPD 94 changing the system clock 126
Serial port 92 current 127
Server 167 zones 126
Set Profile 123 Title Bar 30, 57
Setting up Tower 4
file sharing 172 Tracking
Launcher 110 mouse settings 141
Setup 91 tracks 7
Sharing 170 Trash Can 58
guests 168 Trash Warning 61
the contents of subfolders 173 Turning on File Sharing 171
Shift Key 157 Turning on Your System 22
Show Desktop when in background 133 Turning on your system 21
Show Launcher at system startup 133 typefaces 82
Shuffle 152 Typing 11
SimpleSound 163
SimpleText 63, 68, 109, 146 Y

Size Display 124

U 168
Slider Bars 28 sers

anonymous 168

Software 15 creating new 169
Sound 124, 139 Using
balancing tones 140 Chooser 90

Speaker Volume 140 Find tools 74
SPECIAL 23 folders 40
Speed'l 146 Launcher 110
gpopnltmlgs 95, 96 PC disks on your Macintosh 143
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standard Macintosh menu bar 31 The find command 72
Star Trek 9 the mouse 24
Starting up
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Using the calculator 153
Using the Help System 34
the index 36
topics 35, 38
Using the Scrapbook 159
utility 7
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VIEW 23
View

as buttons 54

as list 51, 150
Views

changing a folder's 52
Virtual Memory 138
Volume 140

W

What are Folders? 40
Windows

operating system 15, 16

resizing 41

the chooser 89
Windows-based systems 16
windowshade 118
Working environment 4
working in an illustration program 31
Working with Files 62
Working with folders 47
Working with Menu Bars 31
Working with Text 83
Working with Windows 26
World Wide Web 4
WYSIWYG 87
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4h

A job printed using four colors of ink on one side of the sheet,
and one color of ink on the other.

44

A job printed with four colors of ink on both sides of the
sheet. A full four-color project. See process colors, subtractive
color.

Acetate

A plastic material used to block or expose specific portions of
a layout through “windows” cut from the material by a
stripper. The resultant “masks” are used to generate film
separations for generating printing plates.

Achromatic

By definition, having no color; therefore, completely black or
white or some shade of gray.

Acrobat

This program by Adobe Systems, Inc. converts any document
from any Macintosh or Windows application to PDF format,
which retains the page layout, graphics, color, and typography
of the original document. It is widely used for distributing
documents online because it is independent of computer
hardware. The only software needed is a copy of Acrobat
Reader, which can be downloaded free.

Adaptive Palette

A sampling of colors taken directly from an image, and used in
a special compression process usually used to prepare images
for the world wide web.

Additive Color Process

The additive color process is the process of mixing red, green,
and blue light to achieve a wide range of colors, as on a color
television screen. See Subtractive Color.

Adjacent Color

The eye will respond to a strong adjacent color in such a way
as to affect the perception of the particular color in question.
That is, a color having different adjacent colors may look
different than it does in isolation. Also referred to as
metamarism.

Adobe Systems Incorporated

A major software developer responsible for the creation of the
PostScript page description language (see PostScript), used in
almost all graphic arts environments. PostScript resides in a
printer or Raster Image Processor (see Raster Imnmage Processor)
and is used to convert graphics from the screen to high-
resolution output. Adobe also develops the highly popular
Photoshop, Illustrator, PageMaker, and Premiere graphics and
video applications, in addition to a range of others.

Airbrush

A tool driven by compressed air that applies a very fine spray
of color to artwork to produce various effects. Its effects are
simulated in digital illustration and imaging programs.

Algorithm

A specific sequence of mathematical steps to process data. A
portion of a computer program that calculates a specific
result.

Alley
The white space, or margin, between columns on a page.

Alpha Channel

An 8-bit channel of data that provides additional graphic
information, such as colors or masking. Alpha channels are
found in some illustration or graphics programs, and are used
in video production.

ANSI

The American National Standards Institute. ANSI establishes
and publishes industry standards in many fields including
data transmission and graphics.

Anti-aliasing
A graphics software feature that eliminates or softens the
jaggedness of low-resolution curved edges.

Apple Computer, Inc.

A computer manufacturer based in Cupertino, California.
Apple was responsible for the development of the Macintosh
computer and the first Postscript-equipped laser printer,
which ushered in the “desktop publishing” revolution.

Archival storage

The process of storing data in a totally secure and safe manner.
Archiving differs from backup in that it's meant to be used to
restore entire systems or networks, rather than providing
quick and easy access to specific files or folders.

Art
Illustrations and photographs in general; that is, all matter
other than text that appears in a mechanical.

Artifact
By definition, something that is artificial, or not meant to be

there. An artifact can be a blemish or dust spot on a piece of
film, or unsightly pixels in a digital image.

Ascender

Parts of a lower-case letter that exceed the height of the letter
“x”. The letters b, d, f, h, k, 1, and t have ascenders.

ASCII

The American Standard Code for Information Interchange,
which defines each character, symbol, or special code as a
number from 0 to 255 (8 bits in binary). An ASCII text file can
be read by any computer, and is the basic mode of data
transmission on the Internet.

ATM (Adobe Type Manager)

A utility program which causes fonts to appear smooth on
screen at any point size. It’s also used to manage font libraries.

Author’s Alterations (A/As)

Changes made to the copy by the author after typesetting, and
thus chargeable to the author.

Backing Up
The process of making copies of current work or work-in-
progress as a safety measure against file corruption, drive or
system failure, or accidental deletion. Backing up work-in-
progress differs from creating an archive (see Archiving) for
long-term storage or system restoration.
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Backslant

A name for characters that slant the opposite way from italic
characters.

Banding
A visible stair-stepping of shades in a gradient.
Banner

A large headline or title extending across the full page width,
or across a double-page spread.

Baseline

The implied reference line on which the bases of capital letters
sit.

Bézier Curves

Curves that are defined mathematically (vectors), in contrast
to those drawn as a collection of dots or pixels (raster). The
advantage of these curves is that they can be scaled without
the “jaggies” inherent in enlarging bitmapped fonts or
graphics.

Binding
In general, the various methods used to secure signatures or
leaves in a book. Examples include saddle-stitching (the use of
staples in a folded spine), and perfect-bound (multiple sets of
folded pages sewn or glued into a flat spine).

Bit (Binary Digit)
The smallest unit of information in a computer, representing
one of two conditions, ON or OFF; HIGH or LOW, etc. Eight

bits comprise one byte. One byte can represent any text
character.

Bitmap
A rectangular array of dots that, taken together, form an

image. Bitmap file formats include: .BMP, .DIB, .GIF, .PCX
and .TIFF (see Raster Graphics).

Bitmapped

An image formed by a grid of dots or pixels whose curved
edges have discrete steps because of the approximation of the
curve by a finite number of pixels.

Black
The absence of color; an ink that absorbs all wavelengths of
light.

Blanket
The blanket, a fabric coated with natural or synthetic rubber

wrapped around the cylinder of an offset press, transfers the
inked image from the plate to the paper.

Bleed

Page data that extends beyond the trim marks on a page.
[lustrations that spread to the edge of the paper without
margins are referred to as “bled off”

Blind Emboss

A raised impression in paper made by a die, but without being
inked. It is visible only by its relief characteristic.

Blow up

An enlargement, usually of a graphic element such as a
photograph.
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Body Copy

The text portion of the copy on a page, as distinguished from
headlines.

Boldface
A heavier, blacker version of a typeface.

Bond

A sized (coated) writing paper used for business or personal
stationery that normally has significant rag (cotton) content.

Border

A continuous line that extends around text; or a rectangular,
oval, or irregularly-shaped visual in an ad.

Bounding Box

The imaginary rectangle that encloses all sides of a graphic,
necessary for a page layout specification.

Bri@tness

1. A measure of the amount of light reflected from a surface. 2.
A paper property, defined as the percentage reflection of 457-
nanometer (nm) radiation. 3. The intensity of a light source. 4.
The overall percentage of lightness in an image.

H

A marker preceding text, usually a solid dot, used to add
emphasis; generally indicates that the text is part of a list.

Burn

1. To expose an image onto a plate. 2. To make copies of ROM
chips or CD-ROMs. 3. To darken a specific portion of an
image through photographic exposure.

Byte
A unit of measure equal to eight bits (decimal 256) of digital
information, sufficient to represent one text character. It is the
standard unit measure of file size. (See also Megabyte, Kilobyte,
and Gigabyte).

Calibration Bars

A strip of reference blocks of color or tonal values used to
check the registration, quality, density, and ink coverage
during a print run.

Calibration

Making adjustments to a color monitor and other hardware
and software to make the monitor represent as closely as
possible the colors of the final printed piece.

Callout

A descriptive label referenced to a visual element, such as
several words connected to the element by an arrow.

Camera Ready

A completely finished mechanical, ready to be photographed
to produce a negative from which a printing plate will be
made.

CaE Line

The theoretical line to which the tops of capital letters are
aligned.




Caps and Small Caps

A style of typesetting in which capital letters are used in the
normal way, while the type that would normally be in lower
case has been changed to capital letters of a smaller point size.
A true small-caps typeface does not contain any lower-case
letters.

Cags

An abbreviation for capital letters.
Caption

The line or lines of text that identify a picture or illustration,
usually placed beneath it or otherwise in close proximity.

CD-ROM

A device used to store approximately 600MB of data. Files are
permanently stored on the device and can be copied to a disk
but not altered directly. ROM stands for Read-Only Memory.
Equipment is now available on the consumer market for
copying computer files to blank CD-ROMs.

Character Count

The number of characters (letters, figures, signs or spaces) in a
selected block of copy. Once used to calculate the amount of text
that would fit on a given line or region when physically setting

type.
Choke

See Trapping
Chooser

A part of the Macintosh operating system that permits
selection of a printer or other peripheral device. Chooser is
also used to access resources on a network.

Chroma

The degree of saturation of a surface color in the Munsell
color space model.

Chromaticity Diagram

A graphical representation of two of the three dimensions of
color. Intended for plotting light sources rather than surface
colors. Often called the CIE diagram.

Cicero/Didot Point

The cicero is a unit of horizontal distance slightly larger than
the pica, used widely in continental Europe. A cicero equals
0.178 inches, or 12 Didot points.

CIE (Commission Internationale de ’Eclairage)

An international group that developed a universal set of color
definition standards in 1931.

CIE Diagram
See Chromaticity Diagram
Clip Art

Collections of predrawn and digitized images stored on disk
that can be pasted into word processing and DTP documents.

Clipboard

The portion of computer memory that holds data that has
been cut or copied. The next item cut or copied replaces the
data already in the clipboard.

Caps -( olor Correction

Cloning

Duplication of pixels from one part of an image to another.
CMS
See Color Management System

CMYK (Cyan, Magenta, Yellow, Black)

The process colors (subtractive primaries) used in color
printing. The letter K stands for “Key,” although it is com-
monly used to refer to the Black ink that is added to the three
colors when necessary. When printing black text as part of a
four-color process, only the black ink is used. A normal four-
color separation will have a plate for each of the four colors.
When combined on the printed piece, the half-tone dots of
each color give the impression of the desired color to the eye.

Coated

Printing papers having a surface coating (of clay or other
material) to provide a smoother, more even finish with greater
opacity.

Cold type

Type produced by photographic or digital methods, as
opposed to the use of molten metal as in the old Linotype
machine.

Collate

To gather separate sections or leaves of a publication together
in the correct order for binding.

Color Balance

The combination of yellow, magenta, and cyan needed to
produce a neutral gray. Determined through a gray balance
analysis.

Color Bars

See Color Control Strip
Color Cast

The modification of a hue by the addition of a trace of
another hue, such as yellowish green, pinkish blue, etc.
Normally, an unwanted effect that can be corrected.

Color Chart

A printed chart of various combinations of CMYK colors used
as an aid for the selection of “legal” colors during the design
phase of a project.

Color Control Strip

A printed strip of various reference colors used to control
printing quality. This strip is normally placed outside the
“trim” area of a project, as a guide and visual aid for the
pressman.

Color Conversion

Changing the color “mode” of an image. Converting an image
from RGB to CMYK for purposes of preparing the image for
conventional printing.

Color Correction

The process of removing casts or unwanted tints in a scanned
image, in an effort to improve the appearance of the scan or to
correct obvious deficiencies, such as green skies or yellowish
skin tones.
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Color Gamut

The range of colors that can be formed by all possible
combinations of the colorants of a given reproduction system
(printing press) on a given type of paper.

Color Key
An overlay color proof of acetate sheets, one for each of the
four primary printing inks. The method was developed by 3M
Corporation and remains a copyrighted term.

Color Management System
A process or utility that attempts to manage color of input and
output devices in such a way that the monitor will match the
output of any CMS-managed printer.

Color Model

A system for describing color, such as RGB, HLS, CIELAB, or
CMYK.

Color Picker

A function within a graphics application that assists in
selecting a color.

Color Proof

A printed or simulated printed image of the color separations
intended to produce a close visual simulation of the final
reproduction for approval purposes.

Color Scanner

See Scanner

Color Separation

The process of splitting an image or PostScript into cyan,
magenta, yellow, and black components for offset printing.

Color Sequence
The color order of printing the cyan, magenta, yellow, and

black inks on a printing press. Sometimes called rotation or
color rotation.

Color Space
Because a color must be represented by three basic character-
istics depending on the color model, the color space is a three-

dimensional coordinate system in which any color can be
represented as a point.

Color Temperature

The temperature, in degrees Kelvin, to which a blackbody
would have to be heated to produce a certain color radiation.
(A “blackbody” is an ideal body or surface that completely
absorbs or radiates energy.) The graphic arts viewing standard
is 5,000 K. The degree symbol is not used in the Kelvin scale,
The higher the color temperature, the bluer the light.

Color Transparency

A positive color photographic image on a clear film base that
must be viewed by transmitted light. It is preferred for original
photographic art because it has higher resolution than a color
print. Transparency sizes range from 35mm color slides up to
8x10in. (203x254mm).

Colorimeter

An optical measuring instrument designed to measure and
quantify color. They are often used to match digital image
values to those of cloth and other physical samples.
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Column rule

A thin vertical rule used to separate columns of type.

Comg

Comprehensive artwork used to present the general color and
layout of a page.

Compose
To set copy into type, or lay out a page.

Compression
A digital technique used to reduce the size of a file by
analyzing occurrences of similar data. Compressed files
occupy less physical space, and their use improves digital
transmission speeds. Compression can sometimes result in a
loss of image quality and/or resolution.

Condensed Type

A typeface in which the width of the letters has been reduced.
Condensed type can be a specific font, or the result of
applying a percentage of normal width by a formatting
command.

Continuous Tone

An image such as an original photograph in which the subject
has continuous shades of color or gray tones through the use
of an emulsion process. Continuous tone images must be
screened to create halftone images in order to be printed.

Contrast
The relationship between the dark and light areas of an image.

Copy
Any material furnished for reproduction such as text or
illustrations. As a verb, the computer command to copy data
to the clipboard in preparation for pasting it to another
location.

Copyfitting

Fitting a certain body of text to a given area by changing the
font size, leading, justification, or some other parameter.

Copyright
Ownership of a work by the originator, such as an author,
publisher, artist, or photographer. The right of copyright
permits the originator of material to prevent its use without
express permission or acknowledgement of the originator.
Copyright may be sold, transferred, or given up contractually.

CorelDraw

A popular drawing program originally designed for the
Windows environment, but now available as a Macintosh
program, Corel is known to create files that can cause printing
and/or output problems in many environments.

Creep

An unwanted movement of the blanket of an offset printing
press that causes registration problems.

Cromalin

A single-sheet color proofing system introduced by DuPont in
1971 and still quite popular in the industry. It uses a series of
overlaid colorants and varnish to simulate the results of a
press run.



Crop Marks
Printed lines used for final trimming of a printed page.
Croppin,

The elimination of parts of a photograph or other original
that are not required to be printed.

Dash

A short horizontal rule of varying lengths used to indicate a
pause or clause in a sentence; see En-dash and Em-dash.

DCS (Desktop Color Separation)

An EPS file format that creates one file for each of the four
primary printing inks, and a fifth file that contains a thumb-
nail of the image. DCS files are used for building pages with
layout programs; when the file is output, the small placement
image is discarded, and the four high-resolution files are
automatically substituted. This reduces the need to move
large, high-resolution files around a network.

Default

A specification for a mode of computer operation that
operates if no other is selected. For example, the default font
size might be 12 point, or a default color for an object might
be white with a black border.

Densitometer

An electronic instrument used to measure optical density.
Reflective (for paper) and transmissive (for film) versions are
available,

Densi

The ability of a material to absorb light. In film, it refers to the
opacity of a specific area of the image. A maximum density of
4.0 refers to solid black. Improper density in film images can
result in washed-out or overly-dark reproduction.

Descender

The part of a lower-case letter that extends below the baseline
(lower edge of the x-height) of the letter. The letters y, p, g,
and j contain descenders.

Desktop

1. The area on a monitor screen on which the icons appear,
before an application is launched. 2. A reference to the size of
computer equipment (system unit, monitor, printer) that can
fit on a normal desk; thus, desktop publishing.

Desktop Publishing (DTP)

Use of a personal computer, software applications, and a high-
quality printer to produce fully composed printed documents.
DTP is, in reality, an incorrect term these days. In the early
days of Macintosh and PostScript technology, the term
Desktop Publishing inferred that the materials produced from
these systems was somehow inferior (as opposed to profes-
sional publishing). Now, the overwhelming majority of all
printed materials — regardless of the quality — are produced on
these systems, up to and including nationally famous
magazines, catalogs, posters, and newspapers.

Dialog Box

A window in a computer application that — in most cases —
presents an opportunity for the user to enter information
relative to the process that they’re executing. A dialog box
might ask, for example, how many copies of a document you

Crop Marks - Dongle

want to print, or what size a circle should be, or what color.
Dialog boxes are an integral part of today’s graphic user
interfaces — both on the Macintosh and on Windows-based
systems,

Digital Camera

A camera which produces images directly into an electronic
file format for transfer to a computer.

Digital
The use of a series of discrete electronic pulses to represent
data. In digital imaging systems, 256 steps (8 bits, or 1 byte)
are normally used to characterize the gray scale or the
properties of one color. For text, see ASCIL

Di&’tal Proofs

Digital proofs are representations of what a specific mechani-
cal will look like when output and reproduced on a specific
type of printing press. The difference with a digital proof is
that it is created without the use of conventional film
processes and output directly from computer files,

Dingbat
A font character that displays a picture instead of a letter,
number or punctuation mark. There are entire font families of
pictographic dingbats; the most commonly used dingbat font
is Zapf Dingbats. There are dingbats for everything from the
little airplanes used to represent airports on a map, to
telephones, swashes, fish, stars, balloons — just about anything.

Direct-to-plate
Producing printing plates directly from computer output
without going through the film process.

Disk
A computer data storage device, either “floppy,” “hard,” or a
high-capacity removable disk, that stores data magnetically.

Disk Operating System (DOS)

Software for computer systems that supervises and controls
the running of programs. The operating system is loaded into
memory from disk by a small program which permanently
resides in the firmware within the computer. The major
operating systems in use today are Windows95 and
WindowsNT from Microsoft, the Macintosh OS from Apple
Computer, and a wide range of UNIX systems, such as those
from Silicon Graphics, SUN Microsystems, and other vendors.
Dithering
A technique used in images wherein a color is represented
using dots of two different colors displayed or printed very
close together. Dithering is often used to compress digital
images, in special screening algorithms (see Stochastic
Screening) and to produce higher quality output on low-end
color printers.

Document

The general term for a computer file containing text and/or
graphics.

Dongle
A security device that usually plugs into your keyboard or
printer port, that allows copy-protected software to run on
your system. Such protected software will only run on systems

with the dongle present. This prevents a single copy of

software from running on any but one machine at a time.
(GLOSSARY 5



Dot Gain - Excel

Dot Gain

The growth of a halftone dot that occurs whenever ink soaks
into paper. This growth can vary from being very small (on a
high-speed press with fast-drying ink and very non-porous
paper) to quite dramatic, as is the case in newspaper printing,
where a dot can expand 30% from its size on the film to the
size at which it dries. Failure to compensate for this gain in the
generation of digital images can result in very poor results on
press. Generally speaking, the finer the screen (and therefore,
the smaller the dot) the more noticable dot gain will be.

Double-page Spread

A design that spans the two pages visible to the reader at any
open spot in a magazine, periodical, or book.

Double-Click

Two clicks of a mouse button in rapid succession that are
interpreted as the command to open an application, file, or
folder.

Downloadable Fonts

Typefaces that can be stored on disk and then downloaded to
the printer when required for printing.

DPI (Dots Per Inch)

The measurement of resolution for page printers, phototype-
setting machines and graphics screens. Currently graphics
screens use resolutions of 60 to 100 dpi, standard desktop
laser printers work at 600 dpi, and imagesetters operate at
more than 1,500 dpi.

Dragging
The process of moving an object on the screen by clicking on

it with the mouse, moving the cursor to another location, then
releasing the button.

Drop Cap

A large initial cap, usually set down into the block or body of
normal text. Excellent examples of ornate drop caps (called
illuminated initials) can often be seen in manuscripts
illustrated by hand in the Middle Ages.

Drop Shadow

A duplicate of a graphic element or type placed behind and
slightly offset from it, giving the effect of a shadow.

Drum Scanner

A color scanner on which the original is wrapped around a
rotary scanning drum. See Scanner.

DTP
See Desktop Publishing

Duotone
The separation of a black-and-white photograph into black
and a second color having different tonal values and screen
angles. Duotones are used to enhance photographic reproduc-

tion in two-, three-, or sometimes four-color work. Often the
second, third, and fourth colors are not standard CMYK inks.

Dye
A soluble coloring material, normally used as the colorant in
color photographs.
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Dye Transfer

A photographic color print using special coated papers to
produce a full color image. Can serve as an inexpensive proof.

Electrostatic

The method by which dry toner is transferred to paper in a
copier or laser printer, and liquid toners are bonded to paper
on some large-format color plotters.

Element
The smallest unit of a graphic, or a component of a page

layout or design. Any object, text block, or graphic might be
referred to as an element of the design.

Elliptical Dot Screen
A halftone screen having an elliptical dot structure.

Em Dash

A dash — often used in place of parentheses or commas to
break a sentence — that is usually equal to the point size. For
example, in 10 point type, an em dash would be 10 points
wide. Formerly the width of a capital M in a particular font;
this definition is still used by some type foundries.

Em Space

A space usually equal to the current point size; in 10 point
type, an em space should be 10 points wide. Formerly the
width of a capital M in a given font; this definition is still used
by some type foundries. Hot lead typesetters often used this
space as the standard distance for a paragraph indent.

Embedding

1. Placing control codes in the body of a document. 2.
Including a complete copy of a text file or image within a
desktop publishing document, with or without a link (see
Linking).

Emulsion

The coating of light-sensitive material (silver halide) on a
piece of film.

En Dash

A dash - often used in hyphenated word pairs — that is usually
half the width of an em dash.

En Space
A space that is usually equal to half the width of an em space.
EPS (Encapsulated PostScript)

A file format used to transfer PostScript data within compat-
ible applications. An EPS file normally contains a small
thumbnail that’s used to display the image when it's placed
into position within a mechanical or used by another
program. EPS files can contain text, vector artwork, and
images.

Ethernet

A set of software protocols widely used in network communi-
cations,

Excel

A spreadsheet application produced by Microsoft; available
separately or as part of Microsoft Office.




Exception Dictionary - GIF

Exception dictionary
A file, used within a spell-checking or hyphenation process,

that provides exceptions to standard spelling or justification
rules.

Expanded Type

Also called extended, a widened version of a typeface design.
Type may be extended artificially within a DTP application, or
designed as such by the typeface designer. See also Condensed
Type.

Export

To save a file generated in one application in a format that is
readable in another application.

Extension

A modular software program that extends or expands the
functions of a larger program. A folder of Extensions is found
in the Macintosh System Folder.

Fill
To add a tone or color to the area inside a closed object in a
graphic illustration program.

Film
Non-paper output of an imagesetter or phototypesetter.

Filter
In image editing applications, a small program that creates a
special effect or performs some other function within an
image.

Flat

A group of individual camera-ready pages mounted in the
proper order and ready for photographing to produce a
signature plate.

Flat Color
Color that lacks contrast or tonal variation.
Flatbed Scanner

A scanner on which the original is mounted on a flat scanning
glass. See Scanner.

Flexography

A rotary letterpress process printing from rubber or flexible
plates and using fast drying inks. Mainly used for packaging.

Floating Accent
A separate accent mark that can be placed under or over
another character. Complex accented characters such as in

foreign languages are usually available in a font as a single
character.

Flog

To make a mirror image of visuals such as photographs or clip
art

Flush Left

Copy aligned along the left margin.
Flush Right

Copy aligned along the right margin.
Folder

1. The digital equivalent of a paper file folder, used to organize
files in the Macintosh and Windows operating systems. The

icon of a folder looks like a paper file folder. Double-clicking it
opens it to reveal the files stored inside. 2. A mechanical device
which folds preprinted pages into various formats, such as a
tri-fold brochure.

Font

A font is the complete collection of all the characters (num-
bers, uppercase and lowercase letters and, in some cases, small
caps and symbols) of a given typeface in a specific style; for
example, Helvetica Bold.

Force Justify

A type alignment command which causes the space between
letters and words in a line of type to expand to fit within a
line. Often used in headlines, and sometimes used to force the
last line of a justified paragraph, which is normally set flush
left, to justify.

Four-color Process

See Process Colors
FPO

“For Position Only”: a low-resolution graphic or simple box to
designate the location of a graphic in the final file.
Frame

In desktop publishing, an area or block into which text or
graphics can be placed.

FreeHand

A popular vector-based illustration program available from
Macromedia.

Full Measure

A line set to the entire line length.

Galley Proof

Proofs, usually of type, taken before the type is made up into
pages. Before desktop publishing, galley proofs were hand-
assembled into pages.

Gamma Correction
1. Adjusting the contrast of the midtones in an image. 2.
Calibrating a monitor so that midtones are correctly displayed
on screen.

Gamma
A measure of the contrast, or range of tonal variation, of the
midtones in a photographic image

Gamut
See Color Gamut

GASP

Acronym for Graphic Arts Service Provider, a firm that
provides a range of services somewhere on the continuum
from design to fulfillment.

GCR (Gray component replacement)

A technique for adding detail by reducing the amount of cyan,
magenta, and yellow in chromatic or colored areas, replacing
them with black.

GIF - Graphics Interface File

A CompuServe graphics file format that is used widely for
graphic elements in Web pages.
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G (Gigabyte)

One billion (1,073,741,824) bytes (2*) or 1,048,576 kilobytes.
Global Preferences

Preference settings which affect all newly created files within
an application.

Gradation

A smooth transition between black and white, one color and
another, or color and no-color.

Gradient

A fill pattern that goes from dark to light or light to dark, or
from one color or shape to another.

Grain

Silver salts clumped together in differing amounts in different
types of photographic emulsions. Generally speaking, faster
emulsions have larger grain sizes.

Graininess
Visual impression of the irregularly distributed silver grain

clumps in a photographic image, or the ink film in a printed
image.

Gray Balance

The values for the yellow, magenta, and cyan inks that are
needed to produce a neutral gray when printed at a normal
density.

Gray Component Replacement
See GCR
Gray Scale

An image containing a series of tones stepped from white to
black that is used for monitoring tone reproduction.

Grayscale

An image composed in grays ranging from black to white,
usually using 256 different shades of gray.

Greeking

1. A software technique by which areas of gray are used to
simulate lines of text below a certain point size. 2. Nonsense
text use to define a layout before copy is available.

Grid
A division of a page by horizontal and vertical guides into
areas into which text or graphics may be placed accurately.
Group

To collect graphic elements together so that an operation may
be applied to all of them simultaneously.

Gul

Acronym for Graphical User Interface, the basis of the
Macintosh and Windows operating systems.

Guides

Lines created in layout application programs to assist in
aligning various design elements.

Gutter

The white space between two facing pages. Sometimes used
interchangeably with Alley to describe the space between
columns on a page.
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Gigabyte - HLS

Hairline Rule
The thinnest rule that can be printed on a given device. A
hairline rule on a 1200 dpi imagesetter is 1/1200 of an inch; on
a 300 dpi laser printer, the same rule would print at 1/300 of
an inch.

Halftone

An image generated for use in printing in which a range of
continuous tones is simulated by an array of dots that create
the illusion of continuous tone when seen at a distance.

Halftone Tint

An area covered with a uniform halftone dot size to produce
an even tone or color. Also called tint or screen tint.

Hanging Indent

Formatting text so that the first line is not indented, and all
subsequent lines within the paragraph are indented. Often
used with bullets.

Hanging punctuation

Punctuation marks such as quotation marks that are set
outside the text block; similar to a hanging indent.

Hard Copy

A tangible permanent image such as an original, a proof, or a
printed sheet.

Hard Drive

A rigid disk sealed inside an airtight transport mechanism that
is the basic storage mechanism in a computer. Information
stored may be accessed more rapidly than on floppy disks and
far greater amounts of data may be stored.

Hard Return

A manual line ending (created by pressing the Return or Enter
key) that denotes the end of a paragraph.

Header

A fixed body of copy that appears at the top of each page of a
section of a book. It may contain variable quantities such as
page number, time, date, or file name.

Hide
A command in DTP applications that will render certain

elements on the screen invisible, but will not remove them
from the file.

High Key
A photographic or printed image in which the main interest
area lies in the highlight end of the scale.

High Resolution File

An image file that typically contains four pixels for every dot
in the printed reproduction. High-resolution files are often
linked to a page layout file, but not actually embedded in it,
due to their large size.

Highlights

The lightest areas in a photograph or illustration.

HLS

Color model based on three coordinates: hue, lightness (or
luminance), and saturation.




HSV

A color model based on three coordinates: hue, saturation and
value (or luminance).

HTML (HyperText Markup Language)

The language, written in plain (ASCII) text using simple tags,
that is used to create Web pages, and which Web browsers are
designed to read and display. HTML focuses more on the
logical structure of a page than its appearance.

Hue

The wavelength of light of a color in its purest state (without
adding white or black).

Hyperlink

An HTML tag that directs the computer to a different Anchor
or URL (Uniform Resource Locator). The linked data may be
on the same page, or on a computer anywhere in the world.

Hyphenation Zone

The space at the end of a line of text in which the hyphenation
function will examine the word to determine whether or not it
should be hyphenated and wrapped to the next line.

Icon

A small graphic symbol used on the screen to indicate files or
folders, activated by clicking with the mouse or pointing device.

Ilustrator

A vector editing application owned by Adobe Systems, Inc.

Imagesetter

A raster-based laser device used to output a computer page-
layout file or composition at high resolution onto photo-
graphic paper or film, from which to make printing plates.
Import
To bring a file generated within one application into another
application.
Imposition
The arrangement of pages on a printed sheet, which, when the

sheet is finally printed, folded and trimmed, will place the
pages in their correct order.

Indent

A typographical technique that lines up the beginnings or
ends of lines at a position other than the preset margin.

Indexing

In DTP, marking certain words within a document with
hidden codes so that an index may be automatically generated.

Indexed Color Image

An image which uses a limited, predetermined number of
colors; often used in Web images. See also GIF.

Initial Caps
Text in which the first letter of each word (except articles, etc.)
is capitalized.

Inline Graghic

A graphic that is inserted within a body of text, and may be
formatted using normal text commands for justification and
leading; inline graphics will move with the body of text in
which they are placed.

HSV - | tfm/.\'('(l/-’[‘

Intensig

Synonym for degree of color saturation.

International Paper Sizes

The International Standards Organization (ISO) system of
paper sizes is based on a series of three sizes A, B and C. Series
A is used for general printing and stationery, Series B for
posters, and Series C for envelopes. Each size has the same
proportion of length to width as the others. The nearest ISO
paper size to conventional 8-1/2 x 11 paper is A4.

ISO
The International Standards Organization.
Italics

A version of a typeface designed with letters slanted to the
right.

Jaggies
Visible steps in the curved edge of a graphic or text character
that results from enlarging a bitmapped image.

JPG or JPEG

A compression algorithm that reduces the file size of
bitmapped images, named for the Joint Photographic Experts
Group, an industry organization that created the standard;
JPEG is a “lossy” compression method, and image quality will
be reduced in direct proportion to the amount of compres-
sion,

Justification

The alignment of text along a margin or both margins..
Kelvin (K)

Unit of temperature measurement based on Celsius degrees,
starting from absolute zero, which is equivalent to -273 Celsius
(centigrade); used to indicate the color temperature of a light
source.

Kerning

Moving a pair of letters closer together or farther apart, to
achieve a better fit or appearance.

Key (Black Plate)

In early four-color printing, the black plate was printed first
and the other three colors were aligned (or registered) to it.
Thus, the black plate was the “key” to the result.

Kilobyte (K, KB)

1,024 (2') bytes, the nearest binary equivalent to decimal
1,000 bytes. Abbreviated and referred to as K.

Knockout

A shape or object printed by eliminating (knocking out) all
background colors. See Overprinting.

L*a*b
The lightness, red-green attribute, and yellow-blue attribute in

the CIE Color Space, a three-dimensional color mapping
system.

Landscage

Printing from the left to right across the wider side of the
page. A landscape orientation treats a page as 11 inches wide
and 8.5 inches long.

GLOSSARY 9
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Laser printer
A high quality image printing system using a laser beam to
produce an image on a photosensitive drum. The image is
transferred to paper by a conventional xerographic printing
process. Current laser printers used for desktop publishing
have a resolution of 600 dpi. Imagesetters are also laser
printers, but with higher resolution and tight mechanical
controls to produce final film separations for commercial
printing.

Lazer

A function of graphics applications in which elements may be
isolated from each other, so that a group of elements may be
hidden from view, locked, reordered or otherwise manipulated
as a unit, without affecting other elements on the page.

Layout

The arrangement of text and graphics on a page, usually
produced in the preliminary design stage.

Leading (“ledding”)
Space added between lines of type. Usually measured in points
or fractions of points. Named after the strips of lead which
used to be inserted between lines of metal type. In specifying
type, lines of 12-pt. type separated by a 14-pt. space is
abbreviated “12/14,” or “twelve over fourteen.”

Leaders

A line of periods or other symbols connecting the end of a
group of words with another element separated by some
space. For example, a table of contents may consist of a series
of phrases on separate lines, each associated with a page
number. Promotes readability in long lists of tabular text.

Letterspacing

The insertion or addition of white space between the letters of
words.

Library
In the computer world, a collection of files having a similar
purpose or function.

Ligature
Letters that are joined together as a single unit of type such as
oe and fi.

Lightness
The property that distinguishes white from gray or black, and
light from dark color tones on a surface.

Line Art

A drawing or piece of black and white artwork, with no
screens. Line art can be represented by a graphic file having
only one-bit resolution.

Line Screen

The number of lines per inch used when converting a
photograph to a halftone. Typical values range from 85 for
newspaper work to 150 or higher for high-quality reproduc-
tion on smooth or coated paper.

Linen Tester

A magnifying glass designed for checking the dot image of a
halftone. See Loupe.
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Linking
An association through software of a graphic or text file on
disk with its location in a document. That location may be
represented by a “placeholder” rectangle, or a low-resolution
copy of the graphic.

Linotype
A typecasting machine (now obsolete) that injected hot metal

into a line of molds to produce lines of type. After printing,
the type was melted and used again.

Linotype-Hell
The manufacturer of imagesetters such as the Linotronic that

process PostScript data through an external Raster Image
Processor (RIP) to produce high resolution film for printing.

Lithography
A mechanical printing process used for centuries based on the
principle of the natural aversion of water (in this case, ink) to
grease. In modern offset lithography, the image on a photo-
sensitive plate is first transferred to the blanket of a rotating
drum, and then to the paper.

Logo
A graphic element normally used as a design to represent a
company or product.

Lossz

A data compression method characterized by the loss of some
data.

Loupe
A small free-standing magnifier used to see fine detail on a
page. See Linen Tester.

Lowercase

The uncapitalized letters of the alphabet; so named when type
was composed by hand, and the small letters were in the lower
part of the type case.

LPI
Lines per inch. See Line Screen.
Luminosity

The amount of light, or brightness, in an image. Part of the
HLS color model.

LZW

The acronym for the Lempel-Ziv-Welch lossless data- and
image-compression algorithm.

M, MB (Megabyte)
One million (1,048,576) bytes (2*°) or 1,024 Kilobytes.
Macro

A set of keystrokes that is saved as a named computer file.
When accessed, the keystrokes will be performed. Macros are
used to perform repetitive tasks.

Manuscript (MS or Mss)

The original written or typewritten work of an author
submitted for publication.

Margms

The non-printing areas of page, or the line at which text starts
or stops.




Markup - Normal Key

Mark up

To prepare copy for a compositor, setting out in detail all the
typesetting instructions, or to denote corrections on a printed
proof.

Mask

To conform the shape of a photograph or illustration to
another shape such as a circle or polygon.

Masking

A digital technique that blocks an area of an image from
reproduction by superimposing an opaque object of any
shape.

Master Page

A page that holds repeating elements of a layout, such as
guides or graphics.

Match Print
A color proofing system used for the final quality check.
Mechanical

A pasted-up page of camera-ready art that is to be photo-
graphed to produce a plate for the press.

Mechanical Dot Gain
See Dot Gain
Medium

A physical carrier of data such as a CD-ROM, video cassette,
or floppy disk, or a carrier of electronic data such as fiber
optic cable or electric wires.

Megabyte (MB)

A unit of measure of stored data equaling 1,024 kilobytes, or
1,048,576 bytes (10%°).

Megahertz

An analog signal frequency of one million cycles per second,
or a data rate of one million bits per second. Used in specify-
ing computer CPU speed.

Menu

A list of choices of functions, or of items such as fonts. In
contemporary software design, there is often a fixed menu of
basic functions at the top of the page that have pull-down
menus associated with each of the fixed choices.

Menu-driven
Programs which allow the user to request functions by
choosing from a list of options.

Metafile

A class of graphics that combines the characteristics of raster
and vector graphics formats; not recommended for high-
quality output,

Metallic Ink

Printing inks which produce an effect of gold, silver, bronze, or
metallic colors.

Midtones or Middletones
The tonal range between highlights and shadows.
Mock-up

The rough concept or layout of a publication or design.

Modem

An electronic device for converting digital data into analog
audio signals and back again (MOdulator-DEModulator.)
Primarily used for transmitting data between computers over
analog (audio frequency) telephone lines.

Moiré
An interference pattern caused by the out-of-register overlap
of two or more regular patterns such as dots or lines. In
process-color printing, screen angles are selected to minimize
this pattern.

Monochrome

An image or computer monitor in which all information is
represented in black and white, or with a range of grays.

Monospace

A font in which all characters occupy the same amount of
horizontal width regardless of the character. See also Propor-
tional Spacing.

Montage

A single image formed by assembling or compositing several
images.

Mottle
Uneven color or tone.
L\/Iﬂ
See Manuscript
Multimedia
The combination of sound, video images, and text to create a
“moving” presentation.
Network

Two or more computers that are linked to exchange data or
share resources. The Internet is a network of networks.

Neutral
Any color that has no hue, such as white, gray, or black.
Neutral Density

A term that describes images or filters that are gray with no
apparent hue.

Noise

Unwanted signals or data that may reduce the quality of the
output.

Non-breaking Space

A typographic command that connects two words with a
space, but prevents the words from being broken apart if the
space occurs within the hypenation zone. See Hyphenation
Zone.

Nonreproducible Colors

Colors in an original scene or photograph that are impossible
to reproduce using process inks. Also called out-of-gamut
colors.

Normal Key

A description of an image in which the main interest area is in
the middle range of the tone scale or distributed throughout
the entire tonal range.
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Norton Utilities

A software product that provides programs for maintaining a
computer’s hardware or software; for example, locating and
restoring a file that was accidentally “erased.”

Nudge

To move a graphic or text element in small, preset increments,
usually with the arrow keys.

Oblique
A slanted character (sometimes backwards, or to the left),

often used when referring to italic versions of sans-serif
typefaces.

OCR (Optical Character Recognition)

A special kind of scanner software that provides a means of
reading printed characters on documents and converting them
into digital codes that can be read into a computer as actual
editable text rather than pure images.

Offset

In graphics manipulation, to move a copy or clone of an
image slightly to the side and/or back; used for a drop-shadow
effect.

Offset Lithography

A printing method whereby the image is transferred from a
plate onto a rubber-covered cylinder from which the printing
takes place (see Lithography).

OLE

Object Linking and Embedding, a software technique that
permits linking an object in a document to its original file and
enabling automatic updating. OLE applications may be OLE
containers (able to accept OLE documents) or OLE servers
(able to create OLE documents), or both.

Opacity
1. The degree to which paper will show print through it. 2.
Settings in certain graphics applications that allow images or
text below the object whose opacity has been adjusted, to show
through.

OPI
Open Prepress Interface, a software device that is an extension

to PostScript that replaces low-resolution placeholder images
in a document with their high-resolution sources for printing.

Optical Disks
Video disks that store large amounts of data used primarily for
reference works such as dictionaries and encyclopedias.

Orphan

The last line of a paragraph that appears alone at the top of a
column or page.

Outline
A typeface in which the letters have outlines only and no fill.
Overlay

A transparent sheet used in the preparation of multicolor
mechanical artwork showing the color breakdown.

Overprint Color

A color made by overprinting any two or more of the primary
yellow, magenta, and cyan process colors.
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Overprinting
Allowing an element to print over the top of underlying
elements, rather than knocking them out (see Knockout).
Often used with black type.

Page Description Language (PDL)

A special form of programming language that describes both
text and graphics (object or bit-image) in mathematical form.
The main benefit of a PDL is that makes the application
software independent of the physical printing device.
PostScript is a PDL, for example,

Page Layout Software

Desktop publishing software such as PageMaker or
QuarkXpress used to combine various source documents and
images into a high quality publication,

Page Proofs

Proofs of the actual pages of a document, usually produced
just before printing, for a final quality check.

PageMaker

A popular page-layout application produced by Adobe
Systems.

Palette

1. As derived from the term in the traditional art world, a
collection of selectable colors. 2. Another name for a dialog
box or menu of choices,

Panose

A typeface matching system for font substitution based on a
numeric classification of fonts according to visual characteris-
tics.

Pantone Matching System

A system for specifying colors by number for both coated and
uncoated paper; used by print services and in color desktop
publishing to assure uniform color matching.

Pasteboard

In a page layout program, the desktop area outside of the
printing page area, on which elements can be placed for later
positioning on any page.

PCX
Bitmap image format produced by paint programs.
PDF (Portable Document Format)

Developed by Adobe Systems, Inc, (and read by Adobe
Acrobat Reader), this format has become a de facto standard
for document transfer across platforms.

PDL
See Page Description Language

Perfect binding

A common method of binding paperback books in which the
pages are glued directly to the binding.

Perspective

The effect of distance in an image achieved by aligning the
edges of elements with imaginary lines directed toward one to
three “vanishing points” on the horizon.



Photoshop - Proof

Photoshop

The Adobe Systems image editing program commonly used
for color correction and special effects on both the Macintosh
and PC platforms.

Pi Fonts

A collection of special characters such as timetable symbols
and mathematical signs. Examples are Zapf Dingbats and
Symbol. See also Dingbats.

Pica
A traditional typographic measurement of 12 points, or
approximately 1/6 of an inch. Most DTP applications specify a
pica as exactly 1/6 of an inch.

PICT/PICT2
A common format for defining bitmapped images on the
Macintosh. The more recent PICT2 format supports 24-bit
color.

Pixel
A picture element — the smallest dot or unit on a computer
monitor or in a bitmapped image.

Plate

Paper, polyester, or metal sheet used in a printing press to
transfer an image onto paper.

PMS
See Pantone Matching System
PMT

Photo Mechanical Transfer — positive prints of text or images
used for paste-up to mechanicals.

Point
A unit of measurement used to specify type size and rule

weight, equal to (approximately, in traditional typesetting)
1/72 inch.

Polygon

A geometric figure consisting of three or more straight lines
enclosing an area. The triangle, square, rectangle, and star are
all polygons.

Portrait

Printing from left to right across the narrow side of the page.
Portrait orientation on a letter-size page uses a standard 8.5-
inch width and 11-inch length.

Positive

A true photographic image of the original made on paper or
film.

Posterize, Posterization

The deliberate constraint of a gradient or image into visible
steps as a special effect; or the unintentional creation of steps
in an image due to a high LPI value used with a low printer
DPL

Postprocessing Applications

Applications, such as trapping programs or imposition
software, that perform their functions after the image has been
printed to a file, rather than in the originating application.

PostScrigt

A page description language developed by Adobe Systems, Inc.
that describes type and/or images and their positional
relationships upon the page; the resulting file is processed by a
RIP (see Raster Image Processor) into a format a laser printer
or imagesetter can understand.

PPD

Acronym for PostScript Printer Definition file, the informa-
tion that ensures that output remains within the capabilities of
the selected output device.

PRI

Pixels per inch; used to denote the resolution of an image.

Prep_ress

All work done between writing and printing, such as typeset-
ting, scanning, layout, and imposition.

Preferences

A set of defaults for an application program that may be
modified.

Prepress Proof
A color proof made directly from electronic data or film
images.

Primary Colors

Colors that can be used to generate secondary colors. For the
additive system (i.e., a computer monitor), these colors are
red, green, and blue. For the subtractive system (i.e., the
printing process), these colors are yellow, magenta, and cyan.

Printer Command Language

PCL — a language, that has graphics capability, developed by
Hewlett Packard for use with its own range of printers.

Printer fonts

The image outlines for type in PostScript that are sent to the
printer.

Printer’s Spreads

Pages arranged so that, when printed as spreads and as-
sembled, the pages appear in the proper order. For example,
the front and back covers are printed on a spread, the inside
front and inside back covers are printed on another spread,
etc.

Process Colors

The four colors (cyan, magenta, yellow, and black) that are
combined to print a wide range of colors. When blended, they
can reproduce many, but not all of the colors found in nature.
See also CMYK.

Profile

A file containing data representing the color reproduction
characteristics of a device determined by a calibration of some
sort.

Proof

A representation of the printed job that is made from plates
(press proof), film, or electronic data (prepress proofs). It is
generally used for customer inspection and approval before
mass production begins.
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Proportional Spacing

A method of spacing whereby each character is spaced to
accommodate the varying widths of letters or figures, thus
increasing readability. Books and magazines are set propor-
tionally spaced, and most fonts in desktop publishing are
proportional. With proportionally spaced fonts, each character
is given a horizontal space proportional to its size. For
example, a proportionally spaced “m” is wider than an “i”

Pt.

Abbreviation for point.
Pull Quote

A phrase extracted from the copy and used as a graphic to
break up a quantity of text visually, and to call attention to an
important point.

QuarkXPress
A popular page-layout application.
Queue

A set of files input to the printer, printed in the order received
unless otherwise instructed.

QuickDraw

Graphic routines in the Macintosh used for outputting text
and images to printers not compatible with PostScript.
Ragged Left
See Flush Right
Ragged Right
See Flush Left
RAM
Random Access Memory, the “working” memory of a
computer that holds files in process. Files in RAM are lost

when the computer is turned off, whereas files stored on the
hard drive or floppy disks remain available.

Raster

A bitmapped representation of graphic data.
Raster Graphics

A class of graphics created and organized in a rectangular
array using bitmaps. Often created by paint software, fax
machines, or scanners.

Raster Image Processor (RIP)

That part of an imagesetter that converts the page information
from the Page Description Language into the bitmap pattern
that is applied to the film or paper output.

Rasterize
Converting mathematical and digital information into a series

of dots by an imagesetter for the production of negative or
positive film or paper output

Ray Tracing
A software technique for rendering the surface of a reflecting

object realistically by tracing the light rays from the source of
illumination to the eye of the viewer.

Reader’s Spreads

A two-page spread as seen by the reader after printing and
collation; thus, the two pages may have been printed in

separate locations on the signature.
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Reference Marks

Symbols such as the asterisk (*), dagger, double dagger, section
mark (§), and paragraph mark (¥) used in text to direct the
reader to a footnote.

Reflective Art

Artwork that is opaque, as opposed to transparent, that can be
scanned for input to a computer.

Registration

Aligning plates on a multicolor printing press so that the
images will superimpose properly to produce the required
composite output.

Registration Color
A default color selection that can be applied to design
elements so that they will print on every separation from a
PostScript printer. “Registration” is often used to print

identification text that will appear outside the page areaon a
set of separations,

Registration Marks

Small crosshairs on film used to align the individual layers of
film separations.

Resolution

The number of dots or pixels per inch of a monitor or output
device.

Retouching
Making selective manual or electronic corrections to images.
Reverse Out

To reproduce an object as white, or paper, within a solid
background, such as white letters in a black rectangle.

RGB

Red, Green, Blue, the additive primary colors used to create
images on a computer monitor or television screen.

Rich Black

A process color consisting of sold black with one or more
layers of cyan, magenta, or yellow.

Right Reading
A positive or negative image that is readable from top to
bottom and from left to right.

Right-Click
Clicking the right mouse button on a Windows system, usually

to reveal a pop-up menu. A Macintosh mouse has only one
button.

RIP
See Raster Image Processor

River
An accidental and undesirable pattern of white space between
words in text that appears to flow from one corner to another.

ROM

Read Only Memory, a semiconductor chip in the computer
that retains startup information for use the next time the
computer is turned on.

Roman Tﬂe

The primary serif typeface of a family.




Rosctic - Shortcut

Rosette
The pattern created when color halftone screens are printed at
traditional screen angles.

Rotation

Turning an object at some angle to its original axis.
RTF

Rich Text Format, a text format that retains formatting
information lost in pure ASCII text.

Rubylith
A two-layer acetate film having a red or amber emulsion on a

clear base used in non-computer stripping and separation
operations.

Ruler

Rulers displayed at two sides of the working space on a
monitor that show measurements in units that can be selected
in the set-up process.

Running Head

Aline of type at the top of a page that repeats the same
information. Also called header.

S/S (Same Size)

An instruction to the printer to reproduce at the same size as
the original.

Sans Serif

Sans Serif fonts are fonts that do not have the tiny lines that
appear at the top of and bottom of letters.

Saturation

The intensity or purity of a particular color; a color with no
saturation is gray.

Scaling

The means within a program to reduce or enlarge the amount
of space an image will occupy by multiplying the data by a
scale factor. Scaling can be proportional, or in one dimension
only.

Scanner

A device that electronically digitizes images point by point
through circuits that can correct color, manipulate tones, and
enhance detail. Color scanners will usually produce a
minimum of 24 bits for each pixel, with 8 bits each for red,
green, and blue.

Screen

To create a halftone of a continuous tone image (See Half-
tone).

Screen Angle

The angle at which the rulings of a halftone screen are set
when making screened images for halftone process-color
printing. The equivalent effect can be obtained electronically
through selection of the desired angle from a menu.

Screen Frequency

The number of lines per inch in a halftone screen, which may
vary from 85 to 300.

Screen Printing
A technique for printing on practically any surface using a fine
mesh (originally of silk) on which the image has been placed
photographically. Preparation of art for screen printing
requires consideration of the resolution of the screen printing
process.

Screen Shot

A printed output or saved file that represents data from a
computer monitor.

Screen Tint
A halftone screen pattern of all the same dot size that creates
an even tone at some percentage of solid color.
A typeface designed to imitate handwriting.
scsl
Small Computer Systems Interface, a standard software

protocol for connecting peripheral devices to a computer for
fast data transfer.

Selection

The act of placing the cursor on an object and clicking the
mouse button to make the object active.

Self-Cover

A cover for a document in which the cover is of the same
paper stock as the rest of the piece.

Serif

A line or curve projecting from the end of a letter form.
Typefaces designed with such projections are called serif faces.

Service Bureau

A business that specializes in producing film for printing on a
high-resolution imagesetter.

Set Solid

Type set with no extra spacing between the lines; for example,
12-pt. type with 12-pt. leading, or 12/12.

SGML

Standard Generalized Markup Language, a set of semantics
and syntax that describes the structure of a document (the
nature, content, or function of the data) as opposed to visual
appearance. HTML is a subset of SGML (see HTML).

Sharpness

The subjective impression of the density difference between
two tones at their boundary, interpreted as fineness of detail.

Sheet Fed

A printing press that prints single sheets of paper rather than
from a continuous roll.

Shortcut

1. A quick method for accessing a menu item or command,
usually through a series of keystrokes. 2. The icon that can be
created in Windows95 to open an application without having
to penetrate layers of various folders. The equivalent in the
Macintosh is the “alias.”
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Show - Subhead

Show

The opposite of “Hide,” a toggle command. For example, the
tabs and paragraph marks in a text document can either be
shown or hidden by clicking on an icon in the toolbar.

Sidebar
Supplementary text positioned at the side of a page.
Signature

A group of pages ganged together on a large, single sheet for
printing, usually comprising an individual section of a
publication.

Silhouette

To remove part of the background of a photograph or
illustration, leaving only the desired portion.

Skew

A transformation command that slants an object at an angle
to the side from its initial fixed base.

Small caps
A type style in which lowercase letters are replaced by
uppercase letters set in a smaller point size.

Smart Quotes
The curly quotation marks used by typographers, as opposed
to the straight marks on the typewriter. Use of smart quotes is

usually a setup option in a word processing program or page
layout application.

Snap-to (guides or rulers)

An optional feature in page layout programs that drives
objects to line up with guides or margins if they are within a
pixel range that can be set. This eliminates the need for very
precise, manual placement of an object with the mouse.

Soft Font
See Downloadable Font
Soft or Discretionary Hyphen

A hyphen that is coded for display and printing only when
formatting of the text puts the hyphenated word at the end of
aline.

Soft Return

A return command that ends a line but does not apply a
paragraph mark that would end the continuity of the style for
that paragraph.

Spectrophotometer

An instrument for measuring the relative intensity of
radiation reflected or transmitted by a sample over the
spectrurm.

Specular Highlight
The lightest highlight area that does not carry any detail, such

as reflections from glass or polished metal. Normally, these
areas are reproduced as unprinted white paper.

Spine

The binding edge at the back of a book that contains title
information and joins the front and back covers.
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Spot Color

A color not created by CMYK separations, usually specified by
a Pantone swatch number. A spot color is printed by mixing
given proportions of various inks in accordance with the
percentages given by the Pantone number.

Spread

Two facing pages that can be worked on as a unit, and will be
viewed side by side in the final publication,

Stacking Order

The order of the elements on a page, wherein the topmost
item will obscure the items beneath it.

Standard Viewing Conditions

A prescribed set of conditions under which the viewing of
originals and reproductions are to take place, defining both
the geometry of the illumination and the spectral power
distribution of the light source.

Standing Cap
A large capital letter sharing baseline with the adjoining text
but rising above it. See Drop Cap.

Standoff

The distance between a graphic and the text that wraps
around it. See Wrap.

Stat
Photostat copy.
Stet

Used in proof correction work to cancel a previous correction.
From the Latin; “let it stand.”

Stipple

Black and white line art where shading is accomplished by the
placement of pinpoint dots.

Stochastic Screening

A method of creating halftones in which the size of the dots
remains constant but their density is varied; also known as
frequency-modulated (or FM) screening.
Stripping
The preparation and assembling of film prior to platemaking.
Stroke, Stroking
Manipulating the width or color of a line.

Stuffit

A file compression utility used in the Macintosh environment.

Style
A set of formatting instructions for font, paragraphing, tabs,
and other properties of text.

Szle Sheet

A file containing all of the tags and instructions for formatting
all parts of a document; style sheets create consistency
between similar documents.

Subhead
A second-level heading used to organize body text by topic.




Subscript - Tracking

Subscrigt

Small-size characters set below the normal letters or figures,
usually to convey technical information.

Substitution

Using an existing font to simulate one that is not available to
the printer.

Substrate
The paper or any other generally flat material upon which an
image is printed.

Subtractive Color
Color which is observed when light strikes pigments or dyes,
which absorb certain wavelengths of light; the light that is

reflected back is perceived as a color. See CMYK and Process
Color.

Superscript

Small characters set above the normal letters or figures, such
as numbers referring to footnotes.

Swash Letters

Letters with extra flourishes usually used in logos, headlines,
or as initial caps.

Swatch

A sample of a set of papers, inks, etc. that may be provided in
physical form, or appear as a menu in a word processing or
illustration application program.

Syntax
The rules that govern the structure of statements in a
computer language, or in a language in general.

System Folder

The location of the operating system files on a Macintosh.
Tabloid
A paper size 11 inches wide and 17 inches long,
Tabular
Text set in columns or tables.
Tagged Image File Format (TIFF)
A common format used for scanned or computer-generated
bitmapped images.

Tags
The various formats in a style sheet that indicate paragraph
settings, margins and columns, page layouts, hyphenation and

justification, widow and orphan control and other parameters.

Template
A document file containing layout and styles by which a series
of documents can maintain the same look and feel.

Text Attribute

A characteristic applied directly to a letter or letters in text,
such as bold, italic, or underline.

Text Block
A set of characters that may be manipulated as a group.
Text File

A file containing text in ASCII format that does not contain
style formatting.

Text e

Typefaces used for the main text of written material. Generally
no larger than 14 point in size, and variable with the type of
publication.

Text wrap
See Wrap

Text
The characters and words that form the main body of a
publication.

Texture
1. A property of the surface of the substrate, such as the
smoothness of paper. 2. Graphically, variation in tonal values

to form image detail. 3. A class of fills in a graphics application
that give various appearances, such as bricks, grass, etc.

Thin Space

A fixed space, equal to half an en space or the width of a
period in most fonts.

Thumbnails

1. The preliminary sketches of a design. 2. Small images used
to indicate the content of a computer file.

Tick Mark

A small mark at right angles to the axis of a graph that
indicates the location of a certain measurement; such as tick
marks indicating the numbers 1, 2, 3, etc.
TIFF
See Tagged Image File Format
Tight
A characteristic of text in which the characters are set very
close together.
Tile
1. A type of repeating fill pattern. 2. Reproduce a number of
pages of a document on one sheet. 3. Printing a large
document overlapping on several smaller sheets of paper.
Tint
1. A halftone area that contains dots of uniform size; that is,
no modeling or texture. 2. The mixture of a color with white.
Tip In
The separate insertion of a single page into a book either
during or after binding by pasting one edge.
Toggle

A command that switches between either of two states at each
application. Switching between Hide and Show is a toggle.

Tone

Any variation in lightness or saturation while hue remains
constant.

Toolbox

An on-screen mouse-operated palette that allows the user to
choose from a selection of tools available in computer
application programs.

Tracking
Adjusting the spacing of letters in a line of text to achieve
proper justification or general appearance.
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Transfer Curve - White Space

Transfer Curve

A curve depicting the adjustment to be made to a particular
printing plate when an image is printed.

Transparency

A full color photographically produced image on transparent
film.

Transparent Ink

An ink that allows light to be transmitted through it.
Trapping

Compensating for potential gaps between two adjoining
colors because of misregistration.

Trim

After printing, mechanically cutting the publication to the
correct final dimensions. The trim size is normally indicated
by marks on the printing plate outside the page area.

TrueType

An outline font format used in both Macintosh and Windows
systems that can be used both on the screen and on a printer.

Type 1 Fonts

PostScript fonts based on Bézier curves encrypted for

compactness that are compatible with Adobe Type Manager.
Type Family

A set of typefaces created from the same basic design but in

different weights, such as bold, light, italic, book, and heavy.

Typesetting

The arrangement of individual characters of text into words,
sentences, and paragraphs.

Typo
An abbreviation for typographical error. A keystroke error in
the typeset copy.

Typographer

A specialist in the design of printed matter and generally an
expert in type and letterforms.

Typography
The design and planning of printed matter using type.

Uklc

An abbreviation for UPPER and lower case. Also the name of
a popular design publication.

UCR (undercolor removal)

A technique for reducing the amount of magenta, cyan, and
yellow inks in neutral or shadow areas and replacing them
with black.

Undertone
Color of ink printed in a thin film,

Unsharp Masking

A digital technique (based on a traditional photographic
technique) performed after scanning that locates the edge
between sections of differing lightness and alters the values of
the adjoining pixels to exaggerate the difference across the
edge, thereby increasing edge contrast.
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Uppercase

The capital letters of a typeface as opposed to the lowercase, or
small, letters. So called because when type was hand
composited, the capital letters resided in the upper part of the
type case.

Utility
Software that performs ancillary tasks such as counting words,
defragmenting a hard drive, or restoring a deleted file.
Varnish Plate

The plate on a printing press that applies varnish after the
other colors have been applied.

Varnishing
A finishing process whereby a transparent varnish is applied
over the printed sheet to produce a glossy or protective
coating, either on the entire sheet or on selected areas.

Vector Graphics

Graphics defined using coordinate points, and mathematically
drawn lines and curves, which may be freely scaled and rotated
without image degradation. Two commonly used vector
drawing programs are lllustrator and FreeHand.

A class of graphics created using mathematically described
geometric shapes that overcomes the limitations of bitmapped
graphics,

Velox

Strictly, a Kodak chloride printing paper, but used to describe
a high-quality black & white print of a halftone or line
drawing.

Vertical Justification
The ability to automatically adjust the interline spacing
(leading) to make columns and pages end at the same point
on a page.

Vignette
An illustration in which the background gradually fades into
the paper; that is, without a definite edge or border.

Visible Spectrum

The wavelengths of light between about 380 nm (violet) and
700 nm (red) that are visible to the human eye.

‘Watermark

An impression incorporated in paper during manufacturing
showing the name of the paper and/or the company logo. A
“watermark” can be applied digitally to printed output asa
very light screened image.

Web Press

An offset printing press that prints from a roll of paper rather
than single sheets.

Weight
1. The thickness of the strokes of a typeface. The weight of a
typeface is usually denoted in the name of the font; for
example, light, book, or ultra (thin, medium, and thick
strokes, respectively). 2. The thickness of a line or rule.

White Space
Areas on the page which contain no images or type. Proper
use of white space is critical to a well-balanced design.



White Light
Light containing all wavelengths of the visible spectrum.

Widow

First line of a paragraph that appears alone at the bottom of a
column or page.

Window Shade

A type of text block used in certain applications, such as
PageMaker. Windowshades have handles at the top and
bottom which, when dragged with the mouse, will reveal or
conceal text.

Wizard
A utility attached to an application or operating system that

aids you in setting up a piece of hardware, software, or
document.

Word Break

The division of a word at the end of a line in accordance with
hyphenation principles.

Word Processor

A desktop publishing application program designed for
creating and formatting text, but not for page layout.

Word Space

The space inserted between words in a desktop publishing
application. The optimal value is built into the typeface, and
may usually be modified within an application.

Word Wrap

In word processing, the automatic adjustment of the number
of words on a line of text to match the margin and hyphen-
ation settings, resulting in shifting a word to the next line as
required.

Wrap
Type set on the page so that it wraps around the shape of
another element.

WYSIWYG (pronounced “wizzywig”)

An acronym for “What You See Is What You Get,” meaning
that what you see on your computer screen bears a strong
resemblance to what the job will look like when it is printed.

X-height
The height of the letter “x” in a given typeface, which

represents the basic size of the bodies of all of the lowercase
letters (excluding ascenders and descenders).

Xerography
A photocopying/printing process in which the image is
formed using the electrostatic charge principle. The toner
replaces ink and can be dry or liquid. Once formed, the image
is sealed by heat. Most page printers currently use this method
of printing.

Zero Point

The mathematical “origin” of the coordinates of the two-
dimensional page. The zero point may be moved to any
location on the page, and the ruler dimensions change
accordingly.

White Light - Zooniing

Zip
1. To compress a file on a Windows-based system using a
popular compression utility. 2. A removable disk made by

Iomega (a Zip disk) or the device that reads and writes such
disks (a Zip drive).

Zooming

The process of electronically enlarging an image on a monitor
to facilitate detailed design or editing.
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